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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
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Notices and Safety 

Read the following instructions carefully before operating your printer. Refer to these instructions to 
ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These 
include safety agency evaluation and certification, and compliance with electromagnetic regulations 
and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 

Note: Unauthorized alterations, which can include the addition of new functions or connection of 
external devices, can affect the product certification. For more information, contact your Xerox 
representative. 
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Electrical Safety 

This section includes: 
• General Guidelines ...........................................................................................................................................................13 
• Power Cord Safety Information ..................................................................................................................................13 
• Emergency Power Off......................................................................................................................................................14 
• Telephone Line Cord ........................................................................................................................................................15 

 
 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are 
installing optional equipment and are instructed to do so. Power off the printer when 
performing these installations. Disconnect the power cord when removing covers and 
guards for installing optional equipment. Except for user-installable options, there are 
no parts that you can maintain or service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Power off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Power Cord Safety Information 

Carefully read the following instructions before operating your printer. For details, contact your Xerox 
representative. 
 

 WARNINGS:  

• The electrical supply for the device must meet the requirements stated on the data plate 
on the rear of the device. If you are not sure that your electrical supply meets the 
requirements, consult your local electricity provider or a licensed electrician. 

• Do not use an extension cord. 
• Do not remove or modify the power cord. 

 

Refer to these instructions to ensure the continued safe operation of your printer. 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded 
properly. Electrical products can be hazardous if misused. 

 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Replace the power cord if it becomes frayed or worn. 
• Do not unplug or plug the power cord while the printer is turned on. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 
• The electrical outlet must be near the printer and must be easily accessible. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
For details, see Turning the Printer On and Off on page 38. 
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Emergency Power Off 

If any of the following conditions occur, power off the printer immediately and disconnect the power 
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the problem 
if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

Telephone Line Cord 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove any paper trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer when it is printing. 
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
• Do not override any electrical or mechanical interlock devices. 
• Do not attempt to remove paper that is jammed deeply inside the product. Power off the printer 

promptly and contact your local Xerox representative. 
• Ensure that the rear right cover is attached. Open this cover to connecting an interface cable. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmenteu&Language=English
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Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, refer to Physical Specifications on page 326. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation. 
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Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or 
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox 
supplies not specified for this printer. The Total Satisfaction Guarantee is available in the 
United States and Canada. Coverage could vary outside these areas. Please contact your 
Xerox representative for details. 
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Maintenance Safety 

Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 
• Clean the device with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa. 
 

 WARNING: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable 
when used on electromechanical equipment. 

When installing the device in a hallway or similar restricted area, additional space requirements can 
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for 
your area. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=recyclesupplies&Language=English
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a serious hazard that can result in death or serious injury if not avoided. 

 

Hot Warning: 
Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Warning: Moving parts. To avoid personal injury, use caution. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Caution: 
To avoid damage to the property, be careful not to spill toner when handling the 
waste cartridge. 

 

Do not touch the part or area of the printer. 

 

Do not expose the drum cartridges to direct sunlight. 

 

Do not burn the toner cartridges. 

 

Do not burn the waste cartridge. 

 

Do not burn the drum cartridges. 

 

Do not use paper attached with staples or any form of binding clip. 
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Symbol Description 

 

Do not use folded, creased, curled, or wrinkled paper. 

 

Do not use inkjet paper. 

 

Do not use transparencies or overhead projector sheets. 

 

Do not reload paper previously printed on or used. 

 

Do not copy money, revenue stamps, or postage stamps. 

 

For details about all the printer symbols that appear on your printer, refer to the Printer Symbols guide at 
www.xerox.com/office/ALC80XXdocs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 
Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmenteu&Language=English
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• Parts of the Printer ...........................................................................................................................................................24 
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• More Information .............................................................................................................................................................62 
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Parts of the Printer 

This section includes: 
• Front View ...........................................................................................................................................................................24 
• Duplex Automatic Document Feeder........................................................................................................................25 
• Control Panel ......................................................................................................................................................................26 
• Internal Parts ......................................................................................................................................................................28 
• Rear View .............................................................................................................................................................................29 
• Configurations and Options .........................................................................................................................................30 

 
 

Front View 

 

1. Leveler Foot 
2. Tray 5 
3. Left Tray 
4. USB Port 
5. Document Cover 
6. Document Glass 
7. Power/Wake Button 
8. Control Panel 
9. Center Output Tray 
10. Center Bottom Tray 
11. Main Power Switch behind Front Door 
12. Trays 1–4 
13. Locking Casters 
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Duplex Automatic Document Feeder 

  
1. Confirmation Indicator 
2. Top Cover 
3. Document Guides 
4. Document Feeder Tray 
5. Document Output Tray 

6. Constant Velocity Transport (CVT) Glass 
7. Document Glass 

 
 

Duplex Automatic Document Feeder Guidelines 

The duplex automatic document feeder scans both sides of 2-sided documents at the same time. The 
confirmation indicator illuminates when you load the original documents correctly. The duplex 
automatic document feeder automatically detects standard paper sizes. 

The duplex automatic document feeder accommodates the following paper sizes and weights: 
• Original document weights: 38–128 g/m². 
• Original document sizes: 85 x 125 mm (3.3 x 4.9 in.) through 297 x 432 mm (11.7 x 17 in.). 
• Original document quantity: 130 sheets of 80 g/m² paper. 

Follow these guidelines when loading original documents into the duplex automatic document feeder: 
• Load original documents face up so that the top of the document enters the feeder first. 
• Place only loose sheets of undamaged paper in the duplex automatic document feeder. 
• Adjust the paper guides so that they fit against the original documents. 
• Insert paper in the duplex automatic document feeder only when ink on the paper is dry. 
• Do not load original documents above the MAX fill line. 
 

  

1
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Document Glass Guidelines 

Lift the document feeder cover and place the first page face down in the upper-left corner of the 
document glass. Align the original documents to the matching paper size printed on the edge of the 
glass. 
• The document glass accepts paper sizes up to 297 x 432 mm (11.7 x 17 in.). 
• The document glass automatically detects standard paper sizes. 

Use the document glass rather than the duplex automatic document feeder to copy or scan the 
following types of original documents: 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper, such as cloth or metal 
• Envelopes 
• Books 
 

Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print, copy, and scan features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
• Provides the Power/Wake button used for powering on or off the printer. This button also supports 

the power-saver modes, and blinks to indicate the power status of the printer. 
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Item Name Description 

1 NFC Area Near Field Communication (NFC), is a technology that enables devices to 
communicate when they are within 10 cm (4 in.) of each other. Use the 
NFC area to obtain a network interface or to establish a TCP/IP 
connection between your device and the printer. 

2 Touch Screen 
Display 

The screen displays information and provides access to printer functions. 

3 Home Button This button provides access to the Home menu for access to printer 
features, such as copy, scan, and fax. 

4 Power/Wake This button serves several power-related functions. 
• When the printer is powered off, this button powers on the printer. 
• When the printer is powered on, pressing this button displays a menu 

on the control panel. From this menu, you can choose to enter Sleep 
mode, restart, or power off the printer. 

• When the printer is powered on, but in a low-power mode or Sleep 
mode, pressing this button wakes the printer. 

• When the printer is powered on, holding this button for 10 seconds 
turns off the printer. 

This button blinks to indicate the power status of the printer. 
• When the light blinks slowly, the printer is in low-power mode or Sleep 

mode. 
• When the light blinks rapidly, the printer is powering down, or exiting a 

low-power mode. 
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Item Name Description 

5 Status LED This light blinks blue or amber to indicate printer status. 
Blue 
• Blinks blue once to acknowledge a successful Authentication request. 
• Blinks blue once slowly for a copy or print job initiated at the control 

panel. 
• Blinks blue twice slowly for fax or print job received from the network. 
• Blinks blue rapidly while the printer is powering up, or to signal 

detection of a Wi-Fi Direct connection request. 
Amber 
• Blinks amber to indicate an error condition or warning that requires 

your attention. For example, an out-of-toner condition, a paper jam, or 
out of paper for the current job. 

• Blinks amber to indicate a system error, which typically is associated 
with an error code. 

6 Notification Area Notifications are displayed above the Apps area. To view the full 
notification, touch the notification area. After you have reviewed the 
information, touch X. 

7 Interrupt Button This button pauses the current job to run a more urgent job. 
Note: This option may be hidden from view. To enable Interrupt, refer to 
the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

8 Pause Button Use this button to pause the current job. The job pauses with the option 
to resume printing or delete the job. 

9 Language Button The Language button allows you to set the language that appears 
temporarily on the control panel display. 

Note: This option may be hidden from view. For details, see the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

10 Reset Use the Reset button to reset all the apps to their default settings. 
 
 

Internal Parts 

 

1. Second Bias Transfer Roller 
2. Fuser Assembly 
3. Drum Cartridge Release Lever 
4. Toner Cartridges 
5. Main Power Switch 
6. Transfer Belt Cleaner 
7. Waste Container 
8. Drum Cartridges 
9. Drum Cartridge Cover 

3
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7
6
5

8
9
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http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Rear View 

 
1. Circuit Breaker 
2. Rear Right Cover 
3. USB Memory Card Connections and SIM Slot 
4. USB Port, Type A 
5. USB Port, Type B 
6. Status Indicator 
7. Side 2 Scan Cable 
8. Data Port, for service only 

9. Ethernet Connection 
10. Foreign Device Interface (optional) 
11. Fax Connections (optional) 
12. Door D Release Lever 
13. Door A Release Lever 
14. Door B Release Lever 
15. Door C Release Lever 

 

Note: Ensure that the rear right cover is attached. To connect an interface cable, open this cover. 
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Configurations and Options 

 
1. Tray 6 - High Capacity Feeder 
2. Work Surface 
3. Convenience Stapler 
4. RFID Kit 

5. Trays 1 and 2 
6. Trays 2–4 of the 3-Tray Module 
7. Trays 3 and 4 of the High-Capacity Tandem Tray 

Module 
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Finishing Options 

Integrated Office Finisher 

 
1. Staple Cartridge 
2. Finisher Front Door 
3. Finisher Top Cover 

4. Center Tray 
5. Integrated Office Finisher 
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Office Finisher LX 

 
1. Front Transport Cover 
2. Hole Punch Waste Container (optional) 
3. Hole Punch Unit (optional) 
4. Center Tray 
5. Right Tray Attachment 
6. Booklet Maker (optional) 
7. Booklet Maker Side Cover (optional) 

8. Booklet Maker Staple Cartridge (optional) 
9. Finisher Top Cover 
10. Right Tray 
11. Creaser Unit (optional) 
12. Staple Cartridge 
13. Finisher Front Cover 
14. Office Finisher LX 

 
 

  

12

4
3
2

1 14

13

5

6

7

8
9
10
11



Getting Started 

 

 Xerox® AltaLink® C80XX Series Multifunction Printer 33 
 User Guide 
 

Business Ready Finisher with Optional Booklet Maker 

 
1. Horizontal Transport Unit 
2. Finisher Front Cover 
3. Right Top Tray 
4. Right Middle Tray 

5. Staple Cartridge 
6. Booklet Maker Tray 
7. Booklet Staple Unit 
8. Booklet Maker Unit 

 
 

Business Ready Finisher with Optional C/Z Folder 

 
 

1. Folder Front Cover 
2. Folder Bin Release Button 
3. Folder Bin 
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Paper Tray Options 

Configuring Dedicated Paper Trays 

The system administrator can set trays to Fully Adjustable mode or Dedicated mode. When a paper tray 
is set to Fully Adjustable mode, you can change paper settings each time that you load the tray. When a 
paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, type, 
and color. 

Your printer can have three high-capacity paper trays installed, depending on the configuration. 
• High-Capacity Trays are configured as Dedicated trays. 
• Trays 3 and 4 in the Tandem Module, and High Capacity Tray 6 hold A4-size (210 x 297 mm), 

Letter-size (8.5 x 11 in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper. 
• High-Capacity Trays are designed to hold larger amounts of paper for fewer printing interruptions. 

Note: To configure tray settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Configuring Trays 3 and 4 of the Tandem Tray Module 

Trays 3 and 4 in the Tandem Tray Module are high-capacity paper trays. Configure Trays 3 and 4 to 
support the paper in use. 

If you are configuring the trays for the first time, configure them for the paper size that you need. If you 
change the paper size, reconfigure the tray for the new paper size. For details on supported paper sizes, 
refer to Supported Standard Paper Sizes on page 172. 

To configure Trays 3 and 4 in the Tandem Tray Module: 

Note: Before you make any tray adjustments, compare the paper size to the current Tray 3 and 4 
configurations. If the paper size matches the tray configuration, no tray adjustment is needed. 

1. Remove any paper from the tray. 
2. Pinch the guide lock on the front paper guide, then slide the paper guide to the required paper size. 
3. To lock the paper guides into place, release the guide lock. 

Note: The paper guides lock into place only at the designated standard paper sizes. 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Configuring Tray 6 

Tray 6 is a dedicated High-Capacity Tray. You can configure Tray 6 to support the paper size that you 
need. For details on supported paper sizes, refer to Supported Standard Paper Sizes on page 172. 

To configure Tray 6: 

Note: Before you make any tray adjustments, compare the paper size to the current Tray 6 
configuration. If the paper size matches the tray configuration, no tray adjustment is needed. 
1. Remove the screw that holds the spacer plate at the back of the tray. 

 
2. To remove the spacer plate, lift it up and out of the tray. 

 
3. Place the tabs at the bottom of the spacer plate into the slots in the bottom of Tray 6 that 

correspond with the paper size. 
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4. Slide down the top of the spacer plate to engage the peg on the back of the tray into the matching 
hole in the spacer plate. 

5. Install the screw to secure the spacer plate. 

 
6. Repeat these steps to adjust the spacer plate at the front of Tray 6. 

 
7. On the top of the side gate, locate the pin. 
8. Lift the pin, then guide it into the desired paper size in the slot. 
9. To lock the side gate into place, release the pin. 
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Wireless Network Adapter 

The wireless network adapter is a USB device that transfers data between the printer and a wireless local 
area network (LAN). The wireless network adapter supports common wireless security protocols, such as 
WEP, WPA, WPA2, and 802.1X standard port-based network access control. 

The wireless network adapter allows multiple users on a wireless LAN to print to and scan from Xerox® 
printers. The wireless network adapter also supports printers that include network scan and fax features. 
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Power Options 

Powering On the Printer or Exiting Low-Power or Sleep Mode 

The printer has two power switches. The main power switch, located behind the front door, controls the 
main power to the printer. The secondary power switch is the Power/Wake button on the control panel. 
The Power/Wake button controls power to the printer electronic components, and when powered off, 
initiates a software-controlled shutdown procedure. The preferred method to power on and off the 
printer is to use the Power/Wake button. 
• To power on the printer, open the front door, then power on the main power switch. On the control 

panel, press the Power/Wake button. 

 
• To enter or exit Low-Power mode or Sleep mode, press the Power/Wake button. 

Notes: 

• The printer exits Low-Power mode or Sleep mode automatically when it receives data from a 
connected device. 

• When in Low-Power mode or Sleep mode, the touch screen is powered off and unresponsive.  
To wake the printer manually, press the Power/Wake button. 

• If Auto Power Off is enabled, the printer powers off automatically after the specified 
conditions are met. To enable Auto Power Off mode, contact your System Administrator. 
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

 

 CAUTION: Do not plug or unplug the power cord while the printer is powered on. 
 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Restarting, Placing in Sleep Mode, or Powering Off the Printer 

To restart the printer, place the printer in Sleep Mode, or power off the printer: 
1. At the printer control panel, press the Power/Wake button. 

 
2. Select an option. 

− To restart the printer, touch Restart. 
− To place the printer in Sleep Mode, touch Sleep. 

In Sleep Mode, the touch screen goes dark and the Power/Wake button flashes. 
− To power off the printer, touch Power Off. 
− If the printer does not respond to a single press of the Power/Wake button, then press and 

hold the button for 5 seconds. A Please Wait message appears as the printer powers down. 
After 10 seconds, the touch screen goes dark and the Power/Wake button flashes until the 
printer powers down. 

3. If you are powering off the printer for an extended period, open the printer front door, then power 
off the main power switch. 

 

 CAUTION: Do not unplug the power cord while the printer powers down. 
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Accessing the Printer 

Authentication 

Authentication is the process of confirming your identity. When the system administrator enables 
authentication, the printer compares the information that you provide to another source of information, 
such as an LDAP directory. The information can be a user name and password, or the information stored 
on a magnetic, proximity, RFID, or smart card. If the information is valid, you are considered an 
authenticated user. 

There are several ways to authenticate a user: 
• User Name/Password - Validate on the Device: This option enables local authentication. Users 

prove their identity by typing a user name and password at the control panel or in the Embedded 
Web Server. The printer compares the user credentials to the information stored in the user 
database. If there are a limited number of users, or you do not have access to an authentication 
server, use this authentication method. 

• User Name/Password - Validate on the Network: This option enables network authentication. 
Users prove their identity by typing a user name and password at the control panel or in the 
Embedded Web Server. The printer compares the user credentials to the information stored on an 
authentication server. 

• Convenience Authentication: If this option is enabled, a card with a magnetic strip or a Radio 
Frequency Identification (RFID) card is used. A convenience authentication card is different from a 
Smart Card, which uses an embedded chip and typically requires a login and password. If the 
optional integrated RFID reader is installed, for authentication, users place a pre-programmed card 
over the RFID reader at the control panel. 

• Xerox Secure Access - Unified ID System: This option enables authentication for the Xerox Secure 
Access Unified ID System. Users present a pre-programmed identification card to a card reader at 
the control panel. The printer compares the user credentials to the information stored on the Xerox® 
Secure Access server. 

• Smart Cards: This option enables authentication for a Smart Card Reader. Users insert a pre-
programmed identification card in a card reader at the control panel. 

Note: The system administrator can allow you to type your user name and password when 
Convenience Authentication or Smart Card is the primary authentication method. If the 
administrator configures an alternative authentication method, and you misplace your card, you 
can still access the printer. 

For information about configuring Authentication settings, refer to the System Administrator Guide 
at www.xerox.com/office/ALC80XXdocs. 

 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English


Getting Started 

 

 Xerox® AltaLink® C80XX Series Multifunction Printer 41 
 User Guide 
 

Authorization 

Authorization is the function of specifying the features that users are allowed to access, and the process 
of approving or disapproving access. You can configure the printer to allow users to access the printer, 
but restrict access to certain features, tools, and apps. For example, you can allow users to access 
copying but restrict access to scanning. You can also control access to features at specific times of the 
day. For example, you can restrict a group of users from printing during peak business hours. 

There are two types of authorization: 
• Local Authorization verifies user information on the printer to approve access. 
• Network Authorization verifies user information stored externally in a network database, such as 

an LDAP directory, to approve access. 

For information about configuring Authorization settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Personalization 

Personalization is the process of customizing apps for a specific user. When a user logs in to the device 
and personalized information is required, the device searches an LDAP directory for the information. 
Personalized information examples are a Home destination or email address. The device uses the 
personalized information to complete the task. 

For information about configuring settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Accounting 

Accounting is used to track and record the numbers of Copy, Print, Workflow Scanning, Server Fax, and 
Fax jobs that the device produces for each user. The system administrator must create user accounts and 
enable the accounting feature. After Accounting is enabled, log in to the printer to access restricted 
apps. Before printing documents from a computer, provide your account details in the print driver. 

The system administrator can set limits to restrict the total number of jobs by type that a user can send 
to the printer. The administrator can generate reports listing usage data for individual users and groups. 

For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
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Logging In 

Logging in is the process by which you identify yourself to the printer for authentication.  
If authentication is set, to access printer features, you log in with your user credentials. 
 

Logging In at the Control Panel 
1. At the printer control panel, press the Home button. 
2. Touch Log In. 
3. Type the User Name using the keypad, then touch Next. 
4. If prompted, enter the password, then touch Done. 

Note: To access each app that is password-protected, repeat steps 3 and 4. 
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Introduction to Xerox® Apps 

Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps 
already installed and displayed on the Home screen. Some Apps are installed as standard, but are hidden 
when you use your device for the first time. You can show, hide, or reorder Apps on the Home screen 
using the settings available in the Embedded Web Server. 

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator 
Guide at www.xerox.com/office/ALC80XXdocs. 

A range of Apps are available for download and installation from the Xerox® App Gallery. These include 
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on 
compatible printers. 

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox App 
Gallery on page 64. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. 

To print an information page, select an option, then touch Print. 

The following Information Pages are available: 
 

Name Description 

Configuration Report The Configuration Report provides printer information including the serial 
number, installed options, network settings, port setup, tray information, 
and more. 

Billing Summary The Billing Summary report provides information about the device and a 
detailed listing of the billing meters and sheet counts. 

Getting Started The Getting Started guide provides an overview of the key features of the 
printer. 

Troubleshooting Print Quality 
Page 

The Troubleshooting Print Quality Page provides a list of common print-
quality problems and tips to help solve them. 

Supplies Usage Page The Supplies Usage Page provides coverage information and part numbers 
for reordering supplies. 

Graphics Demo Page Print this page to check the quality of graphics. 

PCL Font List The PCL Font List provides a printout of all PCL fonts that are available on 
the printer. 

PostScript Font List The PostScript Font List provides a printout of all PostScript fonts that are 
available on the printer. 

 
 

Configuration Report 

The Configuration Report provides product information including, installed options, network settings, 
port setup, tray information, and more. 
 

Printing the Configuration Report 
1. At the printer control panel, press the Home button. 
2. Touch Device > Information Pages. 
3. Touch Configuration Report, then touch Print. 
4. To return to the Home screen, press the Home button. 
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The Embedded Web Server 

The Embedded Web Server is the administration and configuration software that is installed in the 
printer. It allows System Administrators to modify network and system settings on the printer remotely 
using a Web browser. 

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. 
All these functions can be accessed from the convenience of your computer. 

The Embedded Web Server requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 
 

Accessing the Embedded Web Server 

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press 
Enter or Return. 

To use the Embedded Web Server, click the page required: 
• Home: This page provides a description of the printer and current notifications, the status of the 

paper trays, and supplies and billing information. There is a Quick Links area at the bottom of the 
page that provides direct access to key functions and pages. 

• Jobs: The Jobs page enables you to manage active jobs on the printer, view, print, and delete saved 
jobs, and create and manage saved job folders. 

• Print: This page enables you to submit print-ready files to the printer for printing. You can select 
options for print jobs using this page. Only print-ready files can be submitted, for example PDF, PS, 
PCL, and XPS file formats. 

• Scan: The Scan page enables you to create distribution workflows and mailboxes for scanned 
documents. 

• Address Book: Use the Address Book page to create a Device Address Book containing contacts for 
use with the fax, email, and scanning apps. You can configure the printer to use a Network Address 
book that looks up addresses from an LDAP directory. The printer can also be configured to use a 
Network Address Book, which looks up addresses from an LDAP directory. If both the Address Book 
and Device Address Book are configured, users are presented with a choice when they use a 
compatible app. 

• Properties: You can use the Properties tab to access and configure settings for your device. System 
administrator login credentials are required to change most settings. 

• Support: This page provides access to general support information and telephone numbers. You can 
use the Support page to access the Remote Control Panel and send diagnostic information to Xerox. 
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The Embedded Web Server has a Help option that provides information about all available device 
features and functions. To access Help, click the Help link displayed at the bottom of each page. 
Navigate to the topic required, or use the Search function to find specific information. 

For detailed instructions on how to use the Embedded Web Server to configure printer settings, refer to 
the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
 

Finding the IP Address of Your Printer 

To install the print driver for a network-connected printer, you need the IP address of your printer.  
You also need the IP address to access the settings of your printer through the Embedded Web Server. 
You can view the IP address of your printer on the control panel or on the Configuration Report. 

Note: Wait until the printer has been powered on for 2 minutes before viewing the TCP/IP address. If the 
TCP/IP address is 0.0.0.0, or begins with 169, it indicates a network-connectivity issue. 

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About. 
3. Record the IP address from the display. 
4. To return to the Home screen, press the Home button. 

To obtain the printer IP address from the Configuration Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Information Pages. 
3. Touch Configuration Report, then touch Print. 
4. To return to the Home screen, press the Home button. 
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Installation and Setup 

For reference:  
Installation Guide packaged with your printer. 
Online Support Assistant at www.xerox.com/office/ALC80XXsupport  
 

Installation and Setup Overview 

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. 
Configure the initial settings of the printer, then install the print driver software and utilities on your 
computer. 

You can connect to your printer directly from your computer using USB, or connect to a network using an 
Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are 
not included with your printer and are purchased separately. Xerox recommends an Ethernet connection 
because it is typically faster than a USB connection, and it provides access to the Embedded Web Server. 

For more information, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
 

Selecting a Location for the Printer 
1. Select a dust-free area with temperatures from 10–28°C (50–83°F), and relative humidity 15–85%. 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight 
of the printer. The printer must be horizontal with all four castors in solid contact with the surface. 
To find the weight for your printer configuration, refer to Physical Specifications on page 326. Select 
a location with adequate clearance to access supplies and to provide proper ventilation. To find the 
clearance requirements for your printer, refer to Clearance Requirements on page 327. 

3. After positioning the printer, you are ready to connect it to the power source and computer or 
network. 
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Connecting the Printer 

This section includes: 
• Connecting to a Wired Network ..................................................................................................................................48 
• Connecting to a Wireless Network .............................................................................................................................48 
• Connecting with Wi-Fi Direct .......................................................................................................................................49 
• Connecting to a Computer Using USB .....................................................................................................................50 
• Connecting with Near Field Communication (NFC) ............................................................................................50 
• Configuring AirPrint .........................................................................................................................................................53 
• Configuring Google Cloud Print™ ...............................................................................................................................54 
• Connecting to a Telephone Line .................................................................................................................................56 

 
 

Connecting to a Wired Network 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection provides direct access to printer settings using the Embedded Web Server. 

To connect the printer: 
1. Connect the power cord to the printer, then plug the cord into an electrical outlet. 
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the back of the 

printer. Connect the other end of the cable to a correctly-configured network port. 
3. Power on the printer. 

For details on configuring connection settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Connecting to a Wireless Network 

If you have purchased the Wireless Network Adapter, you can use the Wireless Wizard to connect the 
device to a wireless network. If the device is connected to a wired network, you can configure wireless 
settings in the Embedded Web Server. 

Notes: 

• For more information, refer to the Xerox® Wireless Network Adapter Kit Hardware Install and 
Setup instructions that are included with the kit. 

• The device uses either the wireless or the wired network connection. Activating one network 
connection deactivates the other network connection. 

For details on configuring wireless network settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
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Connecting with Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. Wi-Fi Direct is disabled by default on the Xerox device. 

Note: Wi-Fi Direct is available only on printers with the optional Wireless Network Adapter installed. 
Once the Wireless Network Adapter is installed, Wi-Fi Direct is enabled by default. 

 

Wi-Fi Direct Overview 

Wi-Fi Direct allows you to print directly from an Android-based mobile device to your printer by placing 
your mobile device near the printer. 

For detailed information about using Wi-Fi Direct on your mobile device, refer the documentation 
supplied by the manufacturer of your mobile device. 

For details about configuring Wi-Fi Direct on your printer, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Using Wi-Fi Direct on your Mobile Device 

The Wi-Fi Direct feature requires an installed Mopria Print Service app on the mobile device. The printer 
does not need to have a wireless connection. 

Note: This feature supports Android 4.4 or greater. 
 

Installing Mopria® Print Service 
1. On your mobile device, go to the Google Play Store, then search for Mopria Print Service. 
2. Install the Mopria Print Service app. 
3. Go to Settings, then touch Printing. 
4. Go to the notification pull-down bar, then touch Mopria Print Service. 
5. To enable Mopria Print Service, touch On. 
6. Exit Settings. 

Your mobile device searches for Wi-Fi Direct-enabled printers that are in range of the mobile device. 
 

Using Wi-Fi Direct on your Printer 

Wi-Fi Direct is a direct wireless connection from your mobile device to the printer. The Wi-Fi Direct 
feature is enabled by default when the Wi-Fi hardware is installed. 

Using the Wi-Fi Direct feature does not require a wireless network connection to a printer. Contact your 
System Administrator to connect your printer to a wired or wireless network. 
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Printing using Wi-Fi Direct 
1. Open the document for printing. 
2. Select the Print button at the top right of the screen. 
3. If there is more than one printer in the area with Wi-Fi Direct enabled, select the printer required. 
4. Select the print settings required for the job. 
5. Submit the job for printing. 

A pop-up message appears on the mobile device. 
6. Select Connect. 
7. When the connection is made, a pop-up message appears on the printer. 
8. Touch OK on the printer touch screen. 

The job prints at the printer. 
 

Connecting to a Computer Using USB 

Ensure that you have one of the following operating systems installed on your computer. 
• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and 

Windows Server 2012. 
• Macintosh OS X version 10.9 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 

To connect the printer to the computer using a USB cable: 
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the 

printer. 
2. Connect the A end of the USB cable to the USB port on the computer. 
3. If the Windows Found New Hardware Wizard appears, cancel it. 
4. Install the print driver. 

For more information, refer to Installing the Print Driver Software on page 58. 
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Connecting with Near Field Communication (NFC) 

NFC Overview 
 

 
Near field communication (NFC) is a technology that enables devices to communicate when 
they are in close range. NFC allows you to add a printer to your Android mobile device easily. 
After you add the printer, there is no need to use NFC on that printer. You can use NFC to 
obtain the network interface to establish a TCP/IP connection between your device and the 
printer. 

 

Devices can communicate using NFC when they are within the following ranges: 
• Device with case: 17–20 mm (0.7 x 0.8 in.) 
• Device without case: 20–25 mm (0.8 x 1 in.) 

Note: The range can vary depending on the device manufacturer. For information about the required 
settings for individual mobile devices, refer the documentation supplied by the manufacturer of your 
mobile device. 

For details about configuring NFC on your printer, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Using NFC on your Mobile Device 

The NFC feature requires installation of the Xerox Print Service app on the mobile device. 

Your mobile device must use the same Wi-Fi network environment as the printer. The printer does not 
need to have a wireless connection. 

Note: NFC supports Android 4.4 or greater devices. 
 

Installing the Xerox Print Service Plugin 
1. On your mobile device, go to the Google Play Store, then search for Xerox Print Service Plugin. 
2. Install the Xerox Print Service Plugin app. 
3. Go to Settings, then touch Printing. 
4. Go to the notification pull-down bar, then touch Xerox Print Service. 
5. To enable Xerox Print Service, touch On. 
6. Exit Settings. 
 

Enabling NFC on the Mobile Device 

Most mobile devices have NFC disabled by default. 

To enable NFC: 
1. Go to Settings. 
2. Go to the NFC setting, then touch On. 
3. Exit Settings. 
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Using NFC on your Printer 

The NFC chip is on the bottom right of the control panel. When NFC is enabled, the NFC icon is lighted, 
and you can use the NFC function. 

 

Refer to your mobile device user documentation for the mobile device NFC chip location. 

Note: The NFC function must be enabled before use. For NFC enable instructions, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
 

Mapping the Printer to your Mobile Device 
1. Open the Xerox Print Service Plugin. 
2. At the top right side of the screen, touch the selection button, then select Add Printer. 
3. Touch the NFC option. 
4. Hold the mobile device over the NFC icon on the control panel. 

 

The mobile device and the printer communicate with each other. The mobile device searches the 
network for the printer. When the printer is located, it is added to the list as a mapped printer. 

You can submit print jobs from your mobile device to the printer. 
 

Printing using Mopria® 
1. Open the document that you want to print. 
2. At the top of the screen, select the Print button. 
3. If there is more than one printer mapped for use with NFC, select the printer required. 
4. Select the print settings required for the job. 
5. Submit the job for printing. 
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Configuring AirPrint 

AirPrint is a software feature that allows you to print documents from Apple iOS-based mobile devices 
and Mac OS-based devices without a print driver. AirPrint-enabled printers allow you to print or fax 
directly from a Mac or from an iPhone, iPad, or iPod touch. You can use AirPrint to print from a wired or 
wireless device directly without using a print driver. You can also use AirPrint to scan from a printer to 
supported Apple devices. 

 
Notes: 

• Not all applications support AirPrint. 
• When AirPrint is enabled, HTTP, IPP, and Multicast DNS are enabled automatically. 
• IPP enablement requires a Web server reset. 
• The device that submits the AirPrint job must be on the same subnet as the printer. To allow 

devices to print from different subnets, configure your network to pass multicast DNS traffic 
across subnets. 

• Supported mobile devices: all models of iPad, iPhone 3GS or later, and iPod touch third 
generation or later, running the latest version of iOS. 

• If AirPrint is not available on your device, contact your Xerox representative. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 46. 

2. In the Embedded Web Server, click Properties > Connectivity > Setup. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to the 
System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

3. For Mobile Workflows, for AirPrint, click Edit. 
4. Configure HTTP, IPP, and Multicast DNS Registration as required. To configure a protocol, click Edit. 
5. To enable AirPrint, for Enablement, select one or both options: 

− Allow Printing/Faxing to be initiated From AirPrint Supported Devices 
− Allow Scanning to be initiated From AirPrint (or Mopria) Supported Devices 

Notes: 

• AirPrint Faxing is supported only on devices that have embedded fax enabled and are 
configured to allow sending. 

• AirPrint Printing/Faxing is enabled by default. 
• To require authentication for AirPrint Printing and Faxing, configure IPP authentication. 
• Enabling scanning for AirPrint also enables scanning for Mopria®. 
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6. For Require Authentication for Scanning, select an option: 
• Off: This option allows the device to scan without requiring authentication. 
• HTTP Basic: This option authenticates with user accounts that are configured in the device 

user database or in the network database. 

Note: HTTP Basic sends user login credentials as plain, unencrypted text over HTTP. To send 
encrypted login credentials, use HTTPS. 

• HTTP Digest: This option authenticates with user accounts that are configured in the device 
user database. 

7. If you selected HTTP Basic authentication, for Validation Location, select an option: 
− Validation on the Device: This option enables IPP authentication of user accounts that are 

configured in the device user database. 
− Validation on the Network: This option enables IPP authentication of user accounts that are 

configured on the network authentication server for the device. 

Note: The same network authentication configuration is used on the printer for each login method 
that is configured for Network Authentication. 

8. To edit the device name or location, for Device Name, Device Location, or Geographic Location,  
click Edit. 

Note: Providing a device name can help users identify the device. 

9. Click Save. 

For additional information about AirPrint configuration and settings, refer to the System Administrator 
Guide at www.xerox.com/office/ALC80XXdocs. 
 

Configuring Google Cloud Print™ 

Google Cloud Print allows you to print documents from an Internet-connected device without using a 
print driver. Documents stored in the cloud, a personal computer, tablet, or smartphone can be sent to 
the printer from anywhere. 

For more information on Google Cloud Print, including procedures for managing accounts, sharing 
printers, and printing, refer to the Google Cloud Print Help Center. 

Before you begin: 
• Set up a Google email account. 
• Configure the printer to use IPv4. 
• Configure Proxy Server settings as needed. 
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To configure Google Cloud Print™: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 46. 

2. In the Embedded Web Server, click Properties > Connectivity > Setup. 

Note: If this feature does not appear, log in as a system administrator. For details, refer to the 
System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

3. For Mobile Workflows, for Google Cloud Print Service, click Edit. 
4. For Status, for Registration Status, click Register Printer. The Printer Registration Options page 

opens. 
5. To give the printer a user-friendly name, click Edit. 

Note: Xerox recommends that you choose a user-friendly name that includes the printer location 
and department. 

6. Click Continue to Register. The Options for Registering Your Printer page opens. 
7. To change enablement settings, for Enablement, select options as needed. 
8. Click Register Printer. The Google Cloud Print Service page reappears with a link that allows you to 

complete the device registration. 

Note: If printer registration does not continue, to troubleshoot the problem, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

9. Within 15 minutes, click the link for Enabled - Finish device registration. The Google Cloud Print 
Printer confirmation page opens in a new browser tab. 

Notes: 

• If prompted, log in to your Google account. 
• If you do not click the link within 15 minutes, begin the registration process again. 

10. Click Finish printer registration. A message confirms that the printer is registered. The Cloud Printer 
is now ready to print. 

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer. 

Note: The default printer name appears in this format: Model name (MAC address). 

For additional information about Google Cloud Print configuration and settings, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
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Connecting to a Telephone Line 
 

 WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord. 

 

1. Ensure that the printer is powered off. 
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on 

the back of the printer. 
3. Connect the other end of the RJ11 cable to an operating telephone line. 
4. Power on the printer. 
5. Enable and configure the Fax functions. 
 

Optimizing Printer Performance 

Several factors influence printer performance, including temperature, humidity, air pressure, and the 
chemical characteristics of the paper and coatings. The printer must form an electrostatic image on the 
paper, which depends on the ability of the air to hold and transfer electrical charges. The paper and 
coatings must hold an electrical charge in the areas where the toner must adhere. 

To optimize the performance of your printer: 
1. At the printer control panel, press the Home button. 
2. Touch Device. 
3. Touch Tools. 
4. Touch Troubleshooting > Calibration > Print Calibration > Next. 
5. Follow the onscreen instructions to run the Print Calibration procedure. 
 

  



Getting Started 

 

 Xerox® AltaLink® C80XX Series Multifunction Printer 57 
 User Guide 
 

Initial Printer Setup 

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling 
the optional features and assigning an IP address for the Ethernet network connection. Printer settings 
can be configured at the printer control panel or by using the Embedded Web Server. To configure 
settings at the printer control panel, the Installation wizard starts the first time that you power on the 
printer. The wizard prompts you with a series of questions to help configure basic printer settings. 

The System Administrator can configure the following settings: 
• Language 
• Network Connection 
• Proxy Server Setup 
• Date and Time 
• Measurements 
• LDAP Settings 
• Apps Setup 
• Security Settings 

For more information on configuring the printer settings at the control panel or using the Embedded 
Web Server, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
 

Updating the Printer System Software 

Before installing print driver software, verify that the printer has the latest version of system software 
loaded. You can update your device when Xerox releases a new version of printer system software or 
firmware. To ensure a successful software update, follow the steps provided with the software files. 
Printer system software is downloaded from www.xerox.com/office/ALC80XXsupport. 

Before you download and install new software, determine the current software version installed on your 
device. Print the Configuration Report to compare the system software version with the version available 
for download. For instructions about printing a Configuration Report, refer to Printing the Configuration 
Report on page 44. 

Follow the instructions provided with the software to download the files and upgrade your device.  
You can configure the device to connect routinely to an FTP directory on your network to update device 
software automatically. You can also update the device software manually. For more information about 
updating system operating software, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
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Installing the Print Driver Software 

This section includes: 
• Operating System Requirements ................................................................................................................................58 
• Installing the Print Drivers for a Windows Network Printer ..............................................................................59 
• Installing the Print Drivers for a Windows USB Printer ......................................................................................59 
• Installing the Print Drivers for Macintosh OS X .....................................................................................................60 
• Installing Print Drivers and Utilities for UNIX, Linux and AS/400 Printing .................................................60 
• Installing the Printer as a Web Service on Devices ..............................................................................................61 

Before installing print driver software, verify that the printer is plugged in, turned on, connected correctly, 
and has a valid IP address. If you cannot find the IP address, refer to Finding the IP Address of Your 
Printer on page 46. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/ALC80XXdrivers. 
 
 

Operating System Requirements 
• Windows Vista SP2 
• Windows 7, Windows 8, Windows 8.1, Windows 10 
• Windows Server 2003 SP2 R2, Windows Server 2008 and R2, Windows Server 2012 and R2  
• Mac OS 10.8, 10.9, 10.10, 10.11 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 
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Installing the Print Drivers for a Windows Network Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the 

installer does not start automatically, navigate to the drive, and double-click the Setup.exe installer 
file. 

2. Select your printer model. 
3. Click Install Drivers. 
4. Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers. 
5. At the License Agreement, click I Agree. 
6. From the list of discovered printers, select your printer. 

Note: When installing drivers for a network printer, if your printer does not appear in the list, click 
the IP Address or DNS Name computer icon. In the IP Address or DNS Name field, type the IP 
address of your printer, then click Search to locate and select your printer. If you do not know the IP 
address of the printer, refer to Finding the IP Address of Your Printer on page 46. 

7. Click Next. 
8. If needed, you can name your printer by typing a name in the Queue Name field. 
9. If installing a print driver, make a print driver selection. 
10. If installing a scan driver, make a scan driver selection. 
11. Click Install. 
12. If needed, set the printer as the default printer. 

Note: Before selecting Share Printer, contact your system administrator. 

13. To complete the installation, click Finish, then click Close. 
 

Installing the Print Drivers for a Windows USB Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. To install the printer support software, select Software, then click Next. 
5. In the Software and Documentation window, clear the check box for any undesired options. 
6. Click Next. 
7. To complete the installation, click Finish. 
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Installing the Print Drivers for Macintosh OS X 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

Note: The latest print drivers are available for download from 
www.xerox.com/office/ALC80XXdrivers. 

2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer. 
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name. 
4. When prompted, click Continue. 
5. To accept the license agreement, click Agree. 
6. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
7. If prompted, enter your password, then click Install Software. 
8. From the list of discovered printers, select your printer, then click Next. 
9. If your printer does not appear in the list of discovered printers: 

a. Click the IP Address or DNS Name computer icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB 
cable is connected properly. 

11. To accept the print queue message, click OK. 
12. Select or clear the Set Printer as Default and Print Test Page check boxes. 
13. Click Continue, then click Close. 
 

Installing Print Drivers and Utilities for UNIX, Linux and AS/400 Printing 

UNIX-based printing uses LPD/LPR port 515 or lp to port 9100 to provide printer spooling and network 
print server functionality. Xerox® printers can communicate using either protocol. 

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in 
UNIX and Linux environments. Xerox® Printer Manager allows you to: 
• Configure and check the status of network connected printers. 
• Set up a printer on your network and monitor the operation of the printer after installation. 
• Perform maintenance checks and view supplies status at any time. 
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating 

systems. 

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver. You 
do not need both drivers. Xerox recommends that you install one of the full-featured custom print drivers 
for Linux. To locate drivers for your printer, go to www.xerox.com/office/drivers. 

For details about UNIX, Linux and AS/400 printing and drivers, refer to the System Administrator Guide 
at www.xerox.com/office/ALC80XXdocs. 
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Installing the Printer as a Web Service on Devices 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Device Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Device Wizard, click Add a Device. 
3. In the list of available devices, select the one you want to use, then click Next. 

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the 
WSD printer manually using the Add Printer Wizard. 

4. Click Close. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Printer Wizard, click Add a Printer. 
3. Click Add a network, wireless, or Bluetooth printer. 
4. In the list of available devices, select the one you want to use, then click Next. 
5. If the printer you want to use does not appear in the list, click The printer that I want is not listed. 
6. Select Add a printer using a TCP/IP address or hostname, then click Next. 
7. From the Device type field, select Web Services Device. 
8. Enter the printer IP address in the Hostname or IP address field, then click Next. 
9. Click Close. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Getting Started guide Print from the control panel. For details, refer to 
Information Pages on page 44. 

Other documentation for your printer www.xerox.com/office/ALC80XXdocs  

Recommended Media List United States: www.xerox.com/rmlna  
European Union: www.xerox.com/rmleu  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/ALC80XXsupport  

Information Pages Print from the control panel. For details, refer to 
Information Pages on page 44. 

Embedded Web Server information In the Embedded Web Server, click Help. 

Order supplies for your printer www.xerox.com/office/ALC80XXsupplies  

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
 
 

Locating the Serial Number 

When you order supplies or contact Xerox for assistance, you need the serial number of your device.  
You can obtain the serial number in several ways. To locate the serial number, print the Configuration 
Report. You can view the serial number on the control panel or on the Embedded Web Server home page. 
The serial number is printed on a label that is affixed to the printer. To view the label, open Door A, then 
locate the label on the left side of the printer. 

For details on how to print the configuration report, refer to Information Pages on page 44. 

To view the serial number on the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device. 
3. Touch About. 

The model, serial number, and software version is displayed. 
4. To return to the Home screen, press the Home button. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps 
already installed and displayed on the Home screen. Some Apps are installed as standard, but are hidden 
when you use your device for the first time. You can show, hide, or reorder Apps on the Home screen 
using the settings available in the Embedded Web Server. 

For details about displaying, configuring, and customizing the Apps, refer to the System Administrator 
Guide at www.xerox.com/office/ALC80XXdocs. 

A range of Apps is available for download and installation from the Xerox® App Gallery. These apps 
include Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed 
apps on compatible printers. 

For more information about using the Xerox® App Gallery and downloading Apps, refer to Xerox App 
Gallery on page 64. 
 

 

 3 Xerox® Apps 
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Xerox® App Gallery 

This section includes: 
• Xerox® App Gallery Overview .......................................................................................................................................64 
• Creating a Xerox® App Gallery Account ...................................................................................................................64 
• Logging in to your Xerox® App Gallery Account ...................................................................................................65 
• Installing or Updating an App from the Xerox® App Gallery ...........................................................................65 

 
 

Xerox® App Gallery Overview 
 

 

Use the Xerox® App Gallery to find Apps that provide new features or capabilities for 
your device. The Xerox® App Gallery provides direct access to Apps that can improve 
your productivity, simplify workflows, and enhance your user experience. 

The Xerox® App Gallery allows you to browse and update apps easily. You can browse 
through the app library without logging in. The moving banner provides an active 
display of apps, or you can scroll through the full list of apps. To get more details on 
an app, touch an app name in the list. 

 

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network 
connection. 

Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy 
exception at the device. 

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery 
User Guide available at www.xerox.com/XeroxAppGallery. 
 

Creating a Xerox® App Gallery Account 

With an App Gallery account, you have direct access to all the available Apps for your device. An App 
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps 
and licenses. 

You can set up an App Gallery account using the control panel or the Xerox® App Gallery Web portal.  
For more information about the Xerox® App Gallery Web portal, refer to 
www.xerox.com/XeroxAppGallery. 

Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your App Gallery Account 
on page 65. 
  

http://www.xerox.com/XeroxAppGallery
http://www.xerox.com/XeroxAppGallery
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To create an App Gallery account using the Control Panel: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox App Gallery. 
3. Touch Login. 
4. Touch Request an Account. 
5. To enter a valid email address, use the touch screen keypad, then touch OK. 

A message is displayed stating completion instructions have been sent to the email address entered. 
6. Touch Close. 
7. Access your email account for the email address that you provided to Xerox App Gallery. 
8. Open the Xerox App Gallery Account Request email, then click the URL link for creating an account. 
9. Review and accept the Terms of Use. To continue creating an account, click the Agree button. 
10. Enter the information required into the appropriate fields: 

− User ID 
− Password 
− Confirm Password 
− First and Last Name 
− Company Name 
− Country 

11. Click OK. 
12. After the account is created, a confirmation message appears. 
13. At the printer control panel, log in to your App Gallery Account. 
 

Logging in to your Xerox® App Gallery Account 

When you are logged in to the App Gallery, you can browse available Apps, and install and update Apps. 

Note: The first time that any user logs in to the Xerox® App Gallery from the device, the Xerox® App 
Gallery software updates automatically. Once the upgrade completes, a message instructs the user 
to exit and reselect the Xerox® App Gallery. All future Xerox® App Gallery upgrades are manual and 
initiated by the user. 

To log in to your App Gallery Account: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. To enter your User Name, use the touch screen keypad. 
4. To enter your Password, use the touch screen keypad. 
5. Touch OK or Enter. The Xerox® App Gallery opens. 
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Installing or Updating an App from the Xerox® App Gallery 

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App 
Gallery App to browse and install Apps at your device control panel. 

To install an App from the App Gallery: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. To enter your User Name, use the touch screen keypad. 
4. To enter your Password, use the touch screen keypad. 
5. Touch OK or Enter. The Xerox® App Gallery opens. 
6. Touch the App required, then touch Install. The License Agreement screen appears. 

Note: If the App was installed previously and a new version is available, the button is labeled as 
Update. 

7. Touch Agree. The installation process begins. 
If the App does not successfully install, to attempt the installation process again, touch Install. 

8. To exit the Xerox® App Gallery App, touch Exit, or press the Home button. 

To update an App from the App Gallery: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. To enter your User Name, use the touch screen keypad. 
4. To enter your Password, use the touch screen keypad. 
5. Touch OK or Enter. The Xerox® App Gallery opens. 
6. Touch the App required, then touch Update. The License Agreement screen appears. 
7. Touch Agree. 
8. When the update is complete, the Update button is labeled as Installed. 
9. To exit the Xerox® App Gallery App, touch Exit, or press the Home button. 
 



Xerox® Apps 

 

 Xerox® AltaLink® C80XX Series Multifunction Printer 67 
 User Guide 
 

Device 

This section includes: 
• Device Overview ................................................................................................................................................................67 
• About .....................................................................................................................................................................................68 
• Information Pages ...........................................................................................................................................................68 
• Supply Status ......................................................................................................................................................................69 
• Billing and Usage Counters ...........................................................................................................................................70 
• Remote Services ................................................................................................................................................................71 

 
 

Device Overview 
 

 

The Device App gives you access to information about your printer, including the 
serial number and model. You can view the status of the paper trays, billing and 
supplies information, and print information pages. 

 

Many Device options can be configured to meet your individual needs. For details about configuring all 
of the Device settings, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
 

Device Options 

The following Device options are available: 
 

Option Description 

 

About The About option provides an overview of your device, the device serial 
number, and information about current settings. 

 

Information Pages Your printer has a set of information pages that you can print. These 
pages include configuration and font information, demonstration pages, 
and more. 

 

Notifications Use the Notifications option to see details of any current alerts or errors 
on the device. A Fault History button displays fault codes and the date 
that they occurred on the device. 

 

Paper Trays Use the Paper Trays option to see the paper size, type, and color set for 
each paper tray and the tray-capacity status. 

 

Supplies Use the Supplies section to monitor the status of the components you 
can replace. The supply level and estimated number of impressions or 
days left for each unit is displayed. 
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Option Description 

 

Billing/Usage Use the Billing/Usage option to view the serial number and the total 
number of impressions made by your device. 

 

Tools Use the Tools option to customize settings such as the power-save modes, 
date and time, and control panel brightness. You can configure settings 
using the device control panel, or by using the Embedded Web Server. 

Note: For details on configuring the printer settings, see the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

 

Remote Services Use the Remote Services option to send error and usage information to 
the Xerox support team. 

Note: Your System Administrator must enable this feature using the 
Embedded Web Server. 

For details on configuring the printer settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

About 

The About option provides an overview of your device and its current settings and status. You can view 
the serial number, model number, and software version. 
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Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. 

To print an information page, select an option, then touch Print. 

The following Information Pages are available: 
 

Name Description 

Configuration Report The Configuration Report provides printer information including the serial 
number, installed options, network settings, port setup, tray information, 
and more. 

Billing Summary The Billing Summary report provides information about the device and a 
detailed listing of the billing meters and sheet counts. 

Getting Started The Getting Started guide provides an overview of the key features of the 
printer. 

Troubleshooting Print Quality 
Page 

The Troubleshooting Print Quality Page provides a list of common print-
quality problems and tips to help solve them. 

Supplies Usage Page The Supplies Usage Page provides coverage information and part numbers 
for reordering supplies. 

Graphics Demo Page Print this page to check the quality of graphics. 

PCL Font List The PCL Font List provides a printout of all PCL fonts that are available on 
the printer. 

PostScript Font List The PostScript Font List provides a printout of all PostScript fonts that are 
available on the printer. 
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Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts 
appear on the control panel. You can customize the alerts that appear on the control panel and 
configure email alert notifications. 

To check the supplies status at the control panel: 
1. To view status information for the printer supplies, touch Device > Supplies. 
2. To view details about a specific toner cartridge, including the part number for reordering, touch 

Cyan, Magenta, Yellow, or Black. 
3. To view more details, touch Other Supplies. Scroll through the list, then select an option. 
4. To print the Supplies Usage Page, touch Print Supplies Report. 
5. To return to the Supplies screen, touch X. 
6. To return to the Device screen, touch X. 
7. To return to the Home screen, press the Home button. 

To check the supplies status and set up alerts, use the Embedded Web Server. For details about 
configuring all Device settings, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 
 

Billing and Usage Counters 

The Billing/Usage menu displays the total number of impressions that the printer generated or printed 
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.  
For example, a sheet of paper that is printed on two sides counts as two impressions. 

To view the Billing and Usage Counters: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 

The impression counts are displayed: 
− Black Impressions: Total number of pages printed with no color specified. 
− Color Impressions: Total number of pages printed that specify color. 
− Total Impressions: Total number of color impressions and black impressions. 

3. To view more details, touch Usage Counters, then select an option. 
− Impression Counters: This option provides the number of impressions made by the printer.  

The number of impressions cannot equal the number of sheets counted, depending on the 
printer setup. If your printer is set up to count large sheets as large impressions or as multiple 
smaller impressions, the number of impressions can differ. 

− Sheet Counters: This option provides the number of impressions made by the printer. 
Impressions for 2-Sided sheets are identified as a separate line from1-Sided sheets. 
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− Images Sent Counters: This option provides the number of images sent using the Fax, Email, 
or Scan features. 

− Fax Impressions Counters: This option provides the number of images sent using the Fax 
features. Each fax feature is identified on a separate line. 

− All Usage Counters: This option provides all printer usage information. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 
 

Remote Services 

You can use the Remote Services option to send error and usage information to the Xerox support team 
to help them resolve problems quickly. 

For information about enabling Remote Services and uploading information to Xerox, refer to the 
System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
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Jobs 

This section includes: 
• Jobs Overview .....................................................................................................................................................................72 
• Managing Jobs ..................................................................................................................................................................72 
• Managing Special Job Types ........................................................................................................................................74 
• Managing Jobs using the Embedded Web Server ................................................................................................77 

 
 

Jobs Overview 
 

 

You can use Jobs to view current jobs, print saved and secure jobs, and view details 
about completed jobs. You can pause, delete, print, or view job progress or job details 
for a selected job. 

 
 

Managing Jobs 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.  
You can interrupt, pause, or delete jobs that are printing. You can also view job progress or job details for 
a selected job. 

A print job can be held by the printer when it is unable to complete the job. For example, if the printer 
needs attention, paper, or supplies. When the condition is resolved, the printer automatically resumes 
printing. When you send a Secure Print job, the job is held until you release it by entering a passcode at 
the control panel. For more details, refer to Managing Special Job Types on page 74. 

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs. 
For more details, refer to Managing Jobs using the Embedded Web Server on page 77. 

To interrupt printing: 
1. At the control panel, touch the Interrupt button. The printer continues to print while it determines 

the best place to pause the spooled print job. 
2. Printing stops to allow the printer to complete another job. 
3. To resume printing, touch the Interrupt button again. 
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To pause or delete a print job: 
1. At the printer control panel, press the Home button. 
2. To pause a job that is printing, touch the pause button on the control panel. 
3. Select a task. 

− To resume the print job, touch Resume. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 

4. To return to the Home screen, press the Home button. 

To pause, promote, or delete a job waiting to print: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs, then touch the name of the desired print job. 
3. Select a task. 

Note: If you do not make a selection, the job automatically resumes after the set timeout period. 

− To pause the print job, touch Hold. To resume the print job, touch Release. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 
− To move the job to the top of the list, touch Promote. 
− To view the status of the job, touch Job Progress. 
− To view information about the job, touch Job Details, then touch Job Settings or Required 

Resources. 
4. To return to the Home screen, press the Home button. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but cannot delete them. 

• Only the user that sent the job, or the system administrator, can delete a Secure Print job. 

To print a job held for resources: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. From the jobs list, touch the held job name. The resources required for the job appear on the control 

panel. 
4. Do one of the following steps. 

− To print the job, replenish the resources required. The job resumes automatically when the 
required resources are available. If the job does not print automatically, touch Resume. 

− To choose an alternative paper source to enable the job to print, touch Print On Alternate 
Paper. Select a paper tray, then touch OK. 

− To delete the print job, touch Delete. At the prompt, touch Delete. 

Note: The Print On Alternate Paper option is enabled using the Embedded Web Server. For details 
about the Print On Alternate Paper option, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

5. To return to the Home screen, press the Home button. 
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Managing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
 

Saved Job 

Saved Jobs are documents sent to the printer and stored there for future use. All users can print or delete 
a Saved Job. 

On the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded 
Web Server, on the Jobs window, you can view, print, and delete saved jobs, and you can manage where 
jobs are stored. 

To print using Saved Job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
can vary. 

− For Macintosh, in the Print window, in the print options list, click Xerox Features. 
3. For Job Type, select Saved Job. 

a. Type a job name or select a name from the list. 
b. Type a folder name or select a name from the list. 
c. To add a passcode, click Private, type the passcode, then confirm the passcode. 
d. Click OK. 

4. Select other required printing options. 
− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To print a saved job from the control panel, refer to Printing from Saved Jobs on page 133. 
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To print, delete, move, or copy a saved job in the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Home. 
3. Click Jobs. 
4. Click the Saved Jobs tab. 
5. For the job that you want to process, select the check box. 
6. From the menu, select an option. 

− Print Job: This option prints a job immediately. 
− Delete Job This option deletes the saved job. 
− Move Job: Use this option to move the job to another folder location. 
− Copy Job: Use this option to duplicate the job. 

7. Click Go. 
 

Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

After a Secure Print job is printed, it is deleted automatically. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, in the print options list, click Xerox Features. 
3. For Job Type, select Secure Print. 
4. Type the passcode, confirm the passcode, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 
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To release a Secure Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Secure Print jobs, touch Secure Jobs. 
4. Touch your folder. 
5. Enter the passcode number, then touch OK. 
6. Select an option. 

− To print a Secure Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete. 
− To delete all the jobs in the folder, touch Delete All. 

7. To return to the Home screen, press the Home button. 
 

Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel. 

Sample Set is a type of saved job with these features: 
• A Sample Set job appears in a folder named after the user ID associated with the print job. 
• A Sample Set job does not use a passcode. 
• Any user can print or delete a Sample Set job. 
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any 

remaining copies. 

After a Sample Set job is printed, it is deleted automatically. 

To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, in the Print window, in the print options list, click Xerox Features. 
3. For Job Type, select Sample Set. 
4. Select any other required printing options. 

− For Windows, click OK, select the number of copies, then click Print. 
− For Macintosh, select the number of copies, then click Print. 
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To release a Sample Set: 
1. At the printer control panel, press the Home button. 
2. To view available jobs, touch Jobs. 
3. Touch the Sample Set job. 

Note: The Sample Set file description shows the job as Held: Sample Requested. 

4. Touch Job Progress, then select an option: 
− To view information about the job, touch Job Details, then touch Job Settings or Required 

Resources. 
− To print the remaining copies of the job, touch Release. 
− To delete the remaining copies of the job, touch Delete. 

5. To return to the Home screen, press the Home button. 
 

Managing Jobs using the Embedded Web Server 

In the Embedded Web Server Active Jobs list, you can view a list of active jobs and delete print jobs.  
You can use the Embedded Web Server to submit jobs for printing at the device. You can use the Job 
Submission feature to print .ps, .pdf, .pcl, and .xps files without installing a print driver. You can select 
jobs for printing from your local computer hard drive, mass storage devices, or a network drive. 

Saved jobs are documents sent to the printer and stored there for future use. Any saved jobs appear on 
the Saved Jobs page. Use the Saved Jobs page to view, print, and delete saved jobs, and create and 
manage folders in which they are stored. 

To manage jobs using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Jobs. 
3. Click the job name. 
4. From the menu, select an option. 

− To pause the print job, click Pause, then click Go. 
− To delete the print job, click Delete, then click Go. At the prompt, click OK. 

5. To return to the Home screen, click Home. 

To submit jobs for printing using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Home. 
3. Click Print. 
4. For File Name, click Browse or Choose File, then do one of the following steps. 

− Navigate to the file, then select it. 
− Type the path to the file that you want to select. 

5. In the Printing area, for Copies, select Auto, or enter the number of copies to print. 
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6. For Job Type, select an option: 
− Normal Print: This option prints a job immediately. 
− Secure Print: This option prints a job after you enter your passcode at the printer control panel. 
− Sample Set or Proof Print: These options print one copy of a multiple-copy print job. The 

device holds the remaining copies in memory until you release them for printing at the control 
panel. 

− Save Job for Reprint: This option saves a print job in a folder on the print server for future 
printing. You can specify a job name and folder. 

− Delay Print: This option prints a job at a specified time up to 24 hours from the original job 
submission. 

7. As needed, for Paper Selection, select paper size, color, type, and tray. 
8. As needed, select job options. 

− 2-Sided Printing 
− Collate 
− Orientation 
− Staple 
− Folding 
− Output Destination 

Note: The available options vary by device. 

9. If Accounting is enabled, enter your User ID and Account ID. 
10. Click Submit Job. 

To reprint saved jobs using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Home. 
3. Click Jobs. 
4. Click the Saved Jobs tab. 
5. For the job that you want to process, select the check box. 
6. From the menu, select an option. 

− Print Job: This option prints a job immediately. 
− Delete Job This option deletes the saved job. 
− Move Job: Use this option to move the job to another folder location. 
− Copy Job: Use this option to duplicate the job. 

7. Click Go. 
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Copy 

This section includes: 
• Copy Overview ...................................................................................................................................................................79 
• Making a Copy ...................................................................................................................................................................79 
• Copy Workflows .................................................................................................................................................................82 

 
 

Copy Overview 
 

 

To make a copy, the device scans your original documents and temporarily stores the 
images. It then prints the images based on the options that you selected. You can 
change settings for individual jobs based on the original documents. You can save 
settings that you use for regular jobs and retrieve them for later use. 

 

For details on configuring and customizing the Apps, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

If Authentication or Accounting is enabled on your device, to access Copy features, enter your login 
details. 

For information about all the App features and available settings, refer to Apps Features on page 359. 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Making a Copy 

To make a copy: 
1. Load your original documents. 

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use 
the document glass. Lift the duplex automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

 
− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 

staples and paper clips from the pages. Insert the original documents face up in the duplex 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 

 
2. At the printer control panel, press the Home button. 
3. Touch Copy. 
4. To clear previous App settings, touch Reset. 
5. To enter the number of copies needed, use the numeric keypad. 
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6. Adjust copy settings as needed. 
− To scan more documents using the document glass, or to change settings for different sections 

of the job, touch Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Copying, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 

7. Touch Start. If you placed documents in the feeder, scanning continues until the feeder is empty. 
8. If Build Job is enabled, touch Scan and when prompted, do these steps. 

− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

9. To return to the Home screen, press the Home button. 
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Copy Workflows 

This section includes: 
• Adjusting Color Settings .................................................................................................................................................82 
• Erasing the Edges of Copies .........................................................................................................................................84 
• Specifying the Size of the Original .............................................................................................................................84 
• Shifting the Image ...........................................................................................................................................................85 
• Book Copying .....................................................................................................................................................................85 
• Creating a Booklet ............................................................................................................................................................86 
• Adding Covers ....................................................................................................................................................................87 
• Adding Inserts ....................................................................................................................................................................87 
• Specifying Chapter Start Pagination.........................................................................................................................88 
• Specifying Exception Pages ..........................................................................................................................................89 
• Adding Annotations .........................................................................................................................................................89 
• Changing the Page Layout ...........................................................................................................................................91 
• Building a Copy Job .........................................................................................................................................................91 
• Printing a Sample Copy ..................................................................................................................................................92 
• Saving Current Copy Settings ......................................................................................................................................93 
• Retrieving Saved Copy Settings ..................................................................................................................................93 

Note: Some features are hidden from view when the Copy App is installed. For details on configuring and 
customizing the Apps, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
 

Adjusting Color Settings 

Before printing a copy of a color original image, you can adjust the balance of the printing colors 
between cyan, magenta, yellow, and black. You can adjust the color of the copy using preset color 
effects. For example, you can adjust colors for brightness or coolness. Adjusting the saturation makes the 
image colors more vivid or pastel. 

To select color or black and white output: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Output Color. 
  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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4. For Output Color, touch an option. 
− Auto Detect: The device detects the color content in the original document. If the original 

content is a color document, the printer makes copies in full color. If the original content is a 
black and white document, the printer makes copies in black only. 

− Black & White: This option produces copies in black and white only. Colors in the original 
content are converted to shades of gray. 

− Color: This option copies in full color output using all four printing colors, cyan, magenta, 
yellow, and black. 

− To access the Single Color option, touch More. 
Single Color produces shades of a single color. To select a color, touch Color, then select an 
option. Your color selection appears on the sample page. 

5. Touch OK. 

To adjust the Color Balance: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Color Balance. 

Note: This feature is not available when Output Color is set to Black and White. 

4. To adjust the density levels of all four colors: 
a. On the Color Balance screen, touch Basic Color. 
b. Move the sliders to adjust the level for each color. 

5. To adjust the highlight, midtone, and shadow density levels by color: 
a. On the Color Balance screen, touch Advanced Color. 
b. Touch the color you want to adjust. 
c. Move the sliders to adjust the levels for highlights, midtones, and shadows. 
d. To adjust more colors, repeat the previous two steps. 

6. Touch OK. 

To add color effects: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Color Presets. 

Note: This feature is not available when Output Color is set to Black and White. 

4. On the Color Presets screen, touch the required preset color effect. The sample images show how 
the colors are adjusted. 

5. Touch OK. 
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To adjust the Saturation: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Saturation. 
4. To adjust the saturation, move the slider. 
5. Touch OK. 
 

Erasing the Edges of Copies 

You can erase content from the edges of your copies using the Edge Erase feature. You can specify the 
amount to erase on the right, left, top, and bottom edges.  

To erase the edges of copies: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Edge Erase. 
4. Select one of the following options. 

− All Edges: This option erases all four edges by the same amount. To adjust the amount to 
erase, move the slider. 

− Individual Edges: This option allows you to specify different amounts to erase from the edges. 
Touch the required Top, Bottom, Left or Right field. To enter the amount to erase, use the 
numeric keypad, or touch the arrows. 

5. To mirror the same erase amount applied to Side 1 on Side 2, touch the Mirror Side 1 check box. 
6. To select a pre-defined amount of erase, use the Presets option. 
7. Touch OK. 
 

Specifying the Size of the Original 

Use the Original Size feature to set a standard or custom size for scanning, or for the printer to 
determine the original size document automatically. You can use this feature to enable mixed-size 
original document scanning. 

To specify the original size: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Original Size. 
  



Xerox® Apps 

 

 Xerox® AltaLink® C80XX Series Multifunction Printer 85 
 User Guide 
 

4. Select an option. 
− Auto Detect: This option allows the printer to determine the size of the original document. 
− Preset Scan Area: This option specifies the area to scan when it matches a standard paper size. 

In the scrolling list, touch the desired paper size. 
− Custom Scan Area: You can specify the width and length of the area to scan. To specify the 

original width or length, touch the appropriate field. To enter the size, use the numeric keypad, 
or use the arrows. 

− Mixed Size Originals: You can scan standard-size originals of varying sizes. To determine which 
original sizes can be mixed in the same job, use the diagram on the screen. 

5. Touch OK. 
 

Shifting the Image 

You can change the placement of an image on the copy page. This is useful if the image is smaller than 
the page size. For image shift to work correctly, position original documents as follows. 
• Document Feeder: Position original documents face up, long edge entering the feeder first. 
• Document Glass: Position original documents face down, in the upper-left corner of the document 

glass, long edge to the left. 

To change the placement of the image: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Image Shift. 
4. Select one of the following options. 

− Off: This option is the default setting. 
− Auto Center: This option centers the image on the page. 

5. To enter a specific amount of image shift, touch More, then touch Margin Shift. Touch the required 
Up / Down or Left / Right fields. To enter the amount of shift, use the numeric keypad, or touch the 
arrows. 

6. To mirror the same image shift applied to Side 1 on Side 2, touch the Mirror Side 1 check box. 
7. To select a pre-defined amount of shift, use the Presets option. 
8. Touch OK. 
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Book Copying 

You can use the Book Copying feature to copy books, magazines, or other bound documents. You can 
use this feature to copy images for different results. 

You can copy either the left or right page onto a single sheet of paper. You can copy both the left and 
right pages onto two sheets of paper. 

Note: Use the document glass to make copies from books, magazines, or other bound documents. 
Do not place bound originals in the document feeder. 

To set up book copying: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Book Copying. 
4. Select one of the following options. 

− Off: This option is the default setting. 
− Both Pages: This option scans both pages of an open book onto two sheets of paper. 
− Left/Right Page Only: This option scans the left or right page of an open book onto a single 

sheet of paper. 
5. If Binding Edge Erase is required, touch More. Touch the Binding Edge Erase field. To enter the 

amount to erase, use the numeric keypad, or touch the arrows. You can erase up to 50 mm (2 in.) 
from both pages, or 25 mm (1 in.) from one page. 

6. Touch OK. 
 

Creating a Booklet 

The Booklet Creation feature prints two pages on each side of the paper. The printer reorders and 
reorients the pages so that they are in the correct order and orientation when folded. If more finishing 
options are available, the pages can be stapled and folded to create a booklet. 

To create a booklet: 

Note: In this mode, the printer scans all the original documents before it prints the copies. 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Booklet Creation. 
4. Select one of the following options. 

− Off: This option is the default setting. 
− On: This option enables Booklet Creation. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
required paper tray, then touch OK. 
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5. To change the Original Input, Paper Supply or finishing options, touch More, then select an option. 
− To scan 1 or 2-sided originals, touch Original Input, then select an option. 
− To change the paper source for the booklet, touch Paper Supply, then select an option. 
− If your printer has a finisher installed, for Fold & Staple, select a staple or fold option. 

6. Touch OK. 
 

Adding Covers 

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight 
paper. The printer selects the paper from a different tray. The covers can be blank or printed. 

To add covers to your copy job: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Special Pages > Covers. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
required paper tray, then touch OK. 

4. For Covers Options, select an option. 
− Front & Back Same: This option includes front and back covers from the same tray. 
− Front & Back Different: This option includes a front and a back cover from different trays. 
− Front Only: This option includes a front cover only. 
− Back Only: This option includes a back cover only. 

5. For Printing Options, select an option. 
− Blank Cover: This option inserts a blank cover. 
− Print on Side 1 Only: This option prints on the front side of the cover only. To rotate the image 

on side 2 by 180 degrees, touch Rotate Side 2. 
− Print on Side 2 Only: This option prints on the back of the cover only. To rotate the image on 

side 2 by 180 degrees, touch Rotate Side 2. 
− Print on Both Sides: This option prints on both sides of the cover. 
− Rotate Side 2: If covers are 2-Sided, touch this option to rotate the image on side 2 by  

180 degrees. 
6. For Paper Supply, touch the required tray. 
7. Touch OK. The options that you selected appear on the Special Pages screen. 
8. To edit or delete a special page entry, touch the entry in the list. From the menu, touch the required 

option. 
9. Touch OK. 
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Adding Inserts 

You can insert blank pages or pre-printed sheets in specific locations in your copy job. To do this, you 
specify the tray that contains the inserts. 

To add inserts to a copy job: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Special Pages > Inserts. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
required paper tray, then touch OK. 

4. To specify the number of sheets to insert, touch the Insert Quantity field. To enter the number of 
sheets, use the numeric keypad, or use the arrows. Touch Enter. 

5. To enter a location for the insert, touch the Insert After Page entry box. To enter a page number, 
use the numeric keypad. Touch Enter. 

6. To specify the paper tray to use for the insert:  
a. Touch Paper Supply. 
b. Touch the required paper tray. 
c. Touch OK. 

7. Touch Add. The insert appears in the list on the Inserts screen. To add more inserts, repeat the 
previous steps. 

8. Touch X. The options that you selected appear on the Special Pages screen. 
9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required 

option. 
10. Touch OK. 
 

Specifying Chapter Start Pagination 

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If 
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side 
of the paper. 

To specify chapter start pagination: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Special Pages > Chapter Starts. 
4. To specify the chapter start page, touch Page Number. To enter the page number, use the numeric 

keypad. Touch Enter. 
5. For Start Chapter, select an option. 

− On Right Page: This option specifies the front of the paper. 
− On Left Page: This option specifies the back of the paper. 
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6. Touch Add. The page is added to the list on the right side of the screen. 
7. To set other pages, repeat the previous steps. 
8. Touch X. The options that you selected appear on the Special Pages screen. 
9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required 

option. 
10. Touch OK. 
 

Specifying Exception Pages 

You can specify exception pages to print on paper that is loaded in a different paper tray than the paper 
for the rest of the document. Ensure that the paper you use for the exception pages is the same size as 
the paper that you use for the rest of the document. 

To specify the exception pages: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Special Pages > Exceptions. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
required paper tray, then touch OK. 

4. To enter the range of pages to print on different paper: 
− To enter the starting page number, touch the first Page Number field. To enter the starting 

page number, use the numeric keypad. Touch Enter. 
− To enter the ending page number, touch the second Page Number field. To enter the last page 

number, use the numeric keypad. Touch Enter. 

Note: To specify a single page as an exception, enter that page number as the start and end of the 
range. 

5. To specify the paper to use for the exception pages: 
a. Touch Paper Supply. 
b. Touch the tray that contains paper to use for the exception pages. 
c. Touch OK. 

6. Touch Add. The page range is added to the list on the right side of the screen. 
7. To set other pages, repeat the previous steps. 
8. Touch X. The options that you selected appear on the Special Pages screen. 
9. To edit or delete a special-page entry, touch the entry in the list. From the menu, touch the required 

option. 
10. Touch OK. 
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Adding Annotations 

You can automatically add annotations such as page numbers and the date to your copies. 

Notes: 
• You cannot add annotations to covers, inserts, or blank chapter-start pages. 
• If Booklet Creation is selected, you cannot add annotations. 

To add annotations: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Annotations. 
4. To add page numbers: 

a. Touch Page Number. 
b. Touch On. 
c. Touch the Starting Page Number entry box. To enter a page number, use the numeric keypad, 

then touch Enter. 
d. Touch Apply To, then select an option. 
e. To position the page number, touch an arrow. The sample page shows the location of the page 

number. 
f. Touch OK. 

5. To insert a comment: 
a. Touch Comment. 
b. Touch On. 
c. For Stored Comments, touch an option in the list. 

• Touch an existing comment. 
• To create a comment, touch an Available option. To enter the annotation text, use the 

touch screen keypad, then touch OK. 
• To edit or delete a comment, use the buttons below the Stored Comments list. 

d. Touch Apply To, then select an option. 
e. To position the comment, touch an arrow. The sample page shows the location of the 

comment. 
f. Touch OK. 

6. To insert the current date: 
a. Touch the desired current date location. 
b. Touch Date. 
c. Touch On, then touch the date format that you wish to use. 
d. Touch Apply To, then select an option. 
e. To position the date in the header or footer, touch an arrow. The sample page shows the 

location of the date. 
f. Touch OK. 
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7. To insert a Bates Stamp: 
a. Touch Bates Stamp. 
b. Touch On. 
c. For Stored Prefixes, touch an option in the list. 

• Touch an existing prefix. 
• To create a prefix, touch an Available option. To enter text, use the touch keypad, then 

touch OK. 
• To edit or delete a prefix, use the buttons below the Stored Prefixes list. 

d. Touch Starting Page Number. To enter the starting page number, use the alphanumeric 
keypad. You can use leading zeros to indicate the number of digits required. Touch Enter. 

e. Touch Apply To, then select an option. 
f. To position the Bates Stamp in the header or footer, touch an arrow. The sample page shows 

the location of the Bates Stamp. 
g. Touch OK. 

8. To change the text formatting, touch Format & Style, choose the required settings, then touch OK. 
9. To remove all entered annotations, touch Delete All. 
10. Touch OK. 
 

Changing the Page Layout 

You can use Page Layout to place a defined number of pages on one or both sides of the paper. 

To change the page layout: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Page Layout. 
4. Select one of the following options. 

− Pages per Side: This option places a defined number of pages on one or both sides of the 
paper. Select the required number of pages per side. 

− Repeat Image: This option places a defined number of the same image on one or both sides of 
the paper. Select the number of images required. Auto Repeat allows the printer to determine 
the maximum number of images that can fit on the currently selected paper size. 

5. To enter a specific number of rows and columns, touch Specify Rows & Columns. Touch the Rows 
or Columns field. To enter the number of rows and columns, use the numeric keypad, or touch the 
arrows. To rotate the paper, select the check box for Rotate Background. 

6. To change the original orientation, touch Original Orientation. Select Portrait or Landscape. 
7. Touch OK. 
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Building a Copy Job 

Use this feature to produce complex jobs that include a variety of originals requiring different App 
settings. Each segment of the job can have different settings. After all the segments are programmed, 
scanned, and temporarily stored in the printer, the job is processed and completed. 

To build a job: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. To clear previous App settings, touch Reset. 
4. Touch Build Job. 
5. Split the job into the required segments for scanning. 
6. Program and scan the first segment: 

a. Load the original document for the first segment. 
b. Select the options required for the segment. 
c. Touch Scan. 

7. Set the required build job display options. 
8. Print a Sample segment or delete a segment. 

a. To print a sample of the previous segment scanned, touch the segments option, then touch 
Sample Last segment. 

b. To delete the previous segment scanned, touch the segments option, then touch Delete Last 
Segment. 

c. To delete all the previous segment scanned, touch the segments option, then touch Delete All 
Segments. 

9. Program and scan more segments. 
a. Load the originals for the next segment. 
b. To change the settings for the next segment, touch Program Next Segment, then select the 

options required for the segment. 
c. Touch Scan Next Segment. 

10. Continue scanning segments until all original documents are scanned. 
11. Touch Submit. 
 

  



Xerox® Apps 

 

 Xerox® AltaLink® C80XX Series Multifunction Printer 93 
 User Guide 
 

Printing a Sample Copy 

Sample Copy allows you to print a test copy of a job to inspect before printing multiple copies.  
This feature is useful for complex or high-volume jobs. After you print and inspect the test copy, you can 
choose to print or cancel the remaining copies. 

To print a sample copy of your job: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Adjust the copy settings as needed. 
4. Enter the number of copies needed. 
5. Touch the Sample Copy toggle button. 
6. Touch the Start button. The sample copy prints. 
7. Inspect the sample copy, then select one of the following options. 

− If the copy is unsatisfactory, touch Delete. Touch Delete to confirm. The job is canceled and no 
more copies are printed. 

− If the copy is satisfactory, touch Release. The remaining copies are printed. 
8. To return to the home screen, press the Home button. 
 

Saving Current Copy Settings 

To use a particular combination of copy settings for future copy jobs, you can save the settings with a 
name and retrieve them for later use. 

To save the current copy settings: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Change the settings required. 
4. Touch Save Current Settings. 
5. To create a new saved setting, touch any option labeled <Available>. 
6. Enter a name for the saved setting using the touch screen keyboard, then touch OK. 
 

  



Xerox® Apps 

 

94 Xerox® AltaLink® C80XX Series Multifunction Printer 
 User Guide 
 

Retrieving Saved Copy Settings 

You can retrieve and use any previously saved copy settings for current jobs. 

Note: To save the copy settings with a name, refer to Saving Current Copy Settings on page 93. 

To retrieve saved settings: 
1. At the printer control panel, press the Home button. 
2. Touch Copy. 
3. Touch Retrieve Saved Settings. 
4. Touch the saved setting required. 

Note: To delete a saved setting, touch the setting, then touch Delete Settings. Touch Delete to 
confirm. 

5. Touch OK. The saved settings are loaded for the current copy job. 
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ID Card Copy 

This section includes: 
• ID Card Copy Overview ..................................................................................................................................................95 
• Copying an ID Card .........................................................................................................................................................95 

 
 

ID Card Copy Overview 
 

 

You can use the ID Card Copy App to copy both sides of an ID card or small 
document onto one side of paper. To copy the card properly, place each side in the 
upper-left corner of the document glass. The printer stores both sides of the 
document, then prints them side by side on the paper. 

 

The ID Card Copy App is hidden from view on initial device setup. For details about configuring and 
customizing the Apps, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

For information about all the App features and available settings, refer to Apps Features on page 359. 
 

Copying an ID Card 

To copy an ID card: 
1. Lift the document feeder, then place the original document in the upper-left corner of the document 

glass. 
2. At the printer control panel, press the Home button. 
3. Touch ID Card Copy. 
4. To clear previous App settings, touch Reset. 
5. Adjust the settings as required. 
6. Touch Scan Front. 
7. When scanning is finished, lift the document feeder. Place the second side of the original document 

in the upper-left corner of the document glass. 
8. To scan the second side of the original document and print the copies, touch Scan Back. 
9. To return to the home screen, press the Home button. 
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Email 

This section includes: 
• Email Overview ..................................................................................................................................................................96 
• Sending a Scanned Image in an Email ....................................................................................................................96 
• Adding or Editing Contacts in the Device Address Book from the Control Panel .....................................98 

 
 

Email Overview 
 

 

You can use the Email App to scan images and attach them to emails. You can 
specify the file name and format of the attachment, and include a subject heading 
and message for the email. 

 

For details about configuring and customizing the Apps, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

For information about all the App features and available settings, refer to Apps Features on page 359. 
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Sending a Scanned Image in an Email 

To send a scanned image in an email: 
1. Load your original documents. 

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use 
the document glass. Lift the duplex automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

 
− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove all 

staples and paper clips from the pages. Insert the original documents face up in the duplex 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 

 
2. At the printer control panel, press the Home button. 
3. Touch Email. 
4. To clear previous App settings, touch Reset. 
5. Enter recipients. 

− If the entry screen is displayed, to enter a recipient, touch an option or touch X. 
− To select a contact or group from the Address Book, touch the Device Address Book option. 

Touch Favorites or Contacts, then select a recipient. Touch OK. 
− To select a contact from the Network Address Book, touch the Network Address Book option. 

Enter a name and touch Search, then select a recipient. Touch OK. 
  



Xerox® Apps 

 

98 Xerox® AltaLink® C80XX Series Multifunction Printer 
 User Guide 
 

− To enter the email address manually, touch Manual Entry. In the Enter Email address field, 
enter the email address, then touch Add. 

− To add your own email address to the recipient list, touch Add Me. If necessary, enter your 
login details. 

− To add more recipients, touch Add Recipient, then repeat the procedure. 

Note: The choices available for adding recipients depends on system configuration. 

6. To organize the recipients, touch one of the recipients on the list, then from the menu, select To:, Cc: 
or Bcc:. 

7. Adjust the email settings as needed. 
− To change the subject, touch Subject, enter a new subject, then touch OK. 
− To save the scanned document as a specific file name, touch the attachment file name, enter a 

new name, then touch OK. 
− To save the scanned document as a specific file format, touch the attachment file format, then 

select the required format. To create a searchable file or to add password protection, from the 
file format menu, select More. 

− To change the email message, touch Message, enter a new message, then touch OK. 
− To scan more documents using the document glass, or to change settings for different sections 

of the job, touch Build Job. 
− If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option. 
For details about available features, refer to Apps Features on page 359. 

8. To start the scan, touch Send. 
9. If Build Job is enabled, touch Scan and when prompted, do these steps. 

− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

10. To return to the Home screen, press the Home button. 
 

Adding or Editing Contacts in the Device Address Book from the Control 
Panel 

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain 
up to 5000 contacts that you can access when you enter recipients or destinations using apps. 

To add or edit contacts in the Device Address Book from the control panel: 

Note: Before you can use this feature, the system administrator must enable Create/Edit Contact 
from Touch Screen for All Users. 

1. Load your original documents.  
2. At the printer control panel, press the Home button. 
3. Touch Email. 
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4. To clear previous App settings, touch Reset. 
5. Touch Manual Entry. To enter an email address, use the touch screen keypad. 
6. To add the recipient to the Device Address Book, touch the Address Book icon. 
7. Do one of the following steps. 

− To create an entry, touch Create New Contact. To enter contact details, touch a field, then use 
the touch screen keypad. Touch OK. 

− To add to an existing entry, touch Add to Existing Contact. In the list, touch a contact. To find 
a contact, touch Search. 

8. To mark a recipient to appear as a favorite option, touch the Star icon. 
9. Adjust the email settings as needed. 
10. To start the scan, touch Send. 
11. To return to the Home screen, press the Home button. 
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Workflow Scanning 

This section includes: 
• Workflow Scanning Overview .................................................................................................................................... 100 
• Using Workflow Scanning .......................................................................................................................................... 100 

 
 

Workflow Scanning Overview 
 

 

The Workflow Scanning App allows you to scan an original document, distribute, and 
archive the scanned image file. The Workflow Scanning feature simplifies the task of 
scanning many multi-page documents and saving the scanned image files in one or 
more file locations. 

 

Note: The system administrator must set up this feature before you can use it. For details, refer to 
the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

The Workflow Scanning App enables you to scan documents using pre-defined settings to a range of file 
destinations quickly and easily. There are several workflow options: 
• Distribution workflows enable you to scan documents to one or more file destinations. File 

destinations include an FTP site, a website, and a network server. You can add fax destinations to 
workflows too. 

• Scan to Mailbox enables you to scan documents to public or private mailbox folders on the printer 
hard drive. 

• Scan to Home enables you to scan documents to a personal Home folder on your network. 
• Scan to USB enables you to scan documents to a connected USB Flash drive. 

Notes: 

• To scan original documents to a file destination associated with a contact in the address book, 
refer to Scan To on page 112. 

• To scan original documents to an email address, refer to Email on page 96. 

For information about all the App features and available settings, refer to Apps Features on page 359. 
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Using Workflow Scanning 

To scan an original document: 
1. Load your original documents. 

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use 
the document glass. Lift the duplex automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

 
− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 

staples and paper clips from the pages. Insert the original documents face up in the duplex 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 

 
2. At the printer control panel, press the Home button. 
3. Touch Workflow Scanning. 
4. To clear previous App settings, touch Reset. 
5. To select a workflow, from the Pick a Workflow screen, touch an option. If necessary, touch Update 

to refresh the workflow list. 

Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change 
Workflow. 

6. If needed, enter recipients, workflow destination details, or browse to the location required for the 
scanned originals. 
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7. Adjust the workflow scanning settings as needed. 
− To save the scanned document as a specific file name, touch the attachment file name, enter a 

new name, then touch OK. 
− To save the scanned document as a specific file format, touch the attachment file format, then 

select the required format. 
− If you are using the document glass, to combine pages into a single scan file, enable Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 

8. To start the scan, touch Scan. 
9. If Build Job is enabled, when prompted, do these steps. 

− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

10. To return to the Home screen, press the Home button. 

Notes: 

• The printer must be connected to a network to retrieve a scan file remotely. 
• For details, refer to the Help in the Embedded Web Server. 
• Print, copy, and fax jobs can print while you are scanning original documents or downloading 

files from the printer hard drive. 
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Distribution Workflows 

This section includes: 
• Predefined Network File Repositories .................................................................................................................... 103 
• Creating a New Workflow........................................................................................................................................... 103 

Distribution Workflows are customized workflows used in the Workflow Scanning App. A workflow 
contains pre-programmed settings for a scan job that specify how and where scanned documents are 
distributed. A workflow can include one or more file destinations, as well as fax destinations. You can 
store customized scan settings in each workflow. 

Using the Embedded Web Server, you can create a workflow using one or more scan destinations. The 
following options are available: 
• Predefined scan destinations from the list of file repositories. 
• New scan destinations such as an FTP site, a website, or an SMB server. 
• Fax number destinations. 

When you create a workflow, it appears in the list of workflows in the Pick a Workflow screen of the 
Workflow Scanning App. 

At the printer control panel, when you select a workflow, you can change the scan settings and add more 
scan destinations from the predefined list. 
 

Predefined Network File Repositories 

A file repository is a predefined file destination that you can use in a workflow. You can use the printer 
control panel to add a file repository to a workflow. 

The system administrator configures the file repositories available as predefined scanned file 
destinations. At least one repository must be set up for the Workflow Scanning feature to be available. 
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

Note: On the Pick a Workflow screen, the DEFAULT workflow is associated with the default file 
repository. 

 

Creating a New Workflow 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 46. 

2. Click the Scan tab. 
3. In the Display area, select Workflows, then select Create New Workflow. 
4. For Add Destination to Workflow, select an option: 

− To add an existing file destination to the workflow, select Select from a Predefined List. 
− To add a file destination to the workflow, select Enter a Scan Destination. 
− To add a fax destination to the workflow, select Enter a Server Fax Number. 
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5. For Select from a Predefined List, select a destination from the File Destination list, then click Add. 
6. For Enter a Scan Destination, add these details: 

a. Click the Friendly Name field, then enter a name for the scan destination. 
b. For Protocol, select an option, then enter the destination address. 

• For IP Address, enter the IP Address: Port number. 
• For Host Name, enter the Host Name: Port number. 

c. Enter the name of the destination folder as needed. In SMB, the destination folder is the 
shared folder. 

d. In Document Path, enter the name of the subfolder within the destination folder. Select a Filing 
Policy. 

e. Enter a valid login name and password. 

Note: Use the login name for the computer that holds the destination folder. The login name can 
include the domain name, such as domain name\login name. 

f. Click Add. 
7. For Enter a Server Fax Number, add a Fax Number, set the Delivery options, then click Add. 
8. To add another destination to the workflow: 

− To add a file destination, for File Destinations, click Add. 
− To add a fax destination, for Fax Destinations, click Add. 

9. Set the scan settings for the workflow as required. 

After a workflow is created in the Embedded Web Server, the workflow is added to the list in the 
Workflow Scanning App. 
 

Scanning to a Shared Network Folder 

You can scan to a shared folder on a network using SMB. The folder can be on a server or computer 
running SMB services. 

To scan to a shared network folder, create a shared folder with read and write access privileges. 
 

Sharing a Folder on a Windows Computer 
1. Open Windows Explorer. 
2. Right-click the folder you want to share, then select Properties. 
3. Click the Sharing tab, then click Advanced Sharing. 
4. Select Share this folder. 
5. Click Permissions. 
6. Select the Everyone group, and verify that all permissions are enabled. 
7. Click OK. 

Note: Remember the Share name for later use. 

8. Click OK again. 
9. Click Close. 
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Sharing a Folder in Macintosh OS X Version 10.7 and Later 
1. From the Apple menu, select System Preferences. 
2. From the System Preferences window, select Sharing, then select File Sharing. 
3. Under Shared Folders, click the Plus icon (+). Browse to the folder that you want to share on the 

network, then click Add. 
4. To modify access rights for your folder, select the folder. The groups activate. 
5. From the Users list, click Everyone, then use the arrows to select Read & Write. 
6. Click Options, then select a share-folder option. 

− To share the folder, select Share files and folders using SMB. 
− To share the folder with specific users, next to the user name, select On. 

7. Click Done. 
8. Close the System Preferences window. 

Note: When you open a shared folder, a Shared Folder banner appears in the Finder for the folder 
and subfolders. 
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Scanning to a Mailbox Folder 

This section includes: 
• Scanning to the Public Mailbox Folder .................................................................................................................. 106 
• Scanning to a Private Mailbox Folder .................................................................................................................... 107 
• Creating a Private Mailbox Folder ........................................................................................................................... 108 
• Retrieving Scan Files from a Mailbox Folder ....................................................................................................... 108 

Scanning to a folder is the simplest scanning method. This function allows users to scan files to 
mailboxes, which are folders created on the printer hard drive. When you scan an image at the printer, 
the scan file is stored in a folder on the internal hard drive. You can use the Embedded Web Server to 
retrieve the stored scan file to save to your computer. 

The default settings create a 1-sided, color, portable document format .pdf file. You can change the 
default settings using the printer control panel, or using the Embedded Web Server at your computer. 
Control panel selections override the settings in the Embedded Web Server. 
 

Scanning to the Public Mailbox Folder 

The printer provides a public mailbox folder to store scanned images. You do not need a password to 
scan images to the public mailbox folder, or to retrieve the scanned images. All users can view scanned 
documents in the public mailbox folder. You can create a password-protected private mailbox folder.  
For details, refer to Creating a Private Mailbox Folder on page 108. 

To scan an image to the public mailbox folder: 
1. Load your original documents. 
2. At the printer control panel, press the Home button. 
3. Touch Workflow Scanning. 
4. To select a workflow, from the Pick a Workflow screen, touch Default Public Mailbox. 

Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change 
Workflow. 

5. To add a file destination, touch Add File Destinations, then select a file destination from the list. 
6. Adjust the workflow scanning settings as needed. 

− To save the scanned document as a specific file name, touch the attachment file name, enter a 
new name, then touch OK. 

− To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

− If you are using the document glass, to combine pages into a single scan file, enable Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 
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7. To start the scan, touch Scan. The Job Progress screen appears, and the original document is 
scanned. The printer stores the scanned image on the printer hard drive. 

8. If Build Job is enabled, when prompted, do these steps. 
− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

9. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving 
Scan Files from a Mailbox Folder on page 108. 

 

Scanning to a Private Mailbox Folder 

This feature allows you to scan documents to a private mailbox folder. Private mailbox folders can 
require a password. 

You can use the Embedded Web Server to create your private mailbox folders. For details, refer to 
Creating a Private Mailbox Folder on page 108. 

To scan to a private mailbox folder: 
1. Load your original documents. 
2. At the printer control panel, press the Home button. 
3. Touch Workflow Scanning. 
4. To select a workflow, from the Pick a Workflow screen, select a private mailbox folder. 

Note: If the Pick a Workflow screen is not automatically displayed, to display it, touch Change 
Workflow. 

5. On the Mailbox Password screen, enter the password, then touch OK. 
6. To add a file destination, touch Add File Destinations, then select a file destination from the list. 
7. Adjust the workflow scanning settings as needed. 

− To save the scanned document as a specific file name, touch the attachment file name, enter a 
new name, then touch OK. 

− To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

− If you are using the document glass, to combine pages into a single scan file, enable Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 

8. To start the scan, touch Scan. 
9. If Build Job is enabled, when prompted, do these steps: 

− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

10. To move the file to your computer, use the Embedded Web Server. For details, refer to Retrieving 
Scan Files from a Mailbox Folder on page 108. 
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Creating a Private Mailbox Folder 

If the scan policy to allow additional folders is enabled, you can create a private mailbox folder. The 
system administrator can create a private mailbox folder at any time. For details, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

To create a private mailbox folder with a password: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 46. 

2. Click the Scan tab. 
3. In the Display section, select Mailboxes. 

Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, refer to the 
System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

4. In the Scan to Mailbox section, click Create Folder. 
5. Click the Folder Name: field, then type a name for the folder. 
6. In the Folder Password field, type a password that adheres to the password rules. 
7. In the Confirm Folder Password field, type the password again. 
8. Click Apply. 

Your private mailbox folder appears in the mailbox folder list in the Embedded Web Server and on 
the printer touch screen under Pick a Workflow. The contents are stored on the printer hard drive. 

 

Retrieving Scan Files from a Mailbox Folder 

You can use the Embedded Web Server to retrieve scan files from a mailbox folder and copy the files to 
your computer. 

To retrieve your scan files: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 46. 

2. Click the Scan tab. 
3. In the Display section, select Mailboxes. 
4. In the Scan to Mailbox section, click the folder containing the scan. 

Your scan file appears in the Folder Contents window. 

Notes: 

• For a password protected private folder, click the Folder Password field, type the password, 
then click OK. 

• If your image file does not appear, click Update View. 
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5. Under Action, select an option, then click Go. 
− Download saves a copy of the file to your computer. When prompted, click Save, then navigate 

to the location on your computer to save the file. Open the file or close the dialog box. 
− Reprint prints the file without saving a copy of the file to your computer. 
− Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel 

to cancel the operation. 

Note: You can also print a mailbox file using the Print From App. For details, refer to Print From on 
page 133. 

 

Scanning to a User Home Folder 

Scan to Home allows you to scan documents to a home directory on an external server. The home 
directory is distinct for each authenticated user. The directory path is established through LDAP. 

The Scan to Home feature is available as the Home workflow in the Workflow Scanning App. 

To enable the Home workflow: 
• Ensure that LDAP Network Authentication is configured. 
• Ensure that Home folder locations are defined for each user in the LDAP directory. 

Note: When a user logs in to the printer using network credentials, the Home workflow appears on 
the Pick a Workflow screen. 

To use the Home workflow: 
1. Load your original documents. 
2. To log in to the printer, touch Log In, then log in with your network credentials. 
3. At the printer control panel, press the Home button. 
4. Touch Workflow Scanning. 
5. From the Pick a Workflow screen, touch the Home workflow. 

Notes: 

• If the Pick a Workflow screen is not automatically displayed, to display it, touch Change 
Workflow. 

• If the Home workflow is not displayed, check that you have logged in with the required 
credentials.  

6. To add a file destination, touch Add File Destinations, then select a file destination from the list. 
7. Adjust the workflow scanning settings as needed. 

− To save the scanned document as a specific file name, touch the attachment file name, enter a 
new name, then touch OK. 

− To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

− If you are using the document glass, to combine pages into a single scan file, enable Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 
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8. To start the scan, touch Scan. 
9. If Build Job is enabled, when prompted, do these steps. 

− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

10. To return to the Home screen, press the Home button. 
 

Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
produces scans in .jpg, .pdf, .pdf (a), .xps, and .tif file formats. 

The Scan to USB feature is available as the USB workflow in the Workflow Scanning App. 

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To scan to a USB Flash drive: 
1. Load your original documents. 
2. At the printer control panel, press the Home button. 
3. Insert the USB Flash drive into the USB memory port. 
4. At the USB Drive Detected screen, touch Scan to USB. 

Note: If the USB Flash drive is inserted in the printer already, touch Workflow Scanning. Touch 
Change Workflow, then touch USB. 

5. To add a file destination, touch Add File Destinations, then select a file destination from the list. 
6. Adjust the workflow scanning settings as needed. 

− To save the scanned document as a specific file name, touch the attachment file name, enter a 
new name, then touch OK. 

− To save the scanned document as a specific file format, touch the attachment file format, then 
select the required format. 

− If you are using the document glass, to combine pages into a single scan file, enable Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 

7. To start the scan, touch Scan. 
8. If Build Job is enabled, when prompted, do these steps. 

− To change settings, touch Program Next Segment. 
− To scan another page, touch Scan Next Segment. 
− To finish, touch Submit. 

 

 WARNING: Do not remove the USB Flash drive while the printer is processing the scan job.  
If you remove the Flash drive before the transfer is complete, the file can become unusable 
and other files on the drive can be damaged. 

 

9. To return to the Home screen, press the Home button. 
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Single-Touch Apps 

A Single-Touch App enables you to use a workflow without having to use the Workflow Scanning App. 
Single-Touch Apps are displayed on the Home screen, and used with a single touch. 

You can use the Embedded Web Server to design the app, associate it with a workflow, and assign user 
rights. For details about creating Single-Touch Apps for workflow scanning destinations, refer to the 
System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 
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Scan To 

This section includes: 
• Scan To Overview........................................................................................................................................................... 112
• Using Scan To ................................................................................................................................................................. 112
• Adding a Scan To Destination to an Address Book Entry ............................................................................... 113

Scan To Overview 

You can use the Scan To App to scan documents to a file destination associated with 
a contact in the address book. A Scan To Destination can be an FTP site, shared 
network folder, or Netware file destination. 

To scan documents to an email address associated with a contact in the address book, refer to Email on 
page 96. 

To scan documents to one or more file destinations using customized workflows, refer to Workflow 
Scanning on page 100. 

For details about configuring and customizing the Apps, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

For information about all the App features and available settings, refer to Apps Features on page 359. 

Using Scan To 

Before You Begin 

Before using Scan To, do these steps: 
• For scanning to a folder on a network computer, create a shared folder:

− For Windows, refer to Sharing a Folder on a Windows Computer on page 104.
− For Macintosh, refer to Sharing a Folder in Macintosh OS X Version 10.7 and Later on page 105.

• Use the Embedded Web Server to create an address book contact with an associated scan-to 
destination. For details, refer to Adding a Scan To Destination to an Address Book Entry on
page 113. 

Note: Ensure that the Address Book contains at least one contact with a scan-to destination. 
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Scanning to a File Destination 
1. Load your original documents.
2. At the printer control panel, press the Home button.
3. Touch Scan To.
4. To select a recipient, touch Contact or Favorite, then touch a contact in the list.

Note: Only contacts which have been set up with a scan to destination will be listed.

5. Adjust the scanning settings as needed.
− To save the scanned document as a specific file name, touch the attachment file name, enter a

new name, then touch OK. 
− To save the scanned document as a specific file format, touch the attachment file format, then 

select the required format. 
− If you are using the document glass, to combine pages into a single scan file, enable Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 

6. To start the scan, touch Scan.
7. If Build Job is enabled, when prompted, do these steps.

− To change settings, touch Program Next Segment.
− To scan another page, touch Scan Next Segment.
− To finish, touch Submit.

8. To return to the Home screen, press the Home button.
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Adding a Scan To Destination to an Address Book Entry 

You can create Address Book contacts using the Embedded Web Server. A contact is a user with an 
associated email address, fax number, or scan to destination. If a contact has been set up to include a 
scan to destination, the contact is available for selection in the Scan To App. Contacts can be marked as 
a Favorite. 

To create an address book contact and add a scan to destination: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then

press Enter or Return.

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your
Printer on page 46.

2. Click Address Book.
3. To add or edit a contact in the address book:

− To add a contact, click Add, then enter the contact information.
− To edit a contact, select the contact, then click Edit.

Note: If the Add button is unavailable, the address book has reached its limit. The Device Address
Book can contain up to 5000 contacts.

4. To associate a scan destination with this contact, for Scan To Destination, click the Add Destination
(+) button. Enter the nickname that you want to appear in the Address Book.

5. Under Protocol, select an option, then enter the destination address:
− For FTP, SFTP, or SMB:

• For IP Address, enter the IP Address: Port number.
• For Host Name, enter the Host Name: Port number.

− For Netware, enter the Server Name, Server Volume, NDS Tree, and NDS Context. 
6. For SMB, in the Share field, enter the name of the destination folder. For example, to save scanned

files to a shared folder named scans, type scans.
7. In Document Path, enter the name of the subfolder within the destination folder. For example, to

save the scanned files to a folder named colorscans inside the scans folder, type colorscans.
8. Enter a valid login name and password.

Note: Use the login name for the computer that holds the destination folder. For SMB, the login
name is your computer user name.

9. To confirm the validity of the destination details, click Destination Test.
10. Click Save, or select Add Another Contact After Saving, then click Save.

Note: To mark a contact as a Favorite for email, fax, or scan to destination, for the appropriate field,
click the Star icon. If you click the Star icon for Display Name, the contact becomes a Global
Favorite.
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Fax 

This section includes: 
• Fax Overview ................................................................................................................................................................... 115
• Sending a Fax .................................................................................................................................................................. 115
• Fax Workflows ................................................................................................................................................................. 118

Fax Overview 

When you send a fax from the printer control panel, the document is scanned and 
transmitted to a fax machine, using a dedicated telephone line. You can use the Fax 
App to fax documents to a fax number, an individual contact, or to a group of 
contacts. 

You can use the Fax App to do the following tasks: 
• Delay the send of your fax job for up to 24 hours.
• Send a fax from your computer.
• Forward fax documents to an email address.
• Print a fax from a secure folder.

The fax function works best with an analog phone line. Voice-Over-Internet Protocols (VOIPs) such as 
FIOS and DSL are not supported. Before you use the Fax App, configure the Fax Settings to ensure that 
they are compatible with your local connection and regulations. The Fax Settings include optional 
features you can use to configure the printer for faxing. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

For details about configuring the fax function and customizing the Apps, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

For information about all the App features and available settings, refer to Apps Features on page 359. 
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Sending a Fax 

To send a fax: 
1. Load your original documents.

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use
the document glass. Lift the duplex automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 
staples and paper clips from the pages. Insert the original documents face up in the duplex 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 

2. At the printer control panel, press the Home button.
3. Touch Fax.
4. To clear previous App settings, touch Reset.
5. Enter recipients:

− If the entry screen appears, to enter a recipient, touch an option or touch X.
− To select a contact or group from the Device Address Book, touch the Device Address Book

option. Touch Favorites or Contacts, then select a recipient. 
− To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter

the fax number, then touch Add. 
− To add more recipients, touch Add Recipient, then repeat the procedure.

Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pause
multiple times.
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6. Adjust the fax settings as needed.
− To scan more documents using the document glass, or to change settings for different sections

of the job, touch Build Job. 
− If you are scanning from 2-sided original documents, touch 2-Sided Scanning, then select an 

option. 
For details about available features, refer to Apps Features on page 359. 

7. Touch Send.
8. If Build Job is enabled, touch Scan and when prompted, do these steps.

− To change settings, touch Program Next Segment.
− To scan another page, touch Scan Next Segment.
− To finish, touch Submit.

9. To return to the Home screen, press the Home button.
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Fax Workflows 

This section includes: 
• Sending a Delayed Fax ................................................................................................................................................ 118
• Adding a Cover Sheet ................................................................................................................................................... 118
• Printing a Secure Fax .................................................................................................................................................... 119
• Polling a Remote Fax Machine ................................................................................................................................. 120
• Adding or Editing Contacts in the Device Address Book from the Control Panel .................................. 123
• Sending a Fax From Your Computer ...................................................................................................................... 125

Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. You can delay the send of your fax 
job for up to 24 hours. 

Note: Before you use this feature, ensure that the printer is set to the current time. For details, refer to 
the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

To specify the time to send your fax: 
1. Load your original documents.
2. At the printer control panel, press the Home button, then touch Fax.
3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax on

page 115.
4. Touch Delay Send.
5. Touch Delay send, then set the time to send the fax.

− To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
− To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
− If your printer is set to display the 12-hour clock, touch AM or PM.

6. Touch OK.
7. Touch Send. The fax is scanned and saved, then sent at the specified time.
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Adding a Cover Sheet 

You can use the Cover Sheet option to add an introduction page to the beginning of your fax. You can 
add a short comment to the cover sheet, as well as To and From details. 

To include a cover sheet: 
1. Load your original documents.
2. At the printer control panel, press the Home button, then touch Fax.
3. Add fax recipients, then adjust fax settings as needed. For details, refer to Sending a Fax on

page 115.
4. Touch Cover Sheet > On.
5. To enter the name of the recipient, touch the To field, then use the touch screen keyboard.

Touch OK.
6. To enter the name of the sender, touch the From field, then use the touch screen keyboard.

Touch OK.
7. To add a comment, do one of the following steps.

− Touch an existing comment.
− Touch an <Available> comment, then touch the Edit icon. To type text, use the touch screen

keypad. Touch OK. 

Notes: 

• To delete an existing comment, touch the comment, then touch X. To confirm the action, touch
Delete.

• To edit an existing comment, touch the comment, then touch the Edit icon. To change the
comment, use the touch screen keypad. Touch OK.

8. Touch OK.
 

Printing a Secure Fax 

When the Fax Secure Receive option is enabled, all faxes that the device receives are held in the Job list 
until you enter a passcode. After you enter the passcode, the faxes are released and printed. 

Note: Before you can receive a Secure Fax, ensure that the Secure Fax Receive feature is enabled. 
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

To print a secure fax: 
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Secure Print jobs, touch Secure Jobs.
4. Touch your folder.
5. Enter the passcode number, then touch OK.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English


Xerox® Apps 

120 Xerox® AltaLink® C80XX Series Multifunction Printer 
User Guide 

6. Select an option.
− To print a Secure Print job, touch the job.
− To print all the jobs in the folder, touch Print All.
− To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
− To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.
 

Polling a Remote Fax Machine 

Fax Polling allows you to store a fax document on the printer and make it available for other fax 
machines to poll. You can also retrieve faxes stored on other fax machines. To use this feature, both the 
polling printer and the remote printer must have the Fax Polling feature. 

Storing a Fax for Polling 

You can store faxes for polling as Non-Secure or Secure. When you select Secure Storage, you create a 
list of remote device fax numbers that are allowed to access secure faxes. 

To store a fax for non-secure polling: 
1. Load your original documents.
2. At the printer control panel, press the Home button, then touch Fax.
3. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
4. Touch Store Polling Files.
5. Touch Non-Secure Storage, then touch OK. To confirm, touch Update Setting.
6. Touch Send. The original documents are scanned and stored for non-secure polling.

To store a fax for secure polling: 
1. Load your original documents.
2. At the printer control panel, press the Home button, then touch Fax.
3. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
4. Touch Store Polling Files.
5. Touch Secure Storage.
6. Touch Enter a Fax Number. To enter the fax number for the remote device, use the keypad.

Touch OK.
7. Touch the + button. The fax number is added to the access list.
8. Continue to enter fax numbers for all remote devices that require access to the secure documents.
9. Touch OK. To confirm, touch Update Setting.
10. Touch Send. The original documents are scanned and stored for secure polling.
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To delete documents stored for polling: 
1. At the printer control panel, press the Home button, then touch Fax.
2. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
3. Touch Store Polling Files.
4. Touch Empty Fax Polling. To confirm, touch Empty Fax Polling again.
5. Touch OK.

Printing Faxes Stored for Polling 

To print faxes stored for polling: 
1. At the printer control panel, press the Home button, then touch Fax.
2. If the entry screen is displayed, touch Polling, or touch Add Recipient, then touch Polling.
3. Touch Print From Polling Device.
4. To print faxes that are stored for polling on the local device:

a. Touch Local Fax Polling.
b. Touch Print.
c. To delete stored faxes after they print, touch Empty Fax Polling. To confirm, touch Empty Fax

Mailbox.
The local faxes that are stored for polling print. 

5. To print faxes that are stored for polling on a remote device:
a. Touch Remote Fax Polling.
b. Touch Enter Fax Number. To enter the fax number of the remote device, use the keypad.

Touch OK.
c. To add a number to the list, touch the + button. Enter more fax numbers as needed.
d. To edit the list of fax numbers, touch a number in the list, then touch Remove or Edit.
e. To set a specific time to poll the remote device, touch Delay Polling.

• Touch Delay Polling.
• To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
• To set the minutes, touch the Minute field, then use the numeric keypad, or touch the

arrows.
• If your printer is set to display the 12-hour clock, touch AM or PM.
• Touch OK.

f. Touch Print.
The faxes that are stored on the remote device for polling print. 

6. Touch X to exit.
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Storing a Fax in a Local Mailbox 

The system administrator must create a mailbox before you can use this feature. For details, refer to the 
System Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

To store a fax in a local mailbox: 
1. Load your original documents.
2. At the printer control panel, press the Home button, then touch Fax.
3. If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
4. Touch Store To Mailbox.
5. Touch Local Mailbox.
6. Touch a mailbox from the list.
7. If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox

passcode, use the keypad. Touch OK.
8. Touch OK. The mailbox appears as the recipient of the fax.
9. To select a different mailbox, touch the recipient field, then touch Remove or Edit.
10. Touch Send. The original documents are scanned and stored in the mailbox.
 

Printing Local Mailbox Documents 

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a 
Local Mailbox on page 121. 

To print local mailbox documents: 
1. At the printer control panel, press the Home button, then touch Fax.
2. If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
3. Touch Print From Mailbox.
4. Touch Local Mailbox.
5. Touch a mailbox from the list.
6. If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox

passcode, use the keypad. Touch OK.
7. Touch Print. The documents in the mailbox print.
8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox.

o confirm, touch Empty Mailbox.
9. To exit, touch X.
 

Storing a Fax in a Remote Mailbox 

To store a fax in a remote mailbox: 
1. Load your original documents.
2. At the printer control panel, press the Home button, then touch Fax.
3. If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
4. Touch Store To Mailbox.
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5. Touch Remote Mailbox.
6. To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the

numeric keypad. Touch OK.
7. To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad.

Touch Enter.
8. If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox

passcode, use the numeric keypad. Touch OK.
9. Touch OK. To select a different mailbox, touch the recipient field, then touch Remove or Edit.
10. Touch Send. The original documents are scanned and stored in the remote mailbox.
 

Printing Remote Mailbox Documents 

To print remote mailbox documents: 
1. At the printer control panel, press the Home button, then touch Fax.
2. If the entry screen is displayed, touch Mailboxes, or touch Add Recipient, then touch Mailboxes.
3. Touch Print From Mailbox.
4. Touch Remote Mailbox.
5. To enter the fax number of the remote device, touch Enter Remote Fax Number, then use the

numeric keypad. Touch OK.
6. To enter the mailbox number, touch the Mailbox Number field, then use the numeric keypad.

Touch Enter.
7. If a passcode is required, touch the Mailbox Passcode field. To enter the four-digit mailbox

passcode, use the keypad. Touch OK.
8. Touch Print. The documents in the remote mailbox print.
9. Touch X to exit.

Adding or Editing Contacts in the Device Address Book from the Control Panel 

You can set up the Device Address Book using the Embedded Web Server. The Address Book can contain 
up to 5000 contacts that you can access when you enter recipients or destinations using apps. 

To add or edit contacts in the Device Address Book from the control panel: 

Note: Before you can use this feature, the system administrator must enable Create/Edit Contact 
from Touch Screen for All Users. 

1. Load your original documents.
2. At the printer control panel, press the Home button.
3. Touch Fax.
4. To clear previous App settings, touch Reset.
5. Touch Manual Entry. To type the fax number, use the touch screen keypad.
6. To add the recipient to the Device Address Book, touch the Address Book icon.
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7. Do one of the following steps.
− To create an entry, touch Create New Contact. Touch each field, then enter the contact details

using the touch screen keypad. Touch OK. 
− To add to an existing entry, touch Add to Existing Contact. Touch a contact in the list, or use

the Search option to find a contact. 
8. To mark a recipient to appear as a favorite option, touch the Star icon.
9. Adjust the fax settings as needed.
10. To start the scan, touch Send.
11. To return to the Home screen, press the Home button.
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Sending a Fax From Your Computer 

This section includes: 
• Sending a Fax From Windows Applications ........................................................................................................ 125
• Sending a Fax From Macintosh Applications ...................................................................................................... 125

You can send a fax to the printer from an application on your computer. 

Sending a Fax From Windows Applications 

You can use the print driver to send a fax from Windows applications. 

You can use the fax window to enter recipients, create a cover page with notes, and set options. You can 
send a confirmation sheet, set the send speed, resolution, send time, and dialing options. 

To send a fax from Windows applications: 
1. With the desired document or image open in your application, open the Print dialog box. For most

software applications, click File > Print or press CTRL+P.
2. Select the required printer, then to open the print driver dialog box, click Printer Properties.
3. On the Printing Options tab, from the Job Type list, select Fax.
4. In the Fax window, click the Recipients tab.
5. To add recipients manually:

a. Click the Add Recipient icon.
b. Type the recipient name and fax number, then add other information as required.
c. Click OK.
d. To add more recipients, repeat this procedure.

6. To add existing contacts from a phonebook:
a. Click the Add From Phonebook icon.
b. Select the required phonebook from the list.
c. Select names from the list, or search for a contact using the search bar.
d. To add the selected contacts to the Fax Recipients list, click the Down Arrow.
e. Click OK.
f. To add more recipients, repeat this procedure.

7. To include a cover sheet, click the Cover Sheet tab. From the Cover Sheet Options list, select Print a
Cover Sheet. Enter the details as needed, then click OK.

8. On the Options tab, select the required options, then click OK.
9. To save your settings and return to the main print dialogue page, click OK.
10. Click Print. In the Fax Confirmation window, click OK.
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Sending a Fax From Macintosh Applications 

You can use the fax driver to send a fax from many Macintosh applications. To install the fax driver, refer 
to Installing the Print Driver Software on page 58. 

To send a fax from Macintosh applications: 
1. With your document or image open in your application, open the Print dialog box. For most

software applications, click File > Print or press CMD+P.
2. Select the required printer.
3. To access the fax driver settings, in the print options list, click Xerox Features, then from the Job

Type list, select Fax.
4. To add a recipient, in the Fax window, click the Recipients tab, then click the Add Recipient icon.
5. Type the recipient name and fax number, add other information as needed, then click OK.
6. To add more recipients, repeat this procedure.
7. To include a cover sheet, click the Cover Sheet tab.
8. From the Cover Sheet list, select Print a Cover Sheet, then enter the details as needed.
9. On the Options tab, select the required options. To save your settings and return to the main print

dialog window, click OK.
10. To send the fax, click Print.
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Server Fax 

This section includes: 
• Server Fax Overview ...................................................................................................................................................... 127
• Sending a Server Fax .................................................................................................................................................... 127
• Sending a Delayed Server Fax .................................................................................................................................. 129

Server Fax Overview 

Server Fax allows you to send a fax over a network to a fax server. The fax server then 
sends the fax to a fax machine over a phone line. Before you can send a server fax, 
configure a fax filing repository or filing location. The fax server retrieves the 
documents from the filing location and transmits them over the telephone network. 

For details about configuring and customizing the Apps, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

For information about all the App features and available settings, refer to Apps Features on page 359. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English


Xerox® Apps 

128 Xerox® AltaLink® C80XX Series Multifunction Printer 
User Guide 

Sending a Server Fax 

If a fax server is connected to the network, you can send a document to a fax machine without requiring 
a dedicated telephone line. 

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax 
server then sends the fax over a telephone line to a fax machine. 

The system administrator must enable the server fax service and configure a fax repository, or filing 
location, before you can use this feature. 

To send a server fax: 
1. Load your original documents.

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use
the document glass. Lift the duplex automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 
staples and paper clips from the pages. Insert the original documents face up in the duplex 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 

2. At the printer control panel, press the Home button.
3. Touch Server Fax.
4. To clear previous App settings, touch Reset.
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5. Enter recipients.
− If the entry screen is displayed, touch an option, or touch X.
− To select a contact or group from the Device Address Book, touch the Device Address Book

option, then select a recipient. 
− To enter the fax number manually, touch Manual Entry. In the Enter Fax Number field, enter

the fax number, then touch Add. 
− To add more recipients, touch Add Recipient, then repeat the procedure.

Note: To insert a pause as needed, touch Dial Pause. To enter longer pauses, touch Dial Pause
multiple times.

6. Adjust server fax settings as needed.
− To scan more documents using the document glass, or to change settings for different sections

of the job, touch Build Job. 
− If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option. 
For details about available features, refer to Apps Features on page 359. 

7. Touch Send.
8. If Build Job is enabled, touch Scan and when prompted, do these steps.

− To change settings, touch Program Next Segment.
− To scan another page, touch Scan Next Segment.
− To finish, touch Submit.

9. To return to the Home screen, press the Home button.
 

Sending a Delayed Server Fax 

You can set a time in the future for the printer to send your fax job. The delay can range from 
15 minutes through 24 hours. 

Note: Before you use this feature, set the printer to the current time. 

To specify the time to send your server fax: 
1. Load your original documents.
2. At the printer control panel, press the Home button.
3. Touch Server Fax.
4. Add server fax recipients, then adjust server fax settings as needed. For details, refer to Sending a

Server Fax on page 127.
5. Touch Delay Send.
6. Touch Delay Send, then set the time to send the server fax:

− To set the hour, touch the Hour field, then use the numeric keypad, or touch the arrows.
− To set the minutes, touch the Minute field, then use the numeric keypad, or touch the arrows.
− If your printer is set to display the 12-hour clock, touch AM or PM.

7. Touch OK.
8. Touch Send. The fax is scanned and saved, then sent at the time you specified.
9. To return to the Home screen, press the Home button.
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Internet Fax 

Internet Fax Overview 

You can use the Internet Fax App to scan images and attach them to emails. You can 
specify the file name and format of the attachment, and include a subject heading 
and message for the email. 

For details on configuring and customizing the Apps, refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

For information about all the App features and available settings, refer to Apps Features on page 359. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Sending a Scanned Image in an Internet Fax 

To send a scanned image in an email: 
1. Load your original documents.

− For single pages or paper that cannot be fed using the duplex automatic document feeder, use
the document glass. Lift the duplex automatic document feeder, then place the original 
document face down in the upper-left corner of the document glass. 

− For multiple, single, or 2-sided pages, use the duplex automatic document feeder. Remove any 
staples and paper clips from the pages. Insert the original documents face up in the duplex 
automatic document feeder, with the top of the page entering the feeder first. Adjust the 
paper guides so that they fit against the original documents. 

2. At the printer control panel, press the Home button.
3. Touch Internet Fax.
4. To clear previous App settings, touch Reset.
5. Enter recipients:

− If the entry screen is displayed, to enter a recipient, touch an option or touch X.
− To select a contact from the Address Book, touch the Device Address Book option. Select a

recipient, then touch OK. 
− To enter an internet fax address manually, touch Manual Entry. In the Enter an Internet Fax

address field, enter the internet fax address, then touch Add. 
− To add more recipients, touch Add Recipient, then repeat the procedure.
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6. To organize the recipients, touch one of the recipients on the list, then from the menu, select
To: or Cc:.

7. Adjust the internet fax settings as needed:
− To change the subject, touch Subject, enter a new subject, then touch OK.
− To save the scanned document as a specific file name, touch the attachment file name, enter a

new name, then touch OK. 
− To save the scanned document as a specific file format, touch the attachment file format, then 

select the required format. 
− To change the internet fax message, touch Message, enter a new message, then touch OK. 
− To scan more documents using the document glass, or to change settings for different sections 

of the job, touch Build Job. 
− If scanning from 2-sided original documents, touch 2-Sided Scanning, then select an option. 
For details about available features, refer to Apps Features on page 359. 

8. To start the scan, touch Send.
9. If Build Job is enabled, touch Scan and when prompted, do these steps.

− To change settings, touch Program Next Segment.
− To scan another page, touch Scan Next Segment.
− To finish, touch Submit.

10. To return to the Home screen, press the Home button.
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Print From 

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB 
Flash drive. 

Print From Overview 

You can use the Print From App to print jobs from various sources. You can print jobs 
stored in a print-ready format from a USB stick. You can also print Saved Jobs and 
jobs stored in a Mailbox. 

To create a print-ready file, when you print your documents from programs such as Microsoft Word, 
select the Print to File option. Check with your specific publishing application for options to create print-
ready files. 

Printing from a USB Flash Drive 

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. 

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To print from a USB Flash drive: 
1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.

3. To print a specific file, browse to that file, then touch the file name or icon.
4. Select the options for paper supply, quantity, 2-sided printing, output color, and finishing.
5. Touch Print.
6. After the job prints, to print another file, touch Change File.
7. To return to the Home screen, press the Home button.
8. When you are finished, remove the USB Flash drive.
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Printing from Saved Jobs 

To print from saved jobs: 
1. At the control panel, press the Home button, then touch Print From.
2. Touch Saved Jobs, then touch the name of the folder that contains the saved job.
3. Touch the name of the saved job that you want to print.

Note: To print a private saved job, touch the name of the job, then enter the passcode.

4. Select the options for paper supply, quantity, 2-sided printing, output color, and finishing.
5. Touch Print.
6. After the job prints, to return to the list of saved jobs, touch Change File.
7. To return to the Home screen, press the Home button.
 

Printing from Mailbox 

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive. 

To print from a mailbox: 
1. At the control panel, press the Home button, then touch Print From.
2. Select Mailboxes, then touch the name of the folder containing the document.

Note: If Mailboxes does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.

3. Touch the name of the document that you want to print.
4. Select the options for paper supply, quantity, 2-sided printing, output color, and finishing.
5. Touch Print.
6. After the job prints, to return to the mailbox folder, touch Change File.
7. To return to the Home screen, press the Home button.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English


Xerox® AltaLink® C80XX Series Multifunction Printer 135 
User Guide 

This chapter includes: 
• Printing Overview ........................................................................................................................................................... 136
• Print Workflows............................................................................................................................................................... 137
• Print Jobs ........................................................................................................................................................................... 144
• Printing Features ............................................................................................................................................................ 149
• Using Custom Paper Sizes .......................................................................................................................................... 161
• Print From ......................................................................................................................................................................... 164

4 Printing 



Printing 

136 Xerox® AltaLink® C80XX Series Multifunction Printer 
User Guide 

Printing Overview 

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected 
to an active network. Ensure that you have the correct print driver software installed on your computer. 
For details, refer to Installing the Software on page 58. 
1. Select the appropriate paper.
2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color,

and type.
3. Access the print settings in your software application. For most software applications, press CTRL+P

for Windows, or CMD+P for Macintosh.
4. Select your printer.
5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or

Preferences. For Macintosh, select Xerox® Features. The title of the button can vary depending on
your application.

6. Modify the print driver settings as necessary, then click OK.
7. To send the job to the printer, click Print.

For reference:  
Loading Paper on page 177 
Printing Features on page 149 
Printing on Both Sides of the Paper on page 150 
Printing on Special Paper on page 187 
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Print Workflows 

This section includes: 
• Print Driver Help ............................................................................................................................................................. 137
• Windows Printing Options .......................................................................................................................................... 138
• Macintosh Printing Options ....................................................................................................................................... 140
• Linux Printing Options .................................................................................................................................................. 142
• Mobile Printing Options............................................................................................................................................... 142

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

Information about Printing Preferences appears in the Help window on two tabs: 
• Contents provides a list of the tabs at the top and the areas at the bottom of the Printing

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in
Printing Preferences.

• Search provides a field where you can enter the topic or function for which you need information.
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 
1. Navigate to the list of printers on your computer:

− For Windows Server 2008 and later, click Start > Settings > Printers.
− For Windows 7, click Start > Devices and Printers.
− For Windows 8, click Start > Control Panel > Devices and Printers.
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.

Scroll down in the window, then under Related settings, click Devices and printers. 

Note: If you are using a custom Start Menu application, it can change the navigation path to your 
list of printers. 

2. In the list of printers, right-click the icon for your printer, then click Printing preferences.
3. In the Printing Preferences window, click a tab, then select the options. To save the settings,

click OK.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, you can change the Printing Preferences before 
sending the job to the printer. 
1. With the document open in your software application, access the print settings. For most software

applications, click File > Print or press CTRL+P for Windows.
2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print

Options, or Preferences button. The title of the button can vary, depending on your application.
3. Click a tab in the Printing Preferences window, then make selections.
4. To save your selections and close the Printing Preferences window, click OK.
5. To send the job to the printer, click Print.
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Selecting Finishing Options for Windows 

If your printer has a finisher installed, you can select finishing options in the Properties window of the 
print driver. Finishing options allow you to select how your document is delivered. For example, you can 
select hole-punching, stapling, folding, or printing in a booklet format. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

To select finishing options in the PostScript and PCL print drivers: 
1. In the print driver, click the Printing Options tab.
2. To select a finishing option, to the right of the Finishing list, click the arrow.

Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on
the short edge instead of the long edge, the finisher can insert the staple in the wrong location.

3. To select the output tray, click the arrow to the right of the Output Destination field, then select an
option:
− Automatic: This option determines the output destination based on the number of sets and

the stapling option selected. The printer sends multiple sets or stapled sets to the finisher 
output tray. 

− Center Tray: This option selects the output tray in the middle of the Offset Catch Tray, the 
Office Finisher, or the Business Ready Finisher. 

− Center Bottom Tray: This option selects the output tray on the bottom of the Offset Catch 
Tray. 

− Finisher Tray: This option selects the output tray on the Integrated Office Finisher. 
− Left Tray: This option selects the output tray on the left side of the printer. 
− Right Tray: This option selects the output tray on top of the Office Finisher. 
− Right Top Tray: This option to select the output tray on top of the Business Ready Finisher. 
− Right Middle Tray: This option selects the output tray in the middle of the Business Ready 

Finisher. 
− Right Bottom Tray: This option selects the output tray on the bottom of the Business Ready 

Booklet Maker Finisher. 
4. To send the job to the printer, click OK, then click Print.
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Selecting Printing Defaults in Windows for a Shared Network Printer 
1. Navigate to the list of printers on your computer:

− For Windows Server 2008 and later, click Start > Settings > Printers.
− For Windows 7, click Start > Devices and Printers.
− For Windows 8, click Start > Control Panel > Devices and Printers.
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.

Scroll down in the window, then under Related settings, click Devices and printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select 
Personalize > Control Panel Home > Devices and Printers. 

2. In the list of printers, right-click the icon for your printer, then select Printer properties.
3. In the printer Properties dialog box, click the Advanced tab.
4. On the Advanced tab, click Printing Defaults.
5. Make your selections on the print driver tabs as needed, then click Apply.
6. To save the settings, click OK.

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print.
2. Select the printer, then click Properties. Click the tabs in the Properties window, then select the

desired settings.
3. To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the

window, then click Save As.
4. Type a name for the set of printing options, then to save the set of options in the Saved Settings

list, click OK.
5. To print using these options, select the name from the list.
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print.
2. Select your printer.
3. In the Print window, in the print options list, click Xerox Features.

Note: To see all printing options, click Show Details.

4. Select any other required printing options from the lists.
5. Click Print to send the job to the printer.
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Selecting Finishing Options for Macintosh 

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver. 

To select finishing options in the Macintosh print driver: 
1. In the Print window, in the print options list, click Xerox Features.
2. To select a finishing option, click the arrow to the right of the Finishing field, then select an option.
3. To select the output tray, click the arrow to the right of the Output Destination field, then select an

option.
− Automatic: This option determines the output destination based on the number of sets and

the stapling option selected. The printer sends multiple sets or stapled sets to the finisher 
output tray. 

− Center Tray: This option selects the output tray in the middle of the Offset Catch Tray, the 
Office Finisher, or the Business Ready Finisher. 

− Center Bottom Tray: This option selects the output tray on the bottom of the Offset Catch 
Tray. 

− Finisher Tray: This option selects the output tray on the Integrated Office Finisher. 
− Left Tray: This option selects the output tray on the left side of the printer. 
− Right Tray: This option selects the output tray on top of the Office Finisher. 
− Right Top Tray: This option selects the output tray on top of the Business Ready Finisher. 
− Right Middle Tray: This option selects the output tray in the middle of the Business Ready 

Finisher. 
− Right Bottom Tray: This option selects the output tray on the bottom of the Business Ready 

Booklet Maker Finisher. 
4. To send the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print.
2. Select your printer from the Printers list.
3. Select the required printing options from the lists in the Print dialog box.

Note: To see all printing options, click Show Details.

4. Click Presets > Save Current Settings as Preset.
5. Type a name for the printing options. To save the set of options in the Presets list, click OK.
6. To print using these options, select the name from the Presets list.
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Linux Printing Options 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press 
Enter or Return. 

Printing from a Linux Workstation 

To print from a Linux workstation: 
1. Create a print queue.
2. With the desired document or graphic open in your application, open the Print dialog box. For most

software applications, click File > Print or press CTRL+P.
3. Select the target print queue.
4. Close the Print dialog box
5. In the Xerox® GUI print driver, select the available printer features.
6. Click Print.

The Xerox® print driver accepts job ticket settings files that select additional settings or features.
You can also submit print requests through the command line using lp/lpr.

To create a job ticket using the Xerox® GUI print driver: 
1. Open the Xerox® GUI print driver.
2. Select the desired options.
3. Click Save As, then store the job ticket in a public location, such as /tmp.

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job
ticket. You can specify the information on the command line.

To create a job ticket using the command line: 
1. On the command line, as the root user, type xeroxprtmgr.
2. Select the desired options.
3. Click Save As, then store the job ticket in a public location, such as /tmp.

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job
ticket. You can specify the information on the command line.

The following commands are examples of how to print using a job ticket: 
• lp -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File}
• lp -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile
• lp -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile
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Mobile Printing Options 

This printer can print from iOS and Android mobile devices. 

Printing with Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. 

For details, refer to Connecting with Wi-Fi Direct on page 49. 

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device. 

Note: Depending on which mobile device you are using, the printing procedure varies. 

Printing from a Mopria-Enabled Mobile Device 

Mopria™ is a software feature that enables users to print from mobile devices without requiring a print 
driver. You can use Mopria™ to print from your mobile device to Mopria™-enabled printers. 

Notes: 

• Mopria and all of its required protocols are enabled by default.
• Ensure that you have the latest version of the Mopria Print Service installed on your mobile

device. You can obtain a free download from the Google Play Store.
• Wireless devices must join the same wireless network as the printer.
• The name and location of your printer appears in a list of Mopria-enabled printers on

connected devices.

To print using Mopria, follow the directions provided with your mobile device. 
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Print Jobs 

This section includes: 
• Managing Jobs ............................................................................................................................................................... 144
• Printing Special Job Types .......................................................................................................................................... 145

Managing Jobs 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. When you send a secure 
print job, the job is held until you release it by typing a passcode at the control panel. For details, refer to 
Printing Special Job Types on page 145. 

From the Jobs window in the Embedded Web Server, you can view a list of active and saved print jobs. 

To pause, promote, or delete the job: 
1. At the printer control panel, press the Home button.
2. Touch Jobs, then touch the name of the desired print job.
3. Select a task.

Note: If you do not make a selection, the job automatically resumes after the set timeout period.

− To pause the print job, touch Hold. To resume the print job, touch Release.
− To delete the print job, touch Delete. At the prompt, touch Delete.
− To move the job to the top of the list, touch Promote.
− To view the status of the job, touch Job Progress.
− To view information about the job, touch Job Details, then touch Job Settings or Required

Resources. 
4. To return to the Home screen, press the Home button.

To print a job held for resources: 
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. From the jobs list, touch the held job name. The resources required for the job appear on the control

panel.
4. Do one of the following:

− To print the job, replenish the resources required. The job resumes automatically when the
required resources are available. If the job does not print automatically, touch Resume. 

− To delete the print job, touch Delete. At the prompt, touch Delete. 
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5. To return to the Home screen, press the Home button.

Notes:

• The system administrator can restrict users from deleting jobs. If a system administrator has
restricted job deletion, you can view the jobs, but not delete them.

• Only the user who sent the job, or the system administrator, can delete a Secure Print job.

Printing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 

Saved Job 

Saved Jobs are documents sent to the printer and stored there for future use. All users can print or delete 
a Saved Job. 

On the control panel, from the Print From menu, you can view and print saved jobs. In the Embedded 
Web Server, on the Jobs window, you can view, print, and delete saved jobs, and you can manage where 
jobs are stored. 

To print using Saved Job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P

for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

− For Windows, click Printer Properties. Depending on your application, the title of the button
can vary. 

− For Macintosh, in the Print window, in the print options list, click Xerox Features. 
3. For Job Type, select Saved Job.

a. Type a job name or select a name from the list.
b. Type a folder name or select a name from the list.
c. To add a passcode, click Private, type the passcode, then confirm the passcode.
d. Click OK.

4. Select other required printing options.
− For Windows, click OK, then click Print.
− For Macintosh, click Print.

To print a saved job from the control panel, refer to Printing from Saved Jobs on page 133. 
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To print, delete, move, or copy a saved job in the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then

press Enter or Return.
2. In the Embedded Web Server, click Home.
3. Click Jobs.
4. Click the Saved Jobs tab.
5. For the job that you want to process, select the check box.
6. From the menu, select an option.

− Print Job: This option prints a job immediately.
− Delete Job This option deletes the saved job.
− Move Job: Use this option to move the job to another folder location.
− Copy Job: Use this option to duplicate the job.

7. Click Go.
 

Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

After a Secure Print job is printed, it is deleted automatically. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P

for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

− For Windows, click Printer Properties. Depending on your application, the title of the button
varies. 

− For Macintosh, in the Print window, in the print options list, click Xerox Features. 
3. For Job Type, select Secure Print.
4. Type the passcode, confirm the passcode, then click OK.
5. Select any other required printing options.

− For Windows, click OK, then click Print.
− For Macintosh, click Print.
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To release a Secure Print job: 
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. To view Secure Print jobs, touch Secure Jobs.
4. Touch your folder.
5. Enter the passcode number, then touch OK.
6. Select an option.

− To print a Secure Print job, touch the job.
− To print all the jobs in the folder, touch Print All.
− To delete a Secure Print job, touch the Trash icon. At the prompt, touch Delete.
− To delete all the jobs in the folder, touch Delete All.

7. To return to the Home screen, press the Home button.

Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel. 

Sample Set is a type of saved job with these features: 
• A Sample Set job appears in a folder named after the user ID associated with the print job.
• A Sample Set job does not use a passcode.
• Any user can print or delete a Sample Set job.
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any

remaining copies.

After a Sample Set job is printed, it is deleted automatically. 

To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P

for Windows or CMD+P for Macintosh.
2. Select your printer, then open the print driver.

− For Windows, click Printer Properties. Depending on your application, the title of the button
varies. 

− For Macintosh, in the Print window, in the print options list, click Xerox Features. 
3. For Job Type, select Sample Set.
4. Select any other required printing options.

− For Windows, click OK, select the number of copies, then click Print.
− For Macintosh, select the number of copies, then click Print.
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To release a Sample Set: 
1. At the printer control panel, press the Home button.
2. To view available jobs, touch Jobs.
3. Touch the Sample Set job.

Note: The Sample Set file description shows the job as Held: Sample Requested.

4. Touch Job Progress, then select an option:
− To view information about the job, touch Job Details, then touch Job Settings or Required

Resources. 
− To print the remaining copies of the job, touch Release.
− To delete the remaining copies of the job, touch Delete.

5. To return to the Home screen, press the Home button.



Printing 

Xerox® AltaLink® C80XX Series Multifunction Printer 149 
User Guide 

Printing Features 
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• Advanced Tab ................................................................................................................................................................. 158

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 
• To locate paper options in Windows, in the print driver, click the Printing Options tab.
• To locate paper options on Macintosh, in the Print window, in the print options list, click Xerox

Features. Within Xerox Features, in the options list, click Paper/Output.
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Scaling 

Scaling reduces or enlarges the original document to match the selected output paper size. 
• To locate scale options in Windows, on the Printing Options tab, for Paper, click the arrow, select

Other Size, then click Advanced Paper Size.
• To locate scale options on Macintosh, in the Print window, click Show Details.

The following scaling options are available: 
• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount

appears in the percentage box below the sample image.
• No Scaling does not change the size of the page image printed on the output paper, and 100%

appears in the percentage box. If the original size is larger than the output size, the page image is
cropped. If the original size is smaller than the output size, extra space appears around the page
image.

• Manually Scale scales the document by the amount entered in the percentage box below the
preview image.

Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 

Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Sizes 
and Weights for Automatic 2-Sided Printing on page 173. 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
• 1-Sided Print: This option prints on one side of the media. Use this option when printing on

envelopes, labels, or other media that cannot be printed on both sides.
• 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long

edge of the paper. The following illustrations show the result for documents with portrait and
landscape orientations, respectively:
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• 2-Sided Print, Flip on Short Edge: Prints on both sides of the paper. The images print to allow
binding on the short edge of the paper. The following illustrations show the result for documents
with portrait and landscape orientations, respectively:

Note: 2-Sided Printing is part of the Earth Smart settings. 

To change your default print driver settings, refer to Setting Default Printing Options for Windows on 
page 138. 

Xerox Black and White 

You can select printing in color or black and white. 
• Off (use Document Color): Use this option to print in color.
• On: Use this option to print in black and white.

Print Quality 

The Windows PostScript driver and the Macintosh drivers provide the highest print-quality modes: 
• High Resolution: 1200 x 1200 dpi (1-bit depth). This mode provides the best overall image quality

for detailed line drawings such as CAD files. It is recommended for printing vibrant, saturated, color
prints or photos. Print jobs can take longer to process when printed using High Resolution mode.

• Enhanced: 600 x 600 dpi (8-bit depth). This mode is used for better print quality, and is the best
mode to use for business presentations. Enhanced mode takes longer to process than Standard or
Toner Saver.

• Standard: 600 x 600 dpi (1-bit depth). This mode is used for general-purpose printing, and is
optimized for good print quality. Standard quality is suitable for most print jobs.

• Toner Saver: 600 x 600 dpi (1-bit depth). This mode is used for document preview, and is optimized
for quickest print processing. Toner Saver is useful for draft-quality output.

Image Options 

Image options control the way the printer uses color to produce your document. The Windows PostScript 
print driver and the Macintosh print drivers provide the widest range of color controls and corrections on 
the Image Options tab. 
• To locate color options in Windows, in the print driver, click the Image Options tab.
• To locate color options on Macintosh, in the Print window, in the print options list, click Xerox

Features. Within Xerox Features, in the options list, click Color Options.
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Color Correction 

Color Correction matches printer colors on PostScript jobs to colors on other devices, such as your 
computer monitor screen or a printing press. 

Color Correction options: 
• Xerox Black and White: This feature converts all color in the document to black and white, or

shades of gray.
• Xerox Automatic Color: This option applies the best color correction to text, graphics, and images.

Xerox recommends this setting. There are 13 more selections within Xerox Automatic Color,
including Vivid RGB and Commercial.

• Custom Automatic Color: This setting provides finer control over color adjustments. There are
numerous selections for color adjustments to text, graphics, and images.

Color by Words 

Color By Words allows you to adjust colors by building sentences using common phrases describing how 
to change colors. 

For more information, refer to the help for your print driver. 

Color Adjustments 

Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include 
lightness, contrast, saturation, and color cast. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

Lightness 

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in 
your printed job. 

Contrast 

You can use the Contrast feature to adjust the variation between light and dark areas of the print job. 

Saturation 

Saturation allows you to adjust the color strength and the amount of gray in the color. 

Color Cast 

Use Color Cast settings to adjust the amount of a selected color in the print job while preserving 
lightness. 
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The following options are available: 
• The Cyan to Red option allows you to adjust the color balance between cyan and red. For example,

when you increase the cyan levels, the red levels decrease.
• The Magenta to Green option allows you to adjust the color balance between magenta and green.

For example, when you increase the magenta levels, the green levels decrease.
• The Yellow to Blue option allows you to adjust the color balance between yellow and blue. For

example, when you increase the yellow levels, the blue levels decrease.

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 

To print 1, 2, 4, 6, 9, or 16 pages per side, on the Page Layout tab, select Pages Per Sheet. 
• To locate Pages Per Sheet in Windows, on the Document Options tab, click Page Layout.
• To locate Pages Per Sheet on Macintosh, in the Print window, in the print options list, click Layout.

To print a border around each page, select Page Borders. 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets 
from any paper size that is supported for 2-sided printing. 

The print driver automatically reduces each page image and prints four page images per sheet of paper, 
two page images on each side. The pages are printed in the correct order so that you can fold and staple 
the pages to create the booklet. 
• To locate booklet creation in Windows, on the Document Options tab, click Page Layout.
• To locate booklet creation on Macintosh, in the Print window, in the print options list, click Xerox

Features. Within Xerox Features, in the options list, click Booklet Layout.
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When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm

(1/72 in.).
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting

compensates for the thickness of the folded paper, which can cause the page images to shift
outward slightly when folded. You can select a value from zero to 1 point.

Gutter Creep 

Note: To print a border around each page, select Page Borders. 

Using Special Pages 

The Special Pages options control how covers, inserts, and exception pages are added to your printed 
document. 
• To locate Special Pages in Windows, on the Document Options tab, click Special Pages.
• To locate Special Pages on Macintosh, in the Print window, in the print options list, click Xerox

Features. Within Xerox Features, in the options list, click Special Pages.
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Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages 
that are different from the source used for the body of a document. For example, you can use your 
company letterhead for the first page of a document. You can use heavyweight paper for the first and 
last pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

The following options are available: 
• No Covers: This option does not print cover pages. No cover pages are added to the document.
• Front Only: This option prints the first page on paper from the specified tray.
• Back Only: This option prints the back page on paper from the specified tray.
• Front and Back: Same: This option prints the front and back cover pages from the same tray.
• Front and Back: Different: This option prints the front and back cover pages from different trays.

After you make a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, 
or both sides of the cover pages. 

Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates 
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages. 
• Insert Options: Provides the options to place an insert After Page X, where X is the specified page,

or Before Page 1.
• Quantity: Specifies the number of pages to insert at each location.
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. To specify a
different paper size, color, or type, for Paper, click the arrow, then select an option.

• Job Setting: Displays the attributes of the paper for the remainder of the job.
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Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11.

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings.
• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an

option:
− 1-Sided Print prints the exception pages on one side only.
− 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the

long edge. The job then can be bound on the long edge of the pages. 
− 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
− Use Job Setting prints the job using the attributes shown in the Job Settings box.

• Job Setting: Displays the attributes of the paper for the remainder of the job.

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.

Printing Watermarks for Windows 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

Notes: 

• This feature is available only on a Windows computer printing to a network printer.
• Not all options listed are supported on all printers. Some options apply only to a specific printer

model, configuration, operating system, or print driver type.
• Watermarks are not supported for some print drivers when booklet is selected or when more

than one page is printed on a sheet of paper.
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To print a watermark: 
1. In the print driver, click the Document Options tab.
2. Click the Watermark tab.
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or

create a customized watermark. You can also manage watermarks from this menu.
4. Under Text, select an option:

− Text: Enter the text in the field, then specify the font.
− Time Stamp: Specify the date and time options, then specify the font.
− Picture: To locate the picture, click the Browse icon.

5. Specify the scaling angle and position of the watermark.
− Select the scaling option that specifies the size of the picture in relation to the original image.

Use the arrows to scale the image in increments of 1%. 
− To define the angle of the image on the page, specify the position option, or to rotate the 

image left or right by increments of 1, use the arrows. 
− To define the location of the image on the page, specify the position option, or to move the 

image in each direction in increments of 1, use the arrows. 
6. Under Layering, select how to print the watermark.

− Print in Background prints the watermark behind the text and graphics in the document.
− Blend: This option combines the watermark with the text and graphics in the document. A

blended watermark is translucent, so you can see both the watermark and the document 
content. 

− Print in Foreground prints the watermark over the text and graphics in the document. 
7. Click Pages, then select the pages to print the watermark:

− Print on All Pages prints the watermark on all pages of your document.
− Print on Page 1 Only prints the watermark only on the first page of the document.

8. If you select a picture as a watermark, specify the lightness settings for the image.
9. Click OK.
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Orientation 

Orientation allows you to select the direction that the page prints. 
• To locate orientation options in Windows, on the Document Options tab, click Orientation.

Note: The orientation setting in your application print dialog box can override the orientation
options in the print driver.

• To locate orientation options on Macintosh, in the Print window, click Show Details.

The following options are available: 
• Portrait: Orients the paper so that the text and images print across the short dimension of the

paper.

• Landscape: Orients the paper so that the text and images print across the long dimension of the
paper.

• Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long
bottom side up.

Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto 
Rotate check box. 

Advanced Tab 

You can use the Advanced tab to set advanced printing options. Selections on this tab apply to all jobs 
that you print with the print driver. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

• To locate advanced printing options in Windows, in the print driver, click the Advanced tab.
• To locate advanced printing options on Macintosh, in the Print window, in the print options list, click

Xerox Features. Within Xerox Features, in the options list, click Advanced.
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Job Identification 

You can use the Job ID feature to change the job identification setting for your print job. You can print 
the job identification on a separate banner page or on the pages of your document. 

To change the job identification setting from the Advanced tab: 
1. Click Job ID or Job Identification.
2. Select an option.

− Disable Job ID: This option directs the printer not to print a banner page.
− Print ID on a Banner Page: This option prints the job identification on a banner page.
− Print ID in Margins - First Page Only: This option prints the job identification on the first page

of the document in the top-left margin. 
− Print ID in Margins - All Pages: This option prints the job identification in the top-left margin

on every page of the document. 
3. Click OK.
 

Printing Mirror Images 

If the PostScript print driver is installed, you can print pages as a mirror image. Images are mirrored left-
to-right when printed. 
• To locate mirror output in Windows, on the Advanced tab, for Advanced Settings, click Mirror

Output.
• To locate mirror output on Macintosh, within Xerox Features, in the Advanced window, click

Mirrored Output.

Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer 
screen with the name of the job and the name of the printer where it was printed. 

Note: This feature is only available on a Windows computer printing to a network printer. 

To select job completion notification from the Advanced tab: 
1. Click Notifications.
2. Click Notify for Completed Jobs, then select an option.

− Enabled: This option turns on notifications.
− Disabled: This option turns off the Notification feature.

3. Click OK.
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Document Encryption for Windows Print Jobs 

You can select encryption for your print job. The print file is encrypted before it is transmitted to the 
printer. The print file is decrypted before it is printed. 

Note: This feature is available on a Windows computer that is printing to a network printer. 
It applies to the PostScript and PCL print drivers. 

To locate the setting to enable or disable document encryption, in the print driver, click the 
Advanced tab. 

Note: This feature is available only when Document Encryption is set to Manually Encrypt 
Documents in the printer properties of the printer. For details, refer to Setting Encryption Defaults in 
Windows. on page 160. 

Setting Encryption Defaults in Windows 
1. Navigate to the list of printers on your computer:

− For Windows Server 2008 and later, click Start > Settings > Printers.
− For Windows 7, click Start > Devices and Printers.
− For Windows 8, click Start > Control Panel > Devices and Printers.
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners.

Scroll to Related settings, then click Devices and printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select 
Personalize. Select Control Panel Home > Devices and Printers. 

2. In the list of printers, right-click the icon for your printer, then select Printer properties.
3. In the printer Properties dialog box, click the Administration tab.
4. Under Configurations, click Document Encryption, then select an option:

− Disabled: This option disables encryption for all documents that you send to the printer.
− Encrypt All Documents: This option encrypts all documents that you send to the printer.
− Manually Encrypt Documents: This option allows you to set encryption for specific jobs that

you send to the printer. 

Note: Manually Encrypt Documents is the default printer setting. 

5. Click Apply.
6. To save the settings, click OK.
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Using Custom Paper Sizes 

This section includes: 
• Printing on Custom Paper Sizes ................................................................................................................................ 161
• Defining Custom Paper Sizes .................................................................................................................................... 161

You can print on custom paper sizes that are within the minimum and maximum size range supported by 
the printer. For details, refer to Supported Custom Paper Sizes on page 174. 

Printing on Custom Paper Sizes 
Note: Before printing on a custom paper size, use the Custom Paper Sizes feature in printer 
properties to define the custom size. For details, refer to Defining Custom Paper Sizes on page 161. 

Printing on Custom Paper Size from Windows 
Note: Before printing on custom-size paper, define the custom size in the printer properties. 

1. Load the custom-size paper in the tray.
2. In the application, click File > Print, then select your printer.
3. In the Print dialog box, click Printer Properties.
4. On the Printing Options tab, from the Paper list, select the required custom paper size and type.
5. Select any other required options, then click OK.
6. In the Print dialog box, click Print.
 

Printing on Custom Paper Size from Macintosh 
1. Load the custom-size paper. For details, refer to Loading Paper on page 177.
2. In the application, click File > Print.
3. From the Paper Size list, select the custom paper size.
4. Click Print.
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Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as 
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override 
control panel settings when you print using the print driver software on your computer. 

Creating and Saving Custom Paper Sizes in the Print Driver 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes on page 174. 

To create and save custom sizes for Windows: 
1. In the print driver, click the Printing Options tab.
2. For Paper, click the arrow, then select Other Size > Advanced Paper Size >

Output Paper Size > New.
3. In the New Custom Paper Size window, enter the height and width of the new size.
4. To specify the units of measurement, at the bottom of the window, click the Measurements button,

then select Inches or Millimeters.
5. To save, in the Name field, type a title for the new size, then click OK.

To create and save custom sizes for Macintosh: 
1. In the application, click File > Print.
2. Click Paper Size, then select Manage Custom Sizes.
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+).
4. Double-click Untitled, then type a name for the new custom size.
5. Enter the height and width of the new custom size.
6. Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User

Defined margins, set the top, bottom, right, and left margins.
7. To save the settings, click OK.
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Defining a Custom Paper Size at the Control Panel 

You can print custom-size paper from Tray 5. If Trays 1 and 2 are set to Fully Adjustable mode, you can 
print custom-size paper from Trays 1 and 2. Custom-size paper settings are saved in the print driver and 
are available for you to select in all your applications. 

Note: To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring 
Tray Settings on page 175. 

1. Open the paper tray, then load the custom-size paper.
2. Close the tray.
3. At the control panel, to define the new paper size, touch Size, then touch Custom.
4. In the Custom Paper Size window, enter the height and width of the new paper size, then touch OK.
5. To confirm the settings, touch Confirm.
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Print From 

This section includes: 
• Printing from a USB Flash Drive ............................................................................................................................... 164
• Printing from Saved Jobs ............................................................................................................................................ 164
• Printing from Mailbox .................................................................................................................................................. 165
• Printing from the Embedded Web Server ............................................................................................................. 165

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB 
Flash drive. 

Printing from a USB Flash Drive 

You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. 

Note: Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To print from a USB Flash drive: 
1. Insert the USB Flash drive into the USB port on the printer.
2. At the USB Drive Detected screen, touch Print from USB.

Note: If this feature does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.

3. To print a specific file, browse to that file, then touch the file name or icon.
4. Select the options for paper supply, quantity, 2-sided printing, output color, and finishing.
5. Touch Print.
6. After the job prints, to print another file, touch Change File.
7. To return to the Home screen, press the Home button.
8. When you are finished, remove the USB Flash drive.
 

Printing from Saved Jobs 

To print from saved jobs: 
1. At the control panel, press the Home button, then touch Print From.
2. Touch Saved Jobs, then touch the name of the folder that contains the saved job.
3. Touch the name of the saved job that you want to print.

Note: To print a private saved job, touch the name of the job, then enter the passcode.

4. Select the options for paper supply, quantity, 2-sided printing, output color, and finishing.
5. Touch Print.
6. After the job prints, to return to the list of saved jobs, touch Change File.
7. To return to the Home screen, press the Home button.
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Printing from Mailbox 

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive. 

To print from a mailbox: 
1. At the control panel, press the Home button, then touch Print From.
2. Select Mailboxes, then touch the name of the folder containing the document.

Note: If Mailboxes does not appear, enable the feature or contact the system administrator.
For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.

3. Touch the name of the document that you want to print.
4. Select the options for paper supply, quantity, 2-sided printing, output color, and finishing.
5. Touch Print.
6. After the job prints, to return to the mailbox folder, touch Change File.
7. To return to the Home screen, press the Home button.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Printing from the Embedded Web Server 

You can print .pdf, .ps, .pcl, and .xps files directly from the Embedded Web Server without need of 
another application or the print driver. The files can be stored on a local computer hard drive, mass 
storage device, or network drive. 

To print from the Embedded Web Server: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then

press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer
on page 46.

2. In the Embedded Web Server, click the Print tab.
3. To select the file from a local network or remote location, for File Name, click Browse, select the file,

then click Open.
4. For Printing, select the desired options for the job.

− Normal Print prints a job immediately.
− Secure Print prints a job after you enter your passcode at the printer control panel.
− Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining

copies at the printer. 
− Save Job for Reprint saves a print job in a folder on the print server for future printing. You can

specify a job name and folder. 
− Delay Print prints a job at a specified time up to 24 hours from the original job submission.

5. If Accounting is enabled, enter your User ID and account information.
6. Click Submit Job.

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation
message to appear before you close this page.
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Paper and Media Overview 

The printer has five paper trays: 
• Tray 1 is an adjustable paper tray for loading a range of paper sizes.
• For the 3-Tray configuration, Trays 2, 3, and 4 are adjustable trays similar to Tray 1.
• For the Tandem Tray configuration, Tray 2 is an adjustable paper tray, and Trays 3 and 4 are high-

capacity trays that can hold A4, Letter, JIS B5, and Executive size paper.
• Tray 5 is designed for loading small amounts of special paper.

The optional Envelope Tray can replace Tray 1. Tray 6 is an optional high-capacity paper tray holding 
A4, Letter, JIS B5, or Executive size paper. 

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-printed, 
cardstock, labels, transparencies, and envelopes. Ensure that you use the correct media for the tray that 
you are loading. You can load all types of media in Tray 5. 

Labels inside each tray show the correct orientation for loading certain types of media. The MAX label 
shows the maximum fill line for the tray. 
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Supported Paper 

This section includes: 
• Recommended Media .................................................................................................................................................. 169
• Ordering Paper ................................................................................................................................................................ 169
• General Paper Loading Guidelines .......................................................................................................................... 169
• Paper That Can Damage Your Printer ................................................................................................................... 170
• Paper Storage Guidelines ........................................................................................................................................... 170
• Supported Paper Types and Weights ..................................................................................................................... 171
• Supported Standard Paper Sizes .............................................................................................................................. 172
• Supported Paper Sizes and Weights for Automatic 2-Sided Printing ........................................................ 173
• Supported Paper Sizes for the Envelope Tray ..................................................................................................... 174
• Supported Custom Paper Sizes ................................................................................................................................. 174

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/rmlna Recommended Media List (United States)
• www.xerox.com/rmleu Recommended Media List (Europe)

Ordering Paper 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/ALC80XXsupplies. 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.
• Adjust the paper guides to fit the paper size.
• Fan paper before loading it in the paper tray.
• If excessive jams occur, use paper or other approved media from a new package.
• Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
• Do not print on label media once a label has been removed from a sheet.
• Use only paper envelopes. Print envelopes 1-sided only.

http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=order&Language=English
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper
• Inkjet paper
• Non-laser glossy or coated paper
• Paper that has been photocopied
• Paper that has been folded or wrinkled
• Paper with cutouts or perforations
• Stapled paper
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips
• Padded envelopes
• Plastic media
• Iron on transfer paper

CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction 
Guarantee does not cover damage caused by using unsupported paper or special media. 
The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Contact your Xerox representative for details. 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.
• Maintain constant temperatures and relative humidity.
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect

moisture.
• Store paper flat, either on pallets, cartons, shelves, or in cabinets.
• Avoid food or drinks in the area where paper is stored or handled.
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss
or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.
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Supported Paper Types and Weights 

Trays Paper Types Weights 

Trays 1 and 2 
Trays 3 and 4 of the 
3-Tray Module 

Bond 
Custom 
Hole-punched 
Letterhead 
Plain 
Pre-printed 
Recycled 
Transparency 

60–105 g/m² 

Labels 
Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–169 g/m² 

Cardstock 
Cardstock Reloaded 
Glossy Cardstock 
Glossy Cardstock Reloaded 

170–256 g/m² 

Trays 3 and 4 of the Tandem Tray 
Module 
Tray 6 

Bond 
Custom 
Hole-punched 
Letterhead 
Plain 
Pre-printed 
Recycled 
Transparency 

60–105 g/m² 

Labels 
Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–169 g/m² 

Cardstock 
Cardstock Reloaded 
Glossy Cardstock 
Glossy Cardstock Reloaded 

170–256 g/m² 

Tray 5 Bond 
Custom 
Hole-punched 
Letterhead 
Plain 
Pre-printed 
Recycled 
Transparency 

55–105 g/m² 

Envelopes 75-90 g/m² 

Labels 
Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–169 g/m² 
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Trays Paper Types Weights 

Cardstock 
Cardstock Reloaded 
Glossy Cardstock 
Glossy Cardstock Reloaded 

170–256 g/m² 

Heavyweight Cardstock 
Heavyweight Cardstock Reloaded 
Heavyweight Glossy Cardstock 
Heavyweight Glossy Cardstock 
Reloaded 

257–280 g/m² 

Envelope Tray Envelopes 75–90 g/m² 

Notes: 

• Reloaded paper is paper that was previously printed or copied on the printer. Use reloaded
media for manual 2-sided printing of media types that cannot be used for automatic 2-sided
printing.

• Pre-cut tabs are not supported.

Supported Standard Paper Sizes 

Tray Number European Standard Sizes North American Standard Sizes 

Trays 1 and 2 
Trays 3 and 4 of 
the 3-Tray Module 

A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A3 (297 x 420 mm, 11.7 x 16.5 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
B4 (250 x 353 mm, 9.8 x 13.9 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
JIS B4 (257 x 364 mm, 10.1 x 14.3 in.) 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
US Folio (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Tabloid (279 x 432 mm, 11 x 17 in.) 

Tray 2 
Trays 3 and 4 of 
the 3-Tray Module 

SRA3 (320 x 450 mm, 12.6 x 17.7 in.) 12 x 18 (305 x 457 mm, 12 x 18 in.) 

Trays 3 and 4 of 
the Tandem Tray 
Module 

A4 (210 x 297 mm, 8.3 x 11.7 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 

Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
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Tray Number European Standard Sizes North American Standard Sizes 

Tray 5 A6 (105 x 148 mm, 4.1 x 5.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A4 Oversized (223 x 297 mm, 
8.8 x 11.7 in.) 
215 x 315 (215 x 315 mm, 
8.5 x 12.4 in.) 
A3 (297 x 420 mm, 11.7 x 16.5 in.) 
B6 (125 x 176 mm, 4.9 x 6.9 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
B4 (250 x 353 mm, 9.8 x 13.9 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
JIS B4 (257 x 364 mm, 10.1 x 14.3 in.) 
SRA3 (320 x 450 mm, 12.6 x 17.7 in.) 

DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 
C6 envelope (114 x 162 mm, 
4.5 x 6.38 in.) 
C5 envelope (162 x 229 mm, 6.4 x 9 in.) 
C4 envelope (229 x 324 mm, 
9 x 12.8 in.) 

Postcard (89 x 140 mm, 3.5 x 5.5 in.) 
Postcard (102 x 152 mm, 4 x 6 in.) 
5 x 7 (127 x 178 mm, 5 x 7 in.) 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
8 x 10 (203 x 254 mm, 8 x 10 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
9 x 11 (229 x 279 mm, 9 x 11 in.) 
US Folio (216 x 330 mm, 8.5 x 13 in.) 
8.5 x 13.4 (216 x 340 mm, 8.5 x 13.4 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Tabloid (279 x 432 mm, 11 x 17 in.) 
12 x 18 (305 x 457 mm, 12 x 18 in.) 
12 x 19 (305 x 483 mm, 12 x 19 in.) 

Envelope (152 x 228 mm, 6 x 9 in.) 
Envelope (228 x 305 mm, 9 x 12 in.) 
Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.) 
No. 9 envelope (98 x 225 mm, 3.9 x 8.9 in.) 
No. 10 envelope (105 x 241 mm, 4.1 x 9.5 in.) 

Tray 6 A4 (210 x 297 mm, 8.3 x 11.7 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 

Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

Supported Paper Sizes and Weights for Automatic 2-Sided Printing 

European Standard Sizes North American Standard Sizes 

A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A3 (297 x 420 mm, 11.7 x 16.5 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
JIS B4 (257 x 364 mm, 10.1 x 14.3 in.) 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
US Folio (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Tabloid (279 x 432 mm, 11 x 17 in.) 

In addition to the standard sizes, you can use custom-size paper within the following ranges for 2-sided 
printing: 
• Minimum size 128 x 140 mm (5 x 5.5 in.)
• Maximum size 320 x 483 mm (12.6 x 19 in.)

Paper weights from 60 g/m² through 220 g/m² are supported for automatic 2-sided printing. 

Note: Do not use transparencies, envelopes, labels, or reloaded paper for automatic 2-sided printing. 
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Supported Paper Sizes for the Envelope Tray 

European Standard Sizes North American Standard Sizes 

DL (110 x 220 mm, 4.33 x 8.66 in.) 
C6 (114 x 162 mm, 4.5 x 6.38 in.) 
C5 (162 x 229 mm, 6.4 x 9 in.) 

Envelope (152 x 228 mm, 6 x 9 in.) 
Monarch (98 x 190 mm, 3.9 x 7.5 in.) 
No. 9 (98 x 225 mm, 3.9 x 8.9 in.) 
No. 10 (105 x 241 mm, 4.1 x 9.5 in.) 

Supported Custom Paper Sizes 

Tray Number Paper Sizes 

Tray 1 Minimum: 140 x 182 mm (5.5 x 7.5 in.) 
Maximum: 297 x 432 mm (11.7 x 17 in.) 

Tray 2 
Trays 3 and 4 of the 3-Tray Module 

Minimum: 140 x 182 mm (5.5 x 7.5 in.) 
Maximum: 320 x 457 mm (12.5 x 18 in.) 

Trays 3 and 4 of the Tandem Tray Module Standard sizes only: 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

Tray 5 Minimum: 89 x 98 mm (3.5 x 3.9 in.) 
Maximum: 320 x 483 mm (12.6 x 19 in.) 

Tray 6 Standard sizes only: 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 

Envelope Tray Minimum: 98 x 148 mm (3.9 x 5.8 in.) 
Maximum: 162 x 241 mm (6.4 x 9.5 in.) 
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Paper Tray Settings 

This section includes: 
• Configuring Tray Settings .......................................................................................................................................... 175
• Changing Paper Size, Type, and Color ................................................................................................................... 175

Configuring Tray Settings 

The system administrator can set trays to Fully Adjustable or Dedicated mode. When a paper tray is set 
to Fully Adjustable mode, you can change paper settings each time that you load the tray. When a paper 
tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, type and color. 

To configure the tray settings: 
1. At the printer control panel, touch Device.
2. Touch Tools, then touch Device Settings > Paper Management.
3. Touch Tray Settings, then select a tray.

− To set the mode, touch Fully Adjustable or Dedicated.
− To specify the paper settings for a dedicated tray, touch Edit, then set the paper size, type, and

color. Touch OK. 
− To configure the printer to select the tray automatically, for Auto Selection, touch Enabled.
− To set the priority for each tray, touch the number field. To enter a number, use the

alphanumeric keypad, or touch the plus icon (+) or the minus icon (-). The printer uses paper 
from the Priority 1 tray first. If that tray is empty, the printer uses paper from the Priority 2 
tray. 

4. Touch OK.
5. To close Tray Settings, touch X.
6. To close Tools, touch X.

Note: To access the Paper Management menu, log in as the system administrator. For details, refer
to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Changing Paper Size, Type, and Color 

When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that you 
load the tray. When you close the tray, the control panel prompts you to set the paper size, type, and 
color of paper loaded. 

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, 
type, and color. If you move the guides to load a different paper size, the control panel displays an error 
message. 

To configure the tray settings for Fully Adjustable or Dedicated mode, refer to Configuring Tray Settings 
on page 175. 

To set the paper size, type, or color when a tray is set to Fully Adjustable: 
1. Open the paper tray, then load the required paper.
2. Close the tray.
3. At the control panel, select the correct paper size, type, and color:

− To select a new paper size, touch Size.
− To select a new paper type, touch Type.
− To select a new paper color, touch Color.

4. To confirm the settings, touch Confirm.

To set the paper size, type, or color when a tray is set to Dedicated, refer to Configuring Tray Settings on 
page 175. 
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Loading Paper 

This section includes: 
• Loading Paper in Trays 1–4 ....................................................................................................................................... 177
• Adjusting the Paper Guides in the 520-Sheet Adjustable Trays .................................................................. 180
• Loading Paper in Trays 3 and 4 of the Tandem Tray ...................................................................................... 181
• Loading Paper in Tray 5 .............................................................................................................................................. 183
• Loading Paper in Tray 6 .............................................................................................................................................. 185

Loading Paper in Trays 1–4 

The system administrator can set Trays 1–4 to Fully Adjustable or Dedicated mode. Each time a tray is 
opened and closed, the paper settings appear on the control panel: 
• The Fully Adjustable mode allows you to confirm or change the media settings. The tray guides

automatically detect the size of paper loaded.
• The Dedicated mode displays the media settings for the tray. A warning message appears on the

control panel when the wrong media is loaded, or the tray guides are set incorrectly.

Note: Only the system administrator can change the media settings for a Dedicated tray.

A warning message appears on the control panel when the paper in the tray is in short supply, or when a 
tray is empty. 

To load Trays 3 and 4 of the Tandem Tray Module, refer to Loading Paper in Trays 3 and 4 of the 
Tandem Tray on page 181. 
1. Pull out the tray until it stops.

2. Ensure that the paper-guide locks are set in the correct position for the standard or custom size
paper that you are loading. For details, refer to Adjusting the Paper Guides in the 520-Sheet
Adjustable Trays on page 180.
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3. Remove any paper that is a different size or type.
4. To move out the length and width guides:

a. Pinch the guide lever on each guide.
b. Slide the guides outward until they stop.
c. Release the levers.

5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.

Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

6. Load paper in the tray. Position the paper against the left side of the tray.
− For long-edge feed, insert letterhead and pre-printed paper face down with the top edge

toward the front. Load hole-punched paper with the holes to the left. 
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− For short-edge feed, insert letterhead and pre-printed paper face down with the top edge to 
the left. Load hole-punched paper with the holes toward the rear of the printer. 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer 
to jam. 

7. Adjust the length and width guides until they touch the edges of the paper.

8. Close the tray.

9. At the control panel, select the correct paper size, type, and color:
− To select a new paper size, touch Size.
− To select a new paper type, touch Type. For letterhead paper, select Letterhead. For pre-

printed paper, select Pre-Printed. For hole-punched paper, select Hole Punched. 
− To select a new paper color, touch Color.

10. To confirm the settings, touch Confirm.

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring Tray 
Settings on page 175. 
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Adjusting the Paper Guides in the 520-Sheet Adjustable Trays 

You can adjust the paper guides in Trays 1–4 to accommodate standard or custom paper sizes. In the 
standard position, the guides move into the supported standard paper settings. In the custom position, 
the guides move in 1-mm (0.04 in.) increments. 

To move the paper guides from the standard to the custom paper-size position: 
1. Pull out the tray until it stops.

2. Remove any paper from the tray, pinch the guide levers, and move the guides outward until
they stop.

3. To move out the paper-length guide, pinch the guide lever and slide the guide outward.

5.5” 
A5 

8.5” 
8” B5 

A4 
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4. To move out the paper-width guide, pinch the guide lever and slide the guide outward.

5. Load the custom-size paper in the tray.
6. To engage the fine-adjustment block, pinch the levers and slide the guides inward. The tray guides

move in increments of 1 mm.

14”

A3 

8K

B4

A4

B5

13”

11”
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Loading Paper in Trays 3 and 4 of the Tandem Tray 

The Tandem Tray Module holds larger amounts of paper for fewer printing interruptions. It contains 
three trays. Tray 2 holds paper sizes up to SRA3/12 x 18 in. Trays 3 and 4 hold A4-size (210 x 297 mm), 
Letter-size (8.5 x 11 in.), JIS B5-size (182 x 257 mm), or Executive-size (7.25 x 10.5 in.) paper only. 

The control panel displays a warning message when the paper in the tray is in short supply, or when a 
tray is empty. 

To change the paper size, refer to Configuring Trays 3 and 4 of the Tandem Tray Module on page 34. 

To load Tray 2, refer to Loading Paper in Trays 1–4 on page 177. 
1. Pull Tray 3 or Tray 4 out until it stops. Wait for the tray to lower and stop.
2. The control panel displays the paper tray settings. Ensure that you load the correct paper type.

Note: Do not load custom-size paper into Tray 3 or Tray 4 of the Tandem Tray Module.

3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

4. Stack the paper against the left rear corner of the tray as shown.
− Insert letterhead and pre-printed paper face down with the top edge toward the front of the

tray. 
− Load hole-punched paper with the holes to the left. 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

5. Close the tray.
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Loading Paper in Tray 5 

Tray 5 supports the widest variety of media types. You can use the tray for small-quantity jobs that use 
special paper, such as labels, transparencies, and envelopes. The tray extension provides support for 
larger paper sizes. 

Notes: 

• Use Tray 5 to load heavyweight paper types (257–280 g/m²).
• For faster print speeds, load paper 320 mm (12.6 in.) or shorter with the long edge going into

the printer.
• Load paper longer than 320 mm (12.6 in.) with the short edge going into the printer.
• To load labels, refer to Loading Labels in Tray 5 on page 193.
• To load transparencies, refer to Guidelines for Printing on Transparencies on page 196.

1. Open Tray 5, then for larger paper sizes, pull out the extension tray. If Tray 5 is already open,
remove any paper that is a different size or type.

2. Move the width guides to the edges of the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface.
This procedure separates any sheets that are stuck together and reduces the possibility of jams.
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Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

4. Load the paper in the tray.
− For long-edge feed, insert letterhead and pre-printed paper face up with the top edge toward

the front of the tray. Load hole-punched paper with the holes leading into the printer. 

− For short-edge feed, insert letterhead and pre-printed paper face up with the top edge leading 
into the printer. Load hole-punched paper with the holes toward the rear of the printer. 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer 
to jam. 

5. Adjust the width guides until they touch the edges of the paper.
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6. At the control panel, select the correct paper size, type, and color:
− To select a new paper size, touch Size.
− To select a new paper type, touch Type. For letterhead paper, touch Letterhead.

For pre-printed paper, touch Pre-Printed. For hole-punched paper, touch Hole Punched. 
− To select a new paper color, touch Color.

7. To confirm the settings, touch Confirm.
 

Loading Paper in Tray 6 

Tray 6 is an optional high-capacity, dedicated paper tray. It is on the left side of the printer. The tray 
feeds A4 (210 x 297 mm), Letter (8.5 x 11 in.), JIS B5 (182 x 257 mm), or Executive (7.25 x 10.5 in.) 
paper. The tray capacity is 2000 sheets. 

The control panel displays a warning message when the paper in the tray is in short supply, or when the 
tray is empty. 

To change the paper size, refer to Configuring Tray 6 on page 34. 
1. Pull out Tray 6 from the feeder until it stops.
2. Open the side gate until it stops.
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3. The control panel displays the paper settings. Ensure that you load the correct paper type in the
tray.

Note: Do not load custom-size paper into Tray 6.

4. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

5. Load the paper against the right side of the tray.
− Insert letterhead and pre-printed paper face up with the top edge toward the front of the tray.
− Load hole-punched paper with the holes toward the right side of the tray.

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams. 

6. Close the tray.
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Printing on Special Paper 

This section includes: 
• Envelopes .......................................................................................................................................................................... 187
• Labels ................................................................................................................................................................................. 190
• Glossy Media ................................................................................................................................................................... 194
• Transparencies ................................................................................................................................................................ 195

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/ALC80XXsupplies. 

For reference:  
www.xerox.com/rmlna Recommended Media List (United States) 
www.xerox.com/rmleu Recommended Media List (Europe) 

Envelopes 

You can print envelopes from Tray 5. When the optional Envelope Tray is installed, you can print 
envelopes from Tray 1. 

Guidelines for Printing Envelopes 
• Use only paper envelopes.
• Do not use envelopes with windows or metal clasps.
• Print quality depends on the quality and construction of the envelopes. If you do not get the desired

results, try another envelope brand.
• Maintain constant temperatures and relative humidity.
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of them.

• In the print driver software, select Envelope as the paper type.
• Do not use padded envelopes. Use envelopes that lie flat on a surface.
• Do not use envelopes with heat activated glue.
• Do not use envelopes with press and seal flaps.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=order&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
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Loading Envelopes in Tray 5 
1. Open Tray 5. Remove any paper or envelopes that are a different size or type.
2. Move the width guides to the edges of the tray.
3. Load envelopes in the tray.

− For envelopes with the flap on a long edge, load envelopes with the flaps closed, flaps up, and
flaps on the leading edge, toward the right. 

− For envelopes with the flap on a short edge, load envelopes with the flaps closed, flaps up, and 
flaps on the leading edge, toward the right. 

4. Center the stack of envelopes. Adjust the guides so that they touch the edges of the envelopes.
5. At the control panel, select the correct paper size, type, and color.

− To select an envelope size, touch Size. To specify a custom envelope size, touch Custom, then
specify the dimensions of the envelope. 

− For a custom envelope size, touch Type, then touch Envelope.
− To select a new envelope color, touch Color.

Note: When you select an envelope size from the list, the paper type is set to Envelope.

6. To confirm the settings, touch Confirm.
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Loading the Envelope Tray 

You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray holds the following 
envelope sizes: 
• Envelope 6 x 9, Monarch, No. 9, and No.10
• DL, C5, and C6
1. Pull out the Envelope Tray until it stops.

2. Load envelopes in the tray.
− For envelopes with the flap on a long edge, load envelopes with the flaps closed, flap-side

down, and the flaps on the left side of the tray. 

− For envelopes with the flap on a short edge, load envelopes with the flaps closed, flap-side 
down, and the flaps on the left side of the tray. 
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3. Adjust the paper guides so that they rest lightly against the edges of the envelopes.

4. Ensure that the envelope stack height is less than 43 mm (1.7 in.) or that there are no more than
60 envelopes loaded in the tray.

5. Close the tray.
6. At the control panel, select the correct paper size and color.

− To select a new envelope size, touch Size.
− To select a new envelope color, touch Color.

Note: When the Envelope Tray is installed, the paper type is set to Envelope.

7. To confirm the settings, touch Confirm.
 



Paper and Media 

Xerox® AltaLink® C80XX Series Multifunction Printer 191 
User Guide 

Labels 

You can print labels from any tray. 

Guidelines for Printing Labels 
• Use labels designed for laser printing.
• Do not use vinyl labels.
• Do not feed a sheet of labels through the printer more than once.
• Do not use dry gum labels.
• Print only on one side of the sheet of labels. Use full sheet labels only.
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original

packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing
them in extreme conditions can cause print-quality problems or cause them to jam in the printer.

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

• In the print driver software, select Label as the paper type.
• Before loading labels, remove all other paper from the tray.

CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the 
backing sheet. It could damage the printer. 
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Loading Labels in Trays 1–4 
1. Pull out the tray until it stops.

2. Remove any paper that is a different size or type.
3. Ensure that the guide locks are set in the correct position for the size labels you are loading.

For details, refer to Adjusting the Paper Guides in the 520-Sheet Adjustable Trays on page 180.

Note: Trays 1–4 can print labels 106–169 g/m².

4. Load labels in the tray.
− For long-edge feed, load labels face up, with the top edge toward the front of the tray.

− For short-edge feed, load labels face up, with the top edge toward the right of the tray. 

5. Close the tray.
6. At the control panel, select the correct paper size, type, and color:

− Ensure that the paper type is set to Labels. To select a new paper type, touch Type.
− To select a new paper size, touch Size.
− To select a new paper color, touch Color.

7. To confirm the paper settings, touch Confirm.
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Loading Labels in Tray 5 
1. Open Tray 5, then for larger sizes, pull out the extension tray. If Tray 5 is already open, remove any

paper that is a different size or type.

2. Move the width guides to the edges of the tray.

3. Load the labels in the tray:
− For long-edge feed, load labels face down with the top edge toward the front of the tray.
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− For short-edge feed, load labels face down with the top edge to the left. 

Notes: 

• Do not load paper above the maximum fill line. Overfilling the tray can cause the printer
to jam.

• Do not print on label media after a label has been removed from a sheet.
• To avoid jams and misfeeds, do not remove paper from its packaging until you are ready

to use it.
4. Adjust the width guides until they touch the edges of the paper.

5. At the control panel, select the correct paper size, type, and color:
− Ensure that the paper type is set to Labels. To select a new paper type, touch Type.
− To select a new paper size, touch Size.
− To select a new paper color, touch Color.

6. To confirm the paper settings, touch Confirm.
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Glossy Media 

You can print glossy paper, up to 256 g/m2, from any tray. You can print heavyweight glossy paper from 
Tray 5 only. 

Note: For best results, load Glossy Cardstock, and Glossy Cardstock Reloaded paper into Tray 5. 

Guidelines for Printing on Glossy Paper 
• Do not open sealed packages of glossy paper until you are ready to load them into the printer.
• Leave glossy paper in the original wrapper, and leave the packages in the shipping carton until

ready to use.
• Remove all other paper from the tray before loading glossy paper.
• Load only the amount of glossy paper that you are planning to use. Do not leave glossy paper in the

tray when you are finished printing. Reinsert unused paper in the original wrapper and seal.
• Rotate paper frequently. Long periods of storage in extreme conditions can cause glossy paper to

curl and jam in the printer.
• In the print driver software, select the desired glossy paper type or select the tray loaded with the

desired paper.

Loading Gloss Paper in Tray 5 
1. Before you load glossy paper, remove all other paper from the tray.
2. Load only the amount of paper you plan to use.
3. Load the paper with the glossy side or print side down.
4. At the control panel, select the correct paper size, type, and color:

− Ensure that the paper type is set to Glossy. To select a new paper type, touch Type.
− To select a new paper size, touch Size.
− To select a new paper color, touch Color.

5. To confirm the settings, touch Confirm.
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Transparencies 

Transparencies can be printed from trays 1–5. For best results, use only recommended Xerox® 
transparencies. 

CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Please contact your local representative for details. 

Guidelines for Printing on Transparencies 
• Before you load transparencies in the tray, remove all paper.
• Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print

quality.
• Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.
• For clear or non-strip transparencies:

− Load transparencies face up into Trays 1–4.
− Load transparencies face down into Tray 5.

• For striped transparencies:
− Load transparencies into Trays 1–4 with the strip face down on the right trailing edge.
− Load transparencies into Tray 5 with the strip face up on the left trailing edge.

• Do not fan transparencies.
• After you load transparencies, on the control panel, change the paper type to Transparency.
• In the print driver software, for the paper type, select Transparency.
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This chapter includes: 
• General Precautions ...................................................................................................................................................... 198
• Cleaning the Printer ...................................................................................................................................................... 199
• Supplies ............................................................................................................................................................................. 207
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General Precautions 

CAUTION: When cleaning your printer do not use organic or strong chemical solvents or 
aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials 
only as directed in this documentation. 

WARNING: Keep all cleaning materials out of the reach of children. 

WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized 
sprays contain explosive mixtures and are not suitable for use in electrical applications. Use of 
pressurized spray cleaners increases the risk of fire and explosion. 

WARNING: Do not remove the covers or guards that are fastened with screws. You cannot 
maintain or service any parts that are behind these covers and guards. Do not attempt any 
maintenance procedure that is not described in the documentation supplied with your printer. 

WARNING: Internal parts of the printer can be hot. Use caution when doors and covers 
are open. 

• Do not place anything on top of the printer.
• Do not leave the covers and doors open for any length of time, especially in well-lit places.

Light exposure can damage the imaging units.
• Do not open covers and doors during printing.
• Do not tilt the printer while it is in use.
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print

quality to deteriorate.
• Ensure any parts removed during cleaning are replaced before you plug in the printer.
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Cleaning the Printer 

This section includes: 
• Cleaning the Printer Exterior ..................................................................................................................................... 199
• Cleaning the Printer Interior ...................................................................................................................................... 203

Cleaning the Printer Exterior 

Regular cleaning keeps the touch screen and control panel free from dust and dirt. 

To clean the printer exterior: 
1. To avoid activating buttons and menus when cleaning the printer, press the Power/Wake button,

then touch Sleep.

2. To remove fingerprints and smudges, clean the touch screen and control panel with a soft,
lint-free cloth.
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3. To return the printer to Ready mode, press the Power/Wake button.
4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior

areas of your printer.

Cleaning the Scanner 

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with 
streaks, smears, and other marks that transfer from the glass while scanning documents. 
1. Slightly dampen a soft, lint-free cloth with water.
2. Remove any paper or other media from the output tray.
3. Open the document cover.
4. Wipe the surfaces of the document glass and CVT glass until they are clean and dry.

Note: For best results, use Xerox® Glass Cleaner to remove marks and streaks.
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5. Wipe the white underside of the document cover until it is clean and dry.

6. Close the document cover.
 

Cleaning the Document Feed Rollers 

Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best 
performance, clean the document feed rollers once a month. 
1. Lift the lever and open the top cover of the document feeder.

2. While turning the rollers, wipe them with a clean, lint-free cloth moistened with water.

CAUTION: Do not use alcohol or chemical cleaners on the document feed rollers. 

3. Close the document feeder top cover.
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Cleaning the Second-Side Scanning Lens Assembly 

The second-side scanning lens assembly allows you to make 2-sided scans and copies with a single pass 
of the original. The assembly is on the left side of the document cover and includes a mirrored glass strip, 
a metal strip, a white-plastic strip, and rollers. 

Note: Xerox recommends that you clean all parts of the second-side scanning lens assembly 
regularly. 

To clean the second-side scanning lens assembly: 
1. To access the second-side scanning lens assembly, lower the lever under the left side of the

document cover.

2. To separate the left end of the document cover from the lens assembly, continue to lower the lever.
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3. Using a soft cloth moistened with water, wipe the mirrored glass, metal strip, both sides of the
white-plastic strip, and the rollers. If dirt is difficult to remove, moisten a soft cloth with a small
amount of neutral detergent. Then wipe the parts dry with a soft cloth.

CAUTION: To prevent damage to the film around the glass, do not press heavily on the 
mirrored glass. 

4. Return the document cover to its original position, ensuring the lever is locked in place. If you touch
the document cover with your bare hands, clean the cover before closing the document feeder.
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Cleaning the Printer Interior 

Cleaning the Printhead Lenses 

The printer is constructed with four printhead lenses. Clean all lenses as described in the following 
procedure. 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front cover of the printer.

2. Turn the belt tension lever to the left.

3. Pull the drum cartridge cover down until it clicks into the open position.
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4. Each of the four printheads has its own cleaning tool. Slowly pull out the LED printhead cleaner until
the three dots are visible.

Note: The LED printhead cleaner does not detach from the printer.

5. Slowly push the LED printhead cleaner back into the printhead until it stops.

6. Repeat Steps 4 and 5 for each printhead.
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7. Close the drum cartridge cover.

8. Turn the belt tension lever to the right to return it to the locked position.

9. Close the printer front cover.
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Supplies 

This section includes: 
• Consumables ................................................................................................................................................................... 207
• Routine Maintenance Items ...................................................................................................................................... 208
• Ordering Supplies ........................................................................................................................................................... 208
• Toner Cartridges............................................................................................................................................................. 209
• Waste Toner Container ............................................................................................................................................... 211
• Drum Cartridges ............................................................................................................................................................. 213
• Transfer Belt Cleaner .................................................................................................................................................... 217
• Second Bias Transfer Roller........................................................................................................................................ 219
• Staple Cartridges and Staple Refills ........................................................................................................................ 223
• Emptying the Hole Punch Waste Container ........................................................................................................ 234
• Recycling Supplies ......................................................................................................................................................... 237
• Resetting Supply Life Counters ................................................................................................................................. 238

Consumables 

Consumable supplies are printer supplies that become depleted during the operation of the printer. 
Consumable supplies for this printer include the following supplies: 
• Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black.
• Staple Cartridges and Staple Refills for the Optional Integrated Office Finisher.
• Staple Cartridges and Staple Refills for the Optional Office Finisher LX or the Office Finisher LX with

Booklet Maker.
• Staple Cartridges and Staple Refills for the Optional Business Ready Finisher or the Business Ready

Finisher with Booklet Maker.

Notes:

− Each consumable includes installation instructions. To replace consumables, refer to the
instructions included with the consumable supply. 

− Only install new toner cartridges in your printer. If a used toner cartridge is installed, then the 
toner remaining amount displayed can be inaccurate. 

− To ensure print quality, the toner cartridge is designed to cease functioning at a predetermined 
point. 

CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality 
controls by Xerox for specific use with this printer. 
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Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 

Note: Each routine maintenance item includes installation instructions. 

Routine maintenance items for this printer include the following: 
− Waste Toner Container 
− Drum Cartridges 
− Transfer Belt Cleaner 
− Second Bias Transfer Roller 
− Hole-Punch Waste Container 

Ordering Supplies 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/ALC80XXsupplies. 

CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or 
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies 
not specified for this printer. The Total Satisfaction Guarantee is available in the United States 
and Canada. Coverage could vary outside these areas. Please contact your Xerox 
representative for details. 

Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts 
appear on the control panel. 

You can customize the alerts that appear on the control panel and configure email alert notifications 
using the Embedded Web Server. 

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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To check the supplies status at the control panel: 
1. At the printer control panel, press the Home button.
2. To view status information for the printer supplies, touch Device > Supplies.
3. To view details about a specific toner cartridge, including the part number for reordering, touch

Cyan, Magenta, Yellow, or Black.
4. To return to the Supplies screen, touch X.
5. To view more details, touch Other Supplies. Scroll through the list, then select an option.
6. To return to the Supplies screen, touch X.
7. To print the Supplies Report, touch Print Supplies Report.
8. To return to the Device screen, touch X.
 

Toner Cartridges 

WARNINGS: 

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills,
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust.

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner,
have the child spit out the toner, and rinse out their mouth with water. Consult a
physician immediately.

WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to 
remove spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you 
spill a large volume of toner, contact your local Xerox representative. 

WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the 
cartridge can catch fire and cause burn injuries or an explosion. 
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Replacing the Toner Cartridges 

When it is time to replace a toner catridge, the printer displays a message on the control panel. 

Note: Each toner cartridge includes installation instructions. 

To replace a toner cartridge: 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front cover of the printer.

2. Place your fingers under the lip of the toner cartridge, then pull the toner cartridge straight out of
the printer.
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3. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left and
right 10 times.

4. Hold the new toner cartridge with the arrow facing up, then push the cartridge in slowly until it
stops.

5. Push gently on the toner cartridge to ensure that it is seated.

6. Close the printer front cover.

Waste Toner Container 

Replacing the Waste Toner Container 

A message appears on the control panel when the waste toner container must be replaced. 

When replacing the waste toner container, clean the printhead lenses. For details, see Cleaning the 
Printhead Lenses on page 204. 

CAUTION: Spread paper on the floor to catch possible toner spills. 

WARNING: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a 
vacuum cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or 
explosion. 
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WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as 
you can. If some toner remains on your clothes, use cool water, not hot, to rinse off the 
toner. If toner gets on your skin, wash it off with cool water and a mild soap. If you get toner 
in your eyes, wash it out immediately with cool water and consult a doctor. 

Note: Each waste toner container includes installation instructions. 

To replace the waste toner container: 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front cover of the printer.

2. Remove the new waste toner container from the packaging. Retain the packaging.

3. Pull the used waste toner container out slowly while supporting it with your other hand.
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4. Place the used waste toner container in the plastic bag, then seal it firmly using the zipper.

5. Place the used waste toner container in the empty box.

6. Hold the left side of the new waste toner container and slide it into the printer until it clicks.

7. Clean the printhead lenses. For details, refer to Cleaning the Printhead Lenses on page 204.
Close the front cover.
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Drum Cartridges 

Replacing the Drum Cartridges 

A message appears on the control panel when a drum cartridge must be replaced. 

Note: Each drum cartridge includes installation instructions. 

To replace a drum cartridge: 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor 
fluorescent lighting. Do not touch or scratch the surface of the drum. 

1. Open the front cover of the printer.

2. Turn the belt tension lever to the left.

3. Pull the drum cartridge cover down until it clicks into the open position.
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4. Grip the orange handle of the drum cartridge as shown, then pull the drum cartridge straight out of
the printer. Place the used drum cartridge in the plastic bag and place in the box.

WARNING: Do not touch any toner adhering to the drum cartridge. 

5. Remove the packing material from the end of the new drum cartridge.
6. Rest the new cartridge, along with its black plastic protective shield, in the cartridge slot. Load the

cartridge in the direction of the arrow on the top of the shield.

7. With the guides inserted in the slot, to remove the black paper sheet, pull it in the direction shown.
Remove the tape from the top of the cartridge shield.

8. Hold the shield, then use the orange handle to push the cartridge into the printer.
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9. Continue to push the orange handle until it stops.

10. Carefully remove the protective shield, then push the drum cartridge until it stops.

11. Close the drum cartridge cover.

12. Turn the belt tension lever to the right to return it to the locked position.

13. Close the printer front cover.
14. Dispose of the protective shield and tape as normal office waste.
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Transfer Belt Cleaner 

Replacing the Transfer Belt Cleaner 

A message appears on the control panel when the transfer belt cleaner must be replaced. 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front cover of the printer.

2. Turn the orange lever to the right to unlock the belt cleaner.

3. Turn the orange knob counterclockwise until it releases.
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4. Pull the transfer belt cleaner straight out of the printer.

WARNING: Do not touch any toner adhering to the transfer belt cleaner. Do not tilt the 
transfer belt cleaner or toner could spill. 

5. Remove the new transfer belt cleaner from the packaging. Retain the packaging.
6. Place the used transfer belt cleaner in the plastic bag.

7. Remove the protective cover from the new transfer belt cleaner.

CAUTION: Do not touch the surface of the transfer belt cleaner. Doing so could deteriorate 
image quality. 
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8. Support the new transfer belt cleaner with your left hand and slide it straight into the opening until
it stops.

9. Push the orange knob in, then turn it clockwise until snug.

10. To lock the belt cleaner, turn the orange lever to the left.

11. Close the printer front cover.
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Second Bias Transfer Roller 

Replacing the Second Bias Transfer Roller 

When the second bias transfer roller needs to be replaced, a message appears on the control panel. 
1. Remove paper from the left tray, then fold up the tray.

2. To open Door A, open Tray 5, then lift the release lever and open Door A.

WARNING: The area around the fuser can be hot. Use caution to avoid injury. 

CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or 
damage the transfer belt. Do not touch the transfer roller. Touching the roller can reduce 
image quality. 

3
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2



Maintenance 

Xerox® AltaLink® C80XX Series Multifunction Printer 221 
User Guide 

3. Remove the new transfer roller from the packaging. Retain the packaging.
4. Push the orange lever in the direction shown.

5. Lift the used transfer roller out of the printer.

Note: Do not touch any toner adhering to the transfer roller.

6. Place the used transfer roller in the plastic bag.
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7. Place the new transfer roller in the printer as shown. Press down until the transfer roller clicks into
place.

8. Remove the protective cover from the transfer roller.

9. To close Door A, push the door up firmly until it clicks into place, then close Tray 5.

1 2

3
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Staple Cartridges and Staple Refills 

This section includes: 
• Replacing Staples in the Integrated Office Finisher ......................................................................................... 223
• Replacing Staples in the Office Finisher LX .......................................................................................................... 225
• Replacing Staples in the Business Ready Finisher ............................................................................................. 228
• Replacing Staples in the Convenience Stapler ................................................................................................... 234

When a staple cartridge is empty, a message appears on the control panel. 

Replacing Staples in the Integrated Office Finisher 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the finisher front door.

2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.
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3. Check inside the finisher for any loose staples and remove them.
4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler until
it clicks.

7. Close the finisher front door.

1

1

2

1

2
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Replacing Staples in the Office Finisher LX 

Replacing Staples in the Main Stapler of the Office Finisher LX 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
3. Push the stapler assembly to the right as shown.

4. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.
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5. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.

7. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until it clicks.

8. Close the finisher front door.
 

1

1

2

1

2
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Replacing Staples in the Booklet Maker of the Office Finisher LX 

WARNING: Do not perform this procedure while the printer is printing. 

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide them to the center.

3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.
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4. Hold the tabs on both sides of the new staple cartridge and insert it into the original position in the
finisher.

Note: If you have trouble inserting the cartridge, ensure that the staples are positioned correctly 
in the cartridge. 

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple 
cartridges contain staples. 

5. Repeat the procedure for the other staple cartridge.
6. Close the finisher side cover.
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Replacing Staples in the Business Ready Finisher 

Replacing Staples in the Main Stapler of the Business Ready Finisher 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front door of the Business Ready finisher.

2. Hold the stapler assembly by the orange lever R1 and push it to the right.

3. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

(R1)
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4. Pinch both sides of the staple pack and remove the staple pack from the cartridge.

5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until it clicks.

7. Return the staple cartridge assembly to its original position.
 

1

1

2

1

2
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Replacing Staples in the Booklet Maker of the Business Ready Finisher 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front door of the Business Ready finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on
the top edge of the device.
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3. To remove a staple cartridge from the booklet maker, push down on the staple cartridge handle, as
shown, then pull the cartridge out and up.

4. Turn over the staple cartridge.
5. To permit the staple cartridge handle to open out and away from the staple pack, press in the green

tabs, then pull back the handle.

6. To remove the staple pack, press the rear of the cartridge, then lift out the staple pack as shown.

1

1 2
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7. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the
cartridge.

8. To close the staple cartridge, push back the cartridge handle until it clicks.

9. To return the staple cartridge to the booklet maker, insert the staple cartridge and push up on the
cartridge handle as shown.

1

2
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10. Return the booklet maker to its original position, then close the finisher door.

Replacing Staples in the Convenience Stapler 
1. Lift the lever at the rear of the convenience stapler, then gently rotate the staple head toward you.
2. Grip the staple cartridge and pull it out of the stapler head.

3. Unpack the new staple cartridge. Remove any partial strips and any staple strips that are not flat.
4. Install the new staple cartridge in the convenience stapler. The staple cartridge clicks into place.
5. Release the lever at the front of the convenience stapler, then gently rotate the staple head away

from you.
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Emptying the Hole Punch Waste Container 

A message appears on the control panel when the hole punch waste container is full. 

Emptying the Hole Punch Waste Container in the Office Finisher LX 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Lift the finisher transport top cover, then open the front transport cover.

2. Pull out the hole-punch waste container.

3. Empty the container.
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4. Insert the container all the way into the finisher.

5. Close the finisher front transport cover, then close the top cover.
 

Emptying the Hole Punch Waste Container in the Business Ready Finisher 

CAUTION: Do not perform this procedure when the printer is copying or printing. 

1. Open the front door of the Business Ready finisher.

2. Remove the hole-punch waste container from its slot near the top left of the finisher.

Notes:

• When you remove the hole-punch waste container, wait 10 seconds before you reinsert it into
the printer. The hole-punch counter resets after 10 seconds.

• If you remove the hole-punch waste container before the device instructs you to, empty the
container before you reinsert it into the finisher.
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3. Empty the container.

4. Insert the container all the way into the finisher.

5. Close the front door of the Business Ready finisher.

Recycling Supplies 

For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa. 

Supplies include a prepaid return label. Please use it to return used components in their original boxes for 
recycling. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=recyclesupplies&Language=English
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Resetting Supply Life Counters 

You must reset the supply life counters when you replace some supplies. 
1. At the printer control panel, press the Home button.
2. Touch the Log In button, enter the system administrator login information, then touch Done.

For details, refer to the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.
3. Touch Device > Tools > Supplies.
4. Touch Supply Counter Reset.
5. To select an item to reset, touch the supply item in the list, then touch Reset Counter.
6. On the confirmation screen, touch Reset.
7. To return to the Tools screen, touch X, then touch X again.
8. To return to the Home screen, press the Home button.
9. Touch the Log In button, then touch Logout.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Managing the Printer 

This section includes: 
• Viewing the Meter Reading ....................................................................................................................................... 239
• Printing the Billing Summary Report ...................................................................................................................... 239

Viewing the Meter Reading 

The Billing/Usage menu displays the total number of impressions that the printer generated or printed 
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper. For 
example, a sheet of paper that is printed on two sides counts as two impressions. 

Note: If you provide regular billing information for your device, you can use the Remote Services Upload 
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox 
automatically so that you do not have to collect the readings manually. Refer to the System 
Administrator Guide for further information. 

To view the billing information for your printer: 
1. At the printer control panel, press the Home button.
2. Touch Device > Billing/Usage.
3. To view more details, touch Usage Counters, then select an option.
4. After viewing the usage readings, to return to the Device screen touch X, then touch X again.
5. To return to the Home screen, press the Home button.
 

Printing the Billing Summary Report 

The Billing Summary Report provides information about the device and a detailed listing of the billing 
meters and sheet counts. 

To print the Billing Summary Report: 
1. At the printer control panel, press the Home button.
2. Touch Device > Information Pages.
3. Touch Billing Summary, then touch Print.
4. To return to the Home screen, press the Home button.
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Moving the Printer 

• Always power off the printer and wait for the printer to shut down. To power off the printer, verify
that there are no jobs in the queue, then press the secondary power switch. Wait 10 seconds after
the touch screen goes dark, then power off the main power switch. For details, refer to Powering the
Printer On and Off on page 38.

• Disconnect the power cord from the back of the printer.
• Keep the printer level to avoid spilling toner.

Note: When moving the printer over a long distance, remove the drum cartridges and toner
cartridges to prevent toner from spilling. Pack the printer inside a box.

CAUTION: Failure to repackage the printer properly for shipment can result in damage not 
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee.  
The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover 
damage to the printer caused by improper moving. The Xerox® Total Satisfaction Guarantee 
is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your Xerox representative for details. 
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This chapter includes: 
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General Troubleshooting 

This section includes: 
• Restarting the Printer ................................................................................................................................................... 242
• Printer Has Two Power Switches .............................................................................................................................. 243
• Printer Does Not Power On ........................................................................................................................................ 243
• Printer Resets or Powers Off Frequently ................................................................................................................ 244
• Printer Does Not Print .................................................................................................................................................. 244
• Printing Takes Too Long.............................................................................................................................................. 245
• Document Fails to Print ............................................................................................................................................... 246
• Document Prints from Wrong Tray ......................................................................................................................... 247
• Printer is Making Unusual Noises ............................................................................................................................ 247
• Automatic 2-Sided Printing Problems .................................................................................................................... 247
• Date and Time Are Incorrect ..................................................................................................................................... 248
• Scanner Errors ................................................................................................................................................................. 248

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 

Restarting the Printer 

The printer has two power switches. The main power switch, located behind the front door, controls the 
main power to the printer. The secondary power switch is the Power/Wake button on the control panel. 
The Power/Wake button controls power to the printer electronic components, and when powered off, 
initiates a software-controlled shutdown. The preferred method to power on and off the printer is to use 
the Power/Wake button. 

To operate the printer, power on both switches: 
1. Power on the main power switch.
2. At the control panel, press the Power/Wake button.
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To restart the printer. 
1. At the control panel, press the Power/Wake button, then touch Restart. A message appears on the

control panel that warns you that the printer is restarting.
2. If the printer does restart after several minutes, open the front door, then power off the main power

switch. To restart the printer, power on the main switch, then press the Power/Wake button on the
control panel.

3. Close the front door.

If restarting the printer does not resolve the issue, see the table in this chapter that best describes the 
problem. 

Printer Has Two Power Switches 

Probable Causes Solutions 

The printer has two power switches and one is 
not powered on. 

Power off the printer. 
• Press the Power/Wake button on the control panel.
• Open the front door and power off the main power switch.
Power on the printer. 
• Open the front door, then power on the main power

switch. 
• At the printer control panel, press the Power/Wake

button. For details, refer to Powering On and Off the 
Printer on page 38. 
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Printer Does Not Power On 

Probable Causes Solutions 

The power switch is not switched on. • Open the front door and check that the main power
switch is in the On position.

• At the printer control panel, press the Power/Wake
button. For details, refer to Powering On and Off the
Printer on page 38.

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, then plug the power cord into the outlet 
securely. Use the bracket provided with the printer to secure 
the power cord in place. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and check
if it operates properly.

• Try a different outlet.

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the 
Electrical Specifications on page 332. 

CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
Do not use a power strip. If necessary, contact a licensed electrician to install a properly 
grounded outlet. 

Printer Resets or Powers Off Frequently 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer. Confirm that the power cord is plugged 
in correctly to the printer and the outlet, then power on the 
printer. 

A system error occurred. Power off the printer, then power on again. If the error 
persists, contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply (UPS), extension cord, or power 
strip. 

Only use an extension cord designed to handle the electrical 
current capacity of the printer. For details, refer to Electrical 
Specifications on page 332. 

A network configuration problem exists. Unplug the network cable. If the problem is not resolved, 
contact your system administrator to reconfigure your 
network installation. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in Electrical 
Specifications on page 332. 
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Printer Does Not Print 

Probable Causes Solutions 

The printer is in Power Saver mode. On the control panel, press the Power/Wake button. 

The printer has an error. If the Status LED is blinking amber, to clear the error, follow 
the instructions on the control panel. If the error persists, 
contact your Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

A drum cartridge has reached end of life. Replace the drum cartridge. 

No control panel indicators are lighted. Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the 
printer. If the error persists, contact your Xerox representative. 

The printer is busy. • If the Status LED is flashing blue, a previous print job could
be the problem.
a. At your computer, use the printer properties to delete all

print jobs in the print queue.
b. At the control panel, touch Jobs, then delete all pending

print jobs.
• Load the paper in the tray.
• If the Status LED does not flash once after you send a print

job, check the connection between the printer and the
computer. Power off the printer, then power on.

The printer cable is disconnected. If the Status LED does not flash once after you send a print 
job, check the connection between the printer and the 
computer. 

There is a wireless or network connectivity 
issue. 

To test the printer, print an Information Page, such as the 
Configuration Report. If the page prints, there could be a 
wireless or network connectivity issue. 
Contact your system administrator or refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

Incorrect print driver. Check that you have the latest print driver installed. For details, 
go to www.xerox.com/office/ALC80XXsupport. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Printing Takes Too Long 

Probable Causes Solutions 

The printer is set to print on a paper type that 
requires slower printing. 

Certain paper types, like heavyweight paper and 
transparencies, take more time to print. Ensure that the print 
driver and control panel are set to the proper paper type. 

The printer is in Power Saver mode. Wait. It takes time for printing to start after the printer exits 
Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

• Determine if a print spooler or a computer sharing the
printer is buffering all print jobs and then spooling them to
the printer. Spooling can slow print speeds.

• To test the speed of the printer, print multiple copies of an
information page, such as a demo page. If the page prints
at the rated speed of the printer, there could be a network
or printer installation issue. For additional help, contact the
system administrator.

The job is complex. Wait. No action needed. 

Document Fails to Print 

Probable Causes Solutions 

Selected tray has wrong paper size loaded, or 
paper type or color is not available. 

To view the Job Status for a failed print on the touch screen: 
1. At the printer control panel, press the Home button.
2. Touch Jobs.
3. From the jobs list, touch the held job name. The resources

required for the job appear on the control panel.
4. Do one of the following:
• To print the job, replenish the resources required. The job

resumes automatically when the required resources are
available. If the job does not print automatically, touch
Resume.

• To choose an alternative paper source to enable the job to
print, touch Print On Alternate Paper. Select a paper tray,
then touch OK.

• To delete the print job, touch Delete. At the prompt, touch
Delete.

Note: The Print On Alternate Paper option is enabled using the 
Embedded Web Server. 

5. To return to the Home screen, press the Home button.

Incorrect network settings. To reset network settings, contact your system administrator or 
refer to the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Probable Causes Solutions 

The way the printer was installed on the 
network could be an issue. 

• Ensure that the printer is connected to the network.
• Determine if a print spooler or a computer sharing the

printer is buffering all print jobs and then spooling them to
the printer. Spooling can slow print speeds.

• To test the printer, print an information page, such as the
Configuration Report. If the page prints, there could be a
network or printer installation issue. For help, contact the
system administrator.

Application and print driver have conflicting 
tray selections. 

For details, see Document Prints from Wrong Tray on page 247. 

Document Prints from Wrong Tray 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver.
2. Go to the page setup or printer settings of the application

from which you are printing.
3. Set the paper source to match the tray selected in the print

driver or set the paper source to Automatically Select.

Note: To have the print driver select the tray, enable Auto 
Selection for the source tray on the printer. 

Printer is Making Unusual Noises 

Probable Causes Solutions 

One of the trays is not installed correctly. Open and close the tray from which you are printing. 

There is an obstruction or debris inside the 
printer. 

Power off the printer and remove the obstruction or debris. 
If you cannot remove it, contact your Xerox® service 
representative. 

Automatic 2-Sided Printing Problems 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use 
transparencies, envelopes, labels, or reloaded paper for 
automatic 2-sided printing. For details, see Supported Paper 
Sizes and Weights for Automatic 2-Sided Printing on page 173. 

Incorrect setting. On the print driver Printing Options tab, select 2-Sided Print. 
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Date and Time Are Incorrect 

Probable Causes Solutions 

The Date and Time Setup is set to Manual 
(NTP Disabled). 

To change the Date and Time to Automatic, in the Embedded 
Web Server, enable NTP. For details, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For details, refer to 
the System Administrator Guide at 
www.xerox.com/office/ALC80XXdocs. 

Scanner Errors 

Probable Causes Solutions 

Scanner is not communicating. Power off the printer, and check the scanner cable. 
Wait 2 minutes and power on the printer again. 
If the problem is not resolved, contact your Xerox® service 
representative. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Paper Jams 

This section includes: 
• Locating Paper Jams .................................................................................................................................................... 250
• Minimizing Paper Jams ................................................................................................................................................ 251
• Clearing Paper Jams ..................................................................................................................................................... 252
• Troubleshooting Paper Jams ..................................................................................................................................... 265
• Clearing Finisher Jams ................................................................................................................................................. 267
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Locating Paper Jams 

WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of 
paper is wrapped around the inside of the fuser, do not try to remove it immediately. Power 
off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam 
after the printer has cooled. If the error persists, contact your Xerox representative. 

CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can 
permanently damage the printer. 

The following illustration shows where paper jams can occur along the paper path: 

1. Door D
2. Tray 5
3. Doors A and B
4. Door C
5. Duplex Automatic Document Feeder
6. Document Output Tray
7. Finisher Areas
8. Paper Trays 1–4
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Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the 
paper in the same direction it normally moves through the printer. Even a small piece of paper left in the 
printer can cause a jam. Do not reload paper that has jammed. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver.
• Using damaged paper.
• Using unsupported paper.
• Loading paper incorrectly.
• Overfilling the tray.
• Adjusting the paper guides improperly.

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, refer to Supported Paper on page 169.
• Follow proper paper handling and loading techniques.
• Always use clean, undamaged paper.
• Avoid paper that is curled, torn, moist, creased, or folded.
• To separate the sheets before loading into the tray, fan the paper.
• Observe the paper tray fill line; never overfill the tray.
• Remove transparencies from the output tray immediately after printing.
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted

can cause poor print quality, misfeeds, skewed prints, and printer damage.
• After loading the trays, select the correct paper type and size on the control panel.
• When printing, select the correct type and size in the print driver.
• Store paper in a dry location.
• Use only Xerox paper and transparencies designed for the printer.

Avoid the following: 
• Polyester coated paper that is designed especially for inkjet printers.
• Highly glossy or coated paper.
• Paper that is folded, wrinkled, or excessively curled.
• Fanning transparencies before loading in the paper tray.
• Loading more than one type, size, or weight of paper in a tray at the same time.
• Loading hole punched paper or paper with folded corners or staples in the document feeder.
• Overfilling the paper trays.
• Allowing the output tray to overfill.
• Allowing the output tray to fill with more than a few transparencies.
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Clearing Paper Jams 

This section includes: 
• Clearing Jams in the Document Feeder ................................................................................................................ 252
• Clearing Jams at Trays 1–4 ........................................................................................................................................ 255
• Clearing Jams at Tray 5 (Bypass Tray) .................................................................................................................. 256
• Clearing Jams at Door A ............................................................................................................................................. 257
• Clearing Jams at Door B .............................................................................................................................................. 261
• Clearing Jams at Door C .............................................................................................................................................. 261
• Clearing Jams at Door D ............................................................................................................................................. 262

To clear jams, watch the video and follow the instructions on the control panel. To resolve the error that 
appears on the control panel, remove all paper from the areas shown. If the error does not clear, check 
the jam areas again to ensure that all paper has been removed. Ensure that all levers, covers, and doors 
have been closed correctly. 

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in 
the same direction it normally moves through the printer. Even a small piece of paper left in the printer 
can cause a jam. Do not reload paper that has jammed. 

Note: Do not touch the printed side of the paper when removing it. The printed side of jammed 
pages could smudge, and the toner could stick to your hands. Avoid spilling any toner inside the 
printer. 

WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you 
can. If some toner remains on your clothes, use cool water, not hot, to rinse off the toner.  
If toner gets on your skin, wash it off with cool water and a mild soap. If you get toner in your 
eyes, wash it out immediately with cool water and consult a doctor. 
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Clearing Jams in the Document Feeder 
1. Lift the release lever and open the top cover of the document feeder as shown.

2. If the original document is not caught in the entry to the document feeder, pull the document
straight out in the direction shown.

3. If the message on the control panel instructs you to turn the green wheel, turn it in the direction
shown. Turning the green wheel moves the original document out of the feeder.

4. If the control panel message instructs you to open the inner cover, lift the lever with the green tab
to open the inner cover.
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5. To move the original document out of the feeder, turn the green wheel in the direction shown.
Carefully remove the jammed document.

6. Close the inner cover, then close the top cover of the document feeder, pressing it down until it clicks
into place.

7. If the original document is not visible when the document feeder top cover is opened, lift the
document feeder and remove the original document from the document glass.

8. If the original document is not visible when the document feeder is opened, close the document
feeder. Lift up the document feeder tray, then remove the paper.

9. Lower the document feeder tray.
10. If the original document is not wrinkled or torn, load it into the feeder again, following the

instructions on the control panel.

Note: After clearing a document feeder jam, reload the entire document, including the pages 
already scanned. The printer automatically skips the scanned pages and scans the remaining 
pages. 

CAUTION: Torn, wrinkled, or folded originals can cause jams and damage the printer. 
To copy torn, wrinkled, or folded originals, use the document glass. 
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Clearing Jams at Trays 1–4 
1. Before removing the tray from the printer, look at the jam message on the control panel. If another

jam is shown, clear that jam inside the printer first.
2. Pull out the tray until it stops.

3. Remove the paper from the tray.
4. If the paper is torn, remove the tray completely and check inside the printer for torn pieces of paper.

5. Reload the tray with undamaged paper, then push the tray in until it stops.
6. At the control panel, select the correct paper size, type, and color:

− To select a new paper size, touch Size.
− To select a new paper type, touch Type. For letterhead paper, select Letterhead. For pre-

printed paper, select Pre-Printed. For hole-punched paper, select Hole Punched. 
− To select a new paper color, touch Color.

7. To confirm the settings, touch Confirm.
 



Troubleshooting 

256 Xerox® AltaLink® C80XX Series Multifunction Printer 
User Guide 

Clearing Jams at Tray 5 (Bypass Tray) 
1. Remove the jammed paper from the tray. Make sure that the paper feed entrance where the tray

connects to the printer is clear.

2. If the paper is torn, check inside the printer for torn pieces of paper.
3. Fan the paper that you removed and make sure that all four corners are aligned.
4. Insert the paper into tray 5 with the printing side face down. The leading edge of the paper should

lightly touch the paper feed entrance.

5. At the control panel, select the correct paper size, type, and color:
− To select a new paper size, touch Size.
− To select a new paper type, touch Type.
− To select a new paper color, touch Color.

6. To confirm the settings, touch Confirm.
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Clearing Jams at Door A 
1. Remove paper from the left tray, then close the tray.

2. Open Tray 5 as shown.

3. Lift the release lever for Door A.



Troubleshooting 

258 Xerox® AltaLink® C80XX Series Multifunction Printer 
User Guide 

4. Open Door A as shown.

WARNING: The area around the fuser can be hot. Use caution to avoid injury. 

CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or 
damage the transfer belt. Do not touch the transfer roller. Touching the roller can reduce 
image quality. 

5. Remove the jammed paper.
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6. If paper is jammed in the fuser, to open the fuser exit gate, pull the green lever A1.

7. Remove the paper as shown.

Note: If the paper is torn, remove all torn pieces from the printer. 

8. If the paper is jammed at the bottom entry of the fuser, remove it as shown.
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9. Return the green lever A1 to its locked position.

10. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

Note: Toner can adhere to the transfer roller. The toner that does adhere to the transfer roller does
not affect print quality.

11. Close Door A, then close Tray 5.

1

2



Troubleshooting 

Xerox® AltaLink® C80XX Series Multifunction Printer 261 
User Guide 

Clearing Jams at Door B 
1. To open Door B, open Tray 5, then lift the release lever and open Door B.

2. Remove the jammed paper as shown.

Note: If the paper is torn, remove all torn pieces from the printer. 

3. Close door B, then close Tray 5.
 

1

3

2
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Clearing Jams at Door C 
1. Pull the release lever and open Door C.

2. Remove the jammed paper from the Door C upper and lower areas.

Notes: 

• If the paper is torn, remove all torn pieces from the printer.
• If the paper is inaccessible, see Clearing Jams at Door A on page 257.

3. For paper jammed in the paper tray, open the tray and remove the paper.
4. Close Door C.
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Clearing Jams at Door D 
1. Remove paper from the left tray, then close the tray.

2. To open Door A, open Tray 5, lift the release lever, then open Door A.

WARNING: The area around the fuser can be hot. Use caution to avoid injury. 

CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or 
damage the transfer belt. Do not touch the transfer roller. Touching the roller can reduce 
image quality. 

3

1

2
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3. Open the left tray. To open door D, lift the lever.

4. Remove the jammed paper as shown.

Note: If the paper is torn, remove all torn pieces from the printer. 

5. Close Door D.
6. Close Door A, then close Tray 5.
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 265
• Jams in the Document Feeder .................................................................................................................................. 265
• Paper Misfeeds and Paper Size Jams ..................................................................................................................... 266
• Label and Envelope Misfeeds .................................................................................................................................... 266
• Paper Jam Message Stays On ................................................................................................................................... 267
• Jams During Automatic 2-Sided Printing ............................................................................................................. 267

Multiple Sheets Pulled Together 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry 
paper. 

Too much static electricity is present. • Try a new ream of paper.
• Do not fan transparencies before loading in tray.

Using unsupported paper. Use only Xerox approved paper. For details, refer to Supported 
Paper on page 169. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 

Jams in the Document Feeder 

Probable Causes Solutions 

Unsupported paper of the wrong size, 
thickness, or type. 

Use only Xerox-approved paper. For details, see Supported 
Paper on page 169. 

Originals are torn, previously stapled, bent, or 
folded. 

Ensure that the originals are not torn, bent, or folded. If 
previously stapled, remove all staples and separate the sheets 
by fanning them. 

The documents loaded in the document 
feeder exceed the maximum capacity 
allowed. 

Place fewer documents in the document feeder. 

Improperly adjusted document feeder guides. Adjust the paper guides to fit snugly against the paper loaded 
in the document feeder. 
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Paper Misfeeds and Paper Size Jams 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the
tray.

• Adjust the paper guides in the tray to match the size of the
paper.

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

1. Remove the paper.
2. Adjust the paper guides in the tray to match the size of the

paper.
3. Replace the paper.

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still 
misfeeds, do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, 
or type. 

Use only Xerox approved paper. For details, refer to Supported 
Paper on page 169. 

Label and Envelope Misfeeds 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

Load label sheets according to the instructions from the 
manufacturer. 
• Load labels face up in trays 1–4.
• Load labels face down in tray 5.

Envelopes are loaded in the wrong tray. Use tray 5 to print envelopes. 

Envelopes are loaded incorrectly in tray 5. To load envelopes in tray 5: 
• For envelopes with the flap on a long edge, load envelopes

with the flaps closed, flaps up, and flaps on the leading 
edge, toward the right. 

• For envelopes with the flap on a short edge, load envelopes
with the flaps closed, flaps up, and flaps on the leading 
edge, toward the right. 

• Load C4 and custom-size envelopes longer than 320 mm
(12.6 in.) short-edge feed, with the flaps closed, flaps up, 
and flaps on the leading edge, toward the right. For custom-
size envelopes, define a custom size on the control panel. 

Envelopes are loaded incorrectly in the 
envelope tray. 

To load the envelope tray: 
• For envelopes with the flap on a long edge, load envelopes

with the flaps closed, flaps down, and the flaps on the left 
side of the tray. 

• For envelopes with the flap on a short edge, load envelopes
with the flaps closed, flaps down, and the flaps on the left 
side of the tray. 
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Paper Jam Message Stays On 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed 
all of the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 

Note: Check for, and remove, torn pieces of paper in the paper path. 

Jams During Automatic 2-Sided Printing 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

Use paper of the correct size, thickness, or type. For details, see 
Supported Paper Sizes and Weights for Automatic 2-Sided 
Printing on page 173. 

Paper type is set incorrectly in the print driver. Ensure that the paper type is set correctly in the driver and that 
the paper is loaded in the correct tray. For details, see 
Supported Paper on page 169. 

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For details, 
refer to Supported Paper on page 169. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 

Clearing Finisher Jams 

Clearing Jams in the Integrated Office Finisher 
1. Locate the Integrated Office Finisher under the scanner and control panel, then open the top cover

as shown.
2. Rotate the green knob in the direction shown.
3. To remove the paper, pull it in the direction shown.

Note: If the paper is torn, remove all torn pieces from the printer. 

4. Close the top cover of the Integrated Office Finisher.
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Clearing Jams in the Office Finisher LX 

Clearing Jams Under the Office Finisher Top Cover 
1. Pull up the lever on the top cover.

2. Open the top cover by rotating it to the left.

3. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher. 

4. Close the top cover of the finisher.
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Clearing Jams in the Office Finisher LX Transport 
1. Lift the handle of the center tray straight up to open the transport cover.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher. 

3. Close the transport cover.
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Clearing Jams in the Business Ready Finisher 

This section includes: 
• Clearing Jams in the Center Tray ............................................................................................................................ 270
• Clearing Jams in the Finisher Transport ................................................................................................................ 271
• Clearing Jams at 3a in the Finisher ......................................................................................................................... 271
• Clearing Jams at 3c in the Finisher ......................................................................................................................... 274
• Clearing Jams at 3d in the Finisher ......................................................................................................................... 275
• Clearing Jams at 4 in the Finisher ........................................................................................................................... 277
• Clearing Jams in the Booklet Tray ........................................................................................................................... 279

Clearing Jams in the Center Tray 
1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown.

2. Open, then close, the finisher transport cover.
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Clearing Jams in the Finisher Transport 
1. Open the finisher transport cover.

2. Remove the jammed paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

3. Close the finisher transport cover.
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Clearing Jams at 3a in the Finisher 
1. If the paper is visible at the output tray exit, remove the paper by pulling it in the direction shown.

2. Open the front door of the Business Ready finisher.

3. Lift green handle 3a.

3a
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4. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

5. Return green handle 3a to its original position.

6. Close the front door of the Business Ready finisher.
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Clearing Jams at 3c in the Finisher 
1. Open the front door of the Business Ready finisher.

2. Move green lever 3c to the left.

3. Carefully remove the paper.

Notes:

• If the paper is torn, remove all torn pieces from the finisher.
• If the paper is inaccessible, or if the control panel prompts you, to release the paper, turn green

knob 3b in the direction shown.

3c
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4. Return green lever 3c to its original position.

5. Close the front door of the Business Ready finisher.
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Clearing Jams at 3d in the Finisher 
1. Open the front door of the finisher, then locate green lever 3d.

2. Move green lever 3d to the right.

3. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the finisher.

3d

3d
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4. Return green lever 3d to its original position.

5. Close the front door of the Business Ready finisher.
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Clearing Jams at 4 in the Finisher 
1. Open the front door of the Business Ready finisher.

2. Using the green handle, pull out unit 4 until it stops.

3. To remove the jammed paper, turn green knob 4 in either direction as shown.

Note: If the paper is torn, remove all torn pieces from the finisher.
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4. Return unit 4 to its original position.

5. Close the front door of the Business Ready finisher.
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Clearing Jams in the Booklet Tray 
1. Open the front door of the Business Ready finisher.

2. To release the jammed paper, turn green knob 4 in the direction shown.

3. To remove the paper, pull it in the direction shown.

Note: If the paper is torn, remove all torn pieces from the finisher.
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4. Close the front door of the Business Ready finisher.
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Clearing Jams in the CZ Folder 

This section includes: 
• Clearing Jams at 2a in the CZ Folder ..................................................................................................................... 282
• Clearing Jams at 2b in the CZ Folder ..................................................................................................................... 284
• Clearing Jams at 2e in the CZ Folder ..................................................................................................................... 285
• Clearing Jams at 2f in the CZ Folder ...................................................................................................................... 287
• Clearing Jams at 2g in the CZ Folder ..................................................................................................................... 289

Clearing Jams at 2a in the CZ Folder 
1. Open the front door of the CZ folder.

2. Lift green handle 2a.

2a
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3. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the folder.

4. Return green handle 2a to its original position.

5. Close the front door of the CZ folder.
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Clearing Jams at 2b in the CZ Folder 
1. Open the front door of the CZ folder.

2. Move green lever 2b to the left.

3. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the folder.

2b
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4. Return lever 2b to its original position.

5. Close the front door of the CZ folder.
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Clearing Jams at 2e in the CZ Folder 
1. To access lever 2e, open the front door of the CZ folder, then open the Folder tray 2d.

2. Move green lever 2e to the right.

3. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the folder.

2e
2d



Troubleshooting 

Xerox® AltaLink® C80XX Series Multifunction Printer 287 
User Guide 

4. Return green lever 2e to its original position.

5. Close the Folder tray, then close the front door of the CZ folder.

2d
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Clearing Jams at 2f in the CZ Folder 
1. To access lever 2f, open the front door of the CZ folder, then open the Folder tray 2d.

2. Move green lever 2f to the right.

3. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the folder.

2d
2f



Troubleshooting 

Xerox® AltaLink® C80XX Series Multifunction Printer 289 
User Guide 

4. Return green lever 2f to its original position.

5. Close the Folder tray, then close the front door of the CZ folder.

2d
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Clearing Jams at 2g in the CZ Folder 
1. Open the front door of the CZ folder.

2. Move green lever 2g to the right.

3. Carefully remove the paper.

Note: If the paper is torn, remove all torn pieces from the folder.

2g
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4. Return green lever 2g to its original position.

5. Close the front door of the CZ folder.
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Clearing Staple Jams 

This section includes: 
• Clearing Staple Jams in the Integrated Office Finisher .................................................................................. 292
• Clearing Staple Jams in the Office Finisher LX ................................................................................................... 294
• Clearing Booklet Staple Jams in the Office Finisher LX ................................................................................... 296
• Clearing Main Staple Jams in the Business Ready Finisher ........................................................................... 298
• Clearing Staple Jams in the Business Ready Finisher Booklet Maker ........................................................ 300

Clearing Staple Jams in the Integrated Office Finisher 
1. Open the finisher front door.

2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

3. Check inside the finisher for any loose staples and remove them.
4. Pull the staple cartridge clamp firmly in the direction shown to open it.
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5. Remove the jammed staples, then push the clamp in the direction shown until it snaps into the
locked position.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples 
carefully. 

6. Grasp the staple cartridge by the orange handle, then insert the cartridge into the stapler until it
clicks.

7. Close the finisher front door.
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Clearing Staple Jams in the Office Finisher LX 

WARNING: Do not perform this procedure while the printer is printing. 

1. Open the finisher front door.

2. Reach into the finisher cabinet and pull the stapler toward you until it stops.
3. Push the stapler assembly to the right as shown.

4. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it.
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5. Check inside the finisher for any loose staples and remove them.
6. Pull the staple cartridge clamp firmly in the direction shown to open it.

7. Remove the jammed staples by pulling them in the direction shown.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples 
carefully. 

8. Push the clamp in the direction shown until it snaps into the locked position.
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9. Grip the staple cartridge by the orange handle and insert it into the stapler assembly. Push it in until
it clicks.

10. Close the finisher front door.
 

Clearing Booklet Staple Jams in the Office Finisher LX 

WARNING: Do not perform this procedure while the printer is printing. 

1. Open the finisher side cover.

2. If the staple cartridges are not visible, grip the vertical panels at the left and right of the opening
and slide them to the center.
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3. Hold the tabs on both sides of the staple cartridge and pull the cartridge out of the finisher.

4. Remove the jammed staples by pulling them in the direction shown.

5. Hold the tabs on both sides of the staple cartridge and insert it into the original position in the
finisher.

Note: If you have trouble inserting the cartridge, ensure that the staples are positioned correctly in
the cartridge.

Note: The booklet maker uses two staple cartridges. Booklet stapling requires that both staple 
cartridges contain staples. 

6. Starting at Step 2, repeat the procedure for the other staple cartridge.
7. Close the finisher side cover.
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Clearing Main Staple Jams in the Business Ready Finisher 
1. Open the front door of the Business Ready finisher.

2. Hold the stapler assembly by the orange lever R1 and push it to the right.

3. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you.

(R1)
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4. Pull the staple cartridge clamp firmly in the direction shown to open it.

5. Remove the jammed staples, then push the clamp in the direction shown until it snaps into the
locked position.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples 
carefully. 

6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler
assembly until it clicks.

7. Return the staple cartridge assembly to its original position, then close the finisher door.
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Clearing Staple Jams in the Business Ready Finisher Booklet Maker 
1. Open the front door of the Business Ready finisher.

2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on
the top edge of the device.

3. To remove a staple cartridge from the booklet maker, push down on the staple cartridge handle, as
shown, then pull the cartridge out and up.
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4. Turn over the staple cartridge.
5. To permit the staple cartridge handle to open out and away from the staple pack, press in the green

tabs, then pull back the handle.

Note: If you do not see the staple jam, remove the staple case. 

6. To remove the staple case, press the rear of the case as shown.

Note: If you can see the staple jam, open the staple cartridge clamp. 

7. To open to the staple cartridge, pull it firmly in the direction shown.

WARNING: The points of the jammed staples are sharp. Remove the jammed staples 
carefully. 

1

1 2
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8. Remove the jammed staples, then push the clamp in the direction shown until it snaps into the
locked position.

9. Return the staple cartridge to the booklet maker, then return the booklet maker to its original
position.

Clearing Hole Punch Jams 

Clearing Hole Punch Jams in Office Finisher LX 

If the printer stops printing and reports a hole-punch jam, empty the hole-punch waste container. 
For details, refer to Emptying the Hole Punch Waste Container on page 234. 

After emptying the hole-punch waste container, locate and remove any paper jams. 
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Print, Copy, and Scan Problems 

This section includes: 
• Identifying Print, Copy, and Scan Problems ........................................................................................................ 303
• Print-Quality Problems ................................................................................................................................................. 304
• Copy and Scan Problems ............................................................................................................................................ 312

Identifying Print, Copy, and Scan Problems 

Problems with the output quality of your printer can be a print-related, copy-related, or scan-related 
problem. A quick test can help you to identify where a problem lies. 

To identify if a problem is print-related or scan-related, do the following: 
1. Print the Getting Started guide.

a. At the printer control panel, press the Home button.
b. Touch Device, then touch Information Pages.
c. Touch Getting Started, then touch Print.
d. To return to the Home screen, press the Home button.

2. Check the quality of the printed output.
3. If the print quality appears poor, the problem is print-related. Check for the symptom in the Solving

Print Quality Problems table.
4. If the print quality is good, the problem is likely to be scanner-related.

a. Copy the Getting Started guide that you have printed.
b. Check the quality of the copy output.
c. For any symptom of poor print quality, refer to the Copy and Scan Problems table.
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .............................................................................................................................................. 304
• Paper and Media ............................................................................................................................................................ 304
• Print-Quality Modes ...................................................................................................................................................... 305
• Color Corrections and Color Adjustments ............................................................................................................ 305
• Solving Print-Quality Problems ................................................................................................................................. 307

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/ALC80XXsupport. 

CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Please contact your local representative for details. 

Notes: 

• To enhance print quality, the toner/print/drum cartridges for many models of equipment
are designed to cease functioning at a predetermined point.

• Grayscale images printed with the composite black setting increment the color pages
counter, because color consumables are used. Composite black is the default setting on
most printers.

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. For details, see Environmental 
Specifications on page 331. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, refer to Supported Paper on page 169.
• Use only dry, undamaged paper.

CAUTION: Some paper and other media types can cause poor output quality, increased 
paper jams, or damage your printer. Do not use the following: 

• Rough or porous paper
• Inkjet paper
• Non-laser glossy or coated paper
• Paper that has been photocopied
• Paper that has been folded or wrinkled
• Paper with cutouts or perforations
• Stapled paper
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips
• Padded envelopes
• Plastic media
• Iron-on transfer paper

• Ensure the paper type selected in your print driver matches the paper type on which you are
printing.

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is
selected in the print driver.

• Do not load more than one type, size, or weight of paper in the tray at a time.
• Store your paper and other media properly for optimum print quality. For details, refer to Paper

Storage Guidelines on page 170.

Print-Quality Modes 

Select the correct print-quality setting for your print job from the print driver. For instructions on setting 
the print quality, see Printing on page 135. To control the print quality: 
• Use the print-quality settings in the print driver to control print quality. If the print quality is not

suitable, adjust the print-quality setting to an higher level.
• Use only Xerox approved paper. For details, refer to Supported Paper on page 169.
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Color Corrections and Color Adjustments 

For best printing results of mixed text, graphics, and images on a range of supported paper, set the Color 
Correction to Xerox Automatic Color. For instructions on setting the Color Correction, refer to Image 
Options on page 151. Follow these guidelines to control the Color Corrections and Color Adjustments: 
• For best results on most paper, ensure that the Color Correction in the print driver is set to Xerox

Automatic Color. This is the recommended setting.
• To produce more vivid results, select a mode of Color Correction. For example, when printing

graphics in which the sky does not look blue enough, for a more vibrant blue sky, select Vivid Color.
• To match the color output to another output device, select a custom Color Correction.
• To apply different Color Corrections to Text and Graphics and Images, select Custom Automatic

Color. This feature provides custom color corrections using color systems such as RGB Color, CMYK
Color, Spot Color, or CIE Color.

• To adjust particular characteristics of the printed color, such as Lightness, Contrast, Saturation, and
Color Casts, select Color Adjustments.
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Solving Print-Quality Problems 

This section includes: 
• Printing the Troubleshooting Print-Quality Pages ............................................................................................. 307
• Eliminating the Paper or Media as the Problem ................................................................................................ 307
• Isolating the Problem to the Printer or to the Application ............................................................................ 308
• Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server ................... 308
• Troubleshooting Print-Quality Problems in the Printer .................................................................................... 309
• Performing the Print Calibration Procedure ........................................................................................................ 309
• Print-Quality Problems and Solutions..................................................................................................................... 309

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/ALC80XXsupport. 

CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Please contact your local representative for details. 

Note: To enhance the print quality, toner/print/drum cartridges for many models of 
equipment are designed to cease functioning at a predetermined point. 

Printing the Troubleshooting Print-Quality Pages 
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch Information Pages.
4. To print procedures on resolving print-quality problems, touch Troubleshooting Print Quality Page,

then touch Print.
5. Compare your print-quality problems to the examples on the pages.
 

Eliminating the Paper or Media as the Problem 

Damaged or unsupported paper or media can cause print-quality problems even when the printer, 
application, and print driver are working perfectly. Use the following guidelines to eliminate the paper as 
the source of the print-quality problem: 
• Make sure that the printer supports the paper or media.
• Make sure that the printer is loaded with undamaged, dry paper.
• If the condition of the paper or media is in doubt, replace it with new paper or media.
• Make sure that you have the proper tray selected in the print driver and from the control panel.
• Make sure that you have the correct paper type selected in the print driver and in the control panel

of the printer.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Isolating the Problem to the Printer or to the Application 

When you are sure that the paper is supported and in good condition, use the following steps to isolate 
the problem: 
1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see

Printing the Troubleshooting Print Quality Pages on page 307.
− If the pages printed properly, the printer is working properly and the print-quality problem is an

application, print driver, or print server problem. 
− If the pages still have print-quality problems, the problem is in the printer. 

2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print
Driver, or Print Server on page 308.

3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems
in the Printer on page 309.

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server 

If the printer is printing properly from the control panel but you still have print-quality problems, the 
application, print driver, or print server could be the cause. 

To isolate the problem: 
1. Print a similar document from another application and look for the same print-quality problems.
2. If the document has the same print-quality problem, it is probably a print driver or print server

problem. Check the print driver used for the print job.
a. Navigate to the list of printers on your computer:

• For Windows Server 2008 and later, click Start > Settings > Printers.
• For Windows 7, click Start > Devices and Printers.
• For Windows 8, click Start > Control Panel > Devices and Printers.
• For Windows 10, click the Windows Start icon, then click Settings > Devices > Printers &

Scanners. Scroll to Related settings, then click Devices and printers.

Note: If you are using a custom Start Menu application, it can change the navigation path to your 
list of printers. 

b. Right-click on the name of the printer.
c. From the drop-down list, select Properties.

• Ensure that the model name in the middle of the driver matches the model name of the
printer.

• If the names do not match, install the proper print driver for the printer.
3. If the print driver is correct, to set the Print Quality Mode and Color Correction, refer to Printing

Features on page 149.
− Set the Print-Quality mode to Standard or Enhanced.
− Set the Color Correction to Xerox® Automatic Color.

4. If the problem persists, delete then reinstall the print driver.
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5. If the document printed without a print-quality problem, the application is probably the cause.
Restart your printer, restart the application, then print the document again. For more information,
see Restarting the Printer on page 242.

6. If the problem still persists, ensure that you are not printing through a print server. If the problem
persists, for online support information, go to www.xerox.com/office/ALC80XXsupport.

Troubleshooting Print-Quality Problems in the Printer 

If you have print-quality problems when printing a Demo Page or the Configuration Report from the 
control panel, the problem is in the printer. 

To find the source of the problem: 
1. At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the

Troubleshooting Print Quality Pages on page 307.
2. If the prints are too light to see print details, verify the following:

− The printer is loaded with undamaged, dry supported paper.
− The toner levels of one or more of the toner cartridges is not too low.

3. If the pages are printed with a solid color, one or more of the drum cartridges could be defective.
Correct the problem before continuing.

4. If the colors of the pages do not match your expectations, run the control panel Print Calibration.
5. Compare the print-quality problems in your document to each of the examples in the

Troubleshooting Print-Quality Pages.

If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the 
action to take to resolve the problem. 

If the problem persists, for online support information, go to www.xerox.com/office/ALC80XXsupport. 

Performing the Print Calibration Procedure 
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch Tools.
4. Touch Troubleshooting > Calibration > Print Calibration > Next.
5. Follow the onscreen instructions to run the Print Calibration procedure.
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Print-Quality Problems and Solutions 

Use the following table to find solutions to print-quality problems. 

Note: At the printer control panel, press the Home button.Touch Device > Information Pages > 
Troubleshooting Print Quality Page > Print. 

Problem Solution 

Smears, Smudges, and Streaks 
Dark or light marks appear on your output. 

Run a print job consisting of several blank pages through 
the printer to remove toner accumulated on the fuser. 
If the problem persists, print the test pages to help 
determine which component is causing the image-quality 
problem. 
• If the defect occurs in one color only, replace the

corresponding imaging unit. 
• If the defect occurs in all colors and is visible on all the

test pages, replace the fuser. 

Repeating Spots or Lines 
Spot or lines appear at regular intervals on the 
prints. 

1. To identify the part of the printer that is causing the
problem, print the Repeating Defects page. At the
control panel, press the Home button, then touch
Device > Tools > Troubleshooting > Support Pages >
Repeating Defects Page > Print.

2. To identify the part responsible for the repeating spots
or lines, follow the instructions on the Repeating
Defects page.

3. To correct the problem, replace the printer part
identified on the Repeating Defects page.

Colors Look Wrong 
Colors are off or look drastically wrong. 

1. Verify that the printer is on a solid, level, and flat
surface.

2. Perform the Print Calibration procedure. At the control
panel, press the Home button, then touch Device >
Tools > Troubleshooting > Calibration > Print
Calibration > Next, then follow the instructions.
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Problem Solution 

Colors Too Light or Too Dark 
The print or color density is too light, missing, or the 
background is foggy. 

1. Verify that the paper you are using is the correct type
for the printer and is loaded properly. For details, see
Supported Paper on page 169.

2. Verify that the paper loaded in the tray matches the
paper type selected at the control panel and in the
print driver.

3. To print procedures on resolving print-quality problems,
at the control panel, press the Home button. Touch
Device > Information Pages > Troubleshooting Print
Quality Page > Print.
If the Color Reference page looks correct, the printer is
printing properly. Your application or incorrect settings
in the print driver can be causing the print-quality
problems.

4. If the Color Reference page did not print correctly,
perform the Print Calibration procedure. At the control
panel, press the Home button, then touch Device >
Tools > Troubleshooting > Calibration > Print
Calibration > Next, then follow the instructions.

Vertical White Lines or Streaks - One Color 
Lines or streaks appear in one color of your output. 

1. Print the test pages to identify the affected color.
2. To clean the printhead lenses for the affected color,

pull out the cleaning rod until it stops, then move it all
the way in. Repeat three more times. Then repeat this
procedure for each affected color. For details, see
Cleaning the Printhead Lenses on page 204.

Note: To print procedures on resolving print-quality 
problems, at the control panel, press the Home button, 
then touch Device > Information Pages > 
Troubleshooting Print Quality Page > Print. 

Toner Missing or Easy to Rub Off 
Toner appears to be missing from the print or is 
easy to rub off. 

1. Verify that the paper you are using is the correct type
for the printer and is loaded properly. For details, see
Supported Paper on page 169.

2. Perform the Print Calibration procedure. At the control
panel, press the Home button, then touch Device >
Tools > Troubleshooting > Calibration > Print
Calibration > Next, then follow the instructions.

3. At the control panel, select a heavier paper.

Note: Papers from lightest to heaviest are: 

• For uncoated paper: Plain, Lightweight Cardstock,
Cardstock, and Heavyweight Cardstock

• For coated paper: Lightweight Glossy Cardstock, Glossy
Cardstock, and Heavyweight Glossy Cardstock.

•
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Copy and Scan Problems 

If the copy or scan quality is poor, refer to the following table. 

Symptoms Solutions 

Lines or streaks only present in copies made 
from the document feeder. 

There is debris on the document glass. When scanning, the 
paper from the document feeder passes over the debris, 
creating lines or streaks. Clean all glass surfaces with a  
lint-free cloth. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the 
debris creates a spot on the image. Clean all glass surfaces with 
a lint-free cloth. 

The reverse side of the original document is 
showing on the copy or scan. 

Turn on Background Suppression. 

Image is too light or too dark. Adjust the Lighten/Darken or Contrast settings. 

Colors are inaccurate. • Copy: Adjust the Color Balance settings.
• Scan: Confirm the correct Original Type is set.

If the problem persists, for online support information, go to www.xerox.com/office/ALC80XXsupport. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Fax Problems 

This section includes: 
• Problems Sending Faxes ............................................................................................................................................. 313
• Problems Receiving Faxes ........................................................................................................................................... 314
• Printing Fax Reports...................................................................................................................................................... 315

If your printer cannot send and receive faxes, ensure that the printer is connected to an approved analog 
telephone line. The fax machine cannot send or receive faxes when it is connected directly to a digital 
telephone line without the use of an analog filter. 

Note: If the fax connection is poor, transmit the fax at a lower rate. For the Starting Rate, select Forced 
(4800 bps). 

Problems Sending Faxes 

Symptoms Probable Causes Solutions 

The document is not feeding 
properly through the document 
feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass. 

The document is scanned at an 
angle. 

The document feeder width guides are 
not adjusted to fit the width of the 
document. 

Adjust the document feeder width 
guides so that they fit against the 
document. 

The fax received by the recipient 
is blurry. 

The document is positioned incorrectly. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. Adjust the 
contrast. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is 
working, then send the fax again. 

There is a problem with one of the fax 
machines. 

Make a copy to verify that the 
printer can make clean copies and 
prints. If the copy prints correctly, 
have the recipient verify that their 
fax machine is operating correctly. 

The fax received by the recipient 
is blank. 

The document was loaded incorrectly. • If using the document feeder,
place the original document
face up.

• If using the document glass,
place the original document face
down.

Fax was not transmitted. The fax number is wrong. Verify the fax number. 
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Symptoms Probable Causes Solutions 

The telephone line is connected 
incorrectly. 

Verify the telephone line connection. 
If the telephone line is disconnected, 
connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 

The fax feature is not installed or is not 
enabled. 

Ensure that the fax feature is 
installed and enabled. 

Server fax is enabled. Ensure that server fax is disabled. 

An access number is required to 
connect to an outside line. 

If the printer is connected to a PBX 
system, it could be necessary to 
enter a number to access the outside 
telephone line. 

The fax number needs a pause 
between the prefix for an outside line 
and the telephone number. 

To insert a pause, touch the Dial 
Pause button. A comma (,) appears 
in the corresponding location. 

If the problem persists, for online support information, go to www.xerox.com/office/ALC80XXsupport. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Problems Receiving Faxes 

Symptoms Probable Causes Solutions 

The fax received by the recipient 
is blank. 

There is a problem with the telephone 
connection or with the fax machine of 
the sender. 

Verify that the printer can make 
clean copies. If it can, have the 
sender fax the document again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call but 
does not print the fax. 

The memory is full. To increase available memory, 
delete stored jobs and wait for the 
existing jobs to complete. 

The received fax size is reduced 
in size. 

The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents, then load the 
appropriate paper size in the 
printer. 

Faxes are not received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to receive faxes 
automatically. 

The memory is full. If the printer is out of paper, faxes 
and print jobs can deplete the 
printer of memory. Load paper and 
print the jobs stored in the memory. 

The telephone line is connected 
incorrectly. 

Verify the telephone line 
connection. If the telephone line is 
disconnected, connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that the 
printer can make clean copies and 
prints. If the copy prints correctly, 
have the recipient verify that their 
fax machine is operating correctly. 

If the problem persists, for online support information, go to www.xerox.com/office/ALC80XXsupport. 
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Printing Fax Reports 

You can print the following fax reports from the printer control panel: 
• Activity Report
• Protocol Report
• Fax Address Book Report
• Options Report
• Pending Jobs Report

To print a fax report: 
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch Tools.
4. Touch App Settings > Fax App.
5. Touch Print Fax Reports.
6. Touch the required report, then touch Print.
7. To return to the Device screen, touch X, then touch X again.
8. To return to the Home screen, press the Home button.

Note: If the Print Fax Reports feature does not appear, contact your system administrator or refer to
the System Administrator Guide at www.xerox.com/office/ALC80XXdocs.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Getting Help 

This section includes: 
• Viewing Error and Alert Messages on the Control Panel ................................................................................ 317
• Viewing the Error History on the Control Panel .................................................................................................. 317
• The Embedded Web Server ........................................................................................................................................ 318
• Online Support Assistant ............................................................................................................................................. 318
• Information Pages ........................................................................................................................................................ 318
• More Information .......................................................................................................................................................... 319

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality. 

Viewing Error and Alert Messages on the Control Panel 

When an error or warning condition occurs, the printer alerts you of the problem. A message appears on 
the control panel and the LED status light on the control panel flashes amber or red. Alerts inform you 
about printer conditions, such as low supplies or open doors that require your attention. Error messages 
warn you about printer conditions that prevent the printer from printing or degrade printing 
performance. If more than one condition occurs, only one appears on the control panel. 

To view a complete list of active error and alert messages: 
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch Notifications.
4. Touch Faults & Alerts, Alerts, or Faults.
5. To view details, touch a fault or alert.
6. To exit the Notifications screen, touch X.
7. To return to the Home screen, press the Home button.
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Viewing the Error History on the Control Panel 

When errors occur on the device, they are logged into an error history file by date, time, and associated 
fault code. You can use this list to identify trends and resolve problems. 

To view the error history: 
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch Notifications.
4. Touch Fault History.
5. To exit, touch X.
6. To exit the Notifications screen, touch X.
7. To return to the Home screen, press the Home button.
 

The Embedded Web Server 

The Embedded Web Server is the administration and configuration software that is installed in the 
printer. It allows System Administrators to modify network and system settings on the printer remotely 
using a Web browser. 

You can check the status of the printer, monitor paper and supply levels, and submit and track print jobs. 
All these functions can be accessed from the convenience of your computer. 

The Embedded Web Server requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux

environments.
• TCP/IP and HTTP enabled in the printer.
• A network-connected computer with a Web browser that supports JavaScript.

Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/ALC80XXsupport. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
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Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. 

To print an information page, select an option, then touch Print. 

The following Information Pages are available: 

Name Description 

Configuration Report The Configuration Report provides printer information including the serial 
number, installed options, network settings, port setup, tray information, 
and more. 

Billing Summary The Billing Summary report provides information about the device and a 
detailed listing of the billing meters and sheet counts. 

Getting Started The Getting Started guide provides an overview of the key features of the 
printer. 

Troubleshooting Print Quality 
Page 

The Troubleshooting Print Quality Page provides a list of common print-
quality problems and tips to help solve them. 

Supplies Usage Page The Supplies Usage Page provides coverage information and part 
numbers for reordering supplies. 

Graphics Demo Page Print this page to check the quality of graphics. 

PCL Font List The PCL Font List provides a printout of all PCL fonts that are available on 
the printer. 

PostScript Font List The PostScript Font List provides a printout of all PostScript fonts that are 
available on the printer. 
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More Information 

You can obtain more information about your printer from these sources: 

Resource Location 

Installation Guide Packaged with the printer. 

Getting Started guide Print from the control panel. For details, refer to 
Information Pages on page 44. 

Other documentation for your printer www.xerox.com/office/ALC80XXdocs 

Recommended Media List United States: www.xerox.com/rmlna  
European Union: www.xerox.com/rmleu 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/ALC80XXsupport 

Information Pages Print from the control panel. For details, refer to 
Information Pages on page 44. 

Embedded Web Server information In the Embedded Web Server, click Help. 

Order supplies for your printer www.xerox.com/office/ALC80XXsupplies 

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 

Locating the Serial Number 

When you order supplies or contact Xerox for assistance, you need the serial number of your device.  
You can obtain the serial number in several ways. To locate the serial number, print the Configuration 
Report. You can view the serial number on the control panel or on the Embedded Web Server home page. 
The serial number is printed on a label that is affixed to the printer. To view the label, open Door A, then 
locate the label on the left side of the printer. 

For details on how to print the configuration report, refer to Information Pages on page 44. 

To view the serial number on the control panel: 
1. At the printer control panel, press the Home button.
2. Touch Device.
3. Touch About.

The model, serial number, and software version is displayed.
4. To return to the Home screen, press the Home button.

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=reg&Language=English
http://www.direct.xerox.com/
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Printer Configurations and Options 

Standard Features 

The printer provides the following features: 
• Copy, Print, Email, Scan, Internet Fax, and Server Fax
• Scan to USB and Print from USB mass storage devices
• Scan to Mailbox, Scan to Network, Scan to Home, Single Touch Scan
• Searchable PDF, Single/Multiple-Page PDF / XPS / TIFF, Encrypted / Password-Protected PDF, and

Linearized PDF / PDF/A file formats
• Copy speed of up to 70 ppm for color or black and white on A4 (210 x 297 mm) or Letter (8.5 x

11 in.) paper
• 1200 x 2400 dpi HiQ LED imaging and copying quality
• Copy document sizes up to A3/11 x 17 in.
• Print document size, with short-edge feed, up to SRA3/12 x 19 in.
• Automatic 2-sided printing
• Duplex Automatic Document Feeder
• Color touch screen control panel
• Trays 1–2 each with 520-sheet capacities
• Tray 5 with 100-sheet capacity
• Three-Tray module (Trays 2–4) each with 520-sheet capacities
• High Capacity Tandem Tray (Trays 3–4) with total 2000 A4/Letter sheet capacity
• 2-GByte memory plus 1-GByte page memory
• Internal 250-GByte hard drive
• Ethernet 10/100/1000Base-TX
• High-Speed USB 2.0 direct print
• Adobe PostScript and PCL fonts and support
• Xerox® Mobile Express Driver®, Xerox® Global Print Driver®, and Xerox® Pull Print Driver support
• Automated supplies replenishment and management using Xerox® MeterAssistant®, Xerox®

SuppliesAssistant®, and MaintenanceAssistant
• Remote driver installation
• Remote Control Panel and Configuration Cloning
• Bonjour, SSDP, and SAP device discovery
• Unified Address Book
• Xerox® Standard Accounting
• Encrypted Secure Print, Secure Fax, Secure Scan, Secure Email
• McAfee data security
• HDD Overwrite, AES 256-bit Encryption (FIPS 140-2 compliant), SHA-256 Hash Message

Authentication
• Xerox® Extensible Interface Platform
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• Xerox® Earth Smart Driver Settings
• Embedded Web Server
• Xerox® CentreWare® Web
• Email Alerts
• Support for mobile printing, mobile printing connectivity, and mobile Apps
• Xerox® App Gallery supported
• Xerox® Copier Assistant
• NFC printing
• Support for Mopria®

• Support for AirPrint
• Support for Google Cloud Print™

Options and Upgrades 
• Integrated Office Finisher
• Office Finisher LX
• Booklet Maker for Office Finisher LX
• Hole Punch for Office Finisher LX
• Business Ready Finisher with 2/3 or 2/4 hole punch
• Business Ready Booklet Maker Finisher with 2/3 or 2/4 hole punch
• CZ folder for Business Ready Finisher or Business Booklet Maker Finisher
• Swedish Hole Punch
• Envelope tray
• High-Capacity Feeder (Tray 6) with 2000-sheet capacity
• Convenience stapler and work surface
• One-Line and Dual-Line Fax Kits
• Fax forward to Email or SMB
• EFI™ Fiery® Network Server
• Embedded PDL support for XPS
• Xerox Secure Access Unified ID System
• Xerox® Common Access Card Enablement Kit
• Xerox® Network Accounting Enablement
• Wireless Network Adapter
• Wi-Fi Direct with optional Wireless Network Adapter
• Foreign Device Interface
• McAfee Integrity Control Enablement Kit and McAfee enhanced security features
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• XPS Print Option Kit
• Smart Card Enablement Kit
• Xerox® Integrated RFID Card Reader E1.0
• Unicode print
• Xerox® Scan to PC Desktop® Professional

Finishing Options 

Output Device Capacity Sizes Weights Finishing Options 

Left Tray 100 sheets All supported sizes All supported 
weights 

NA 

Stacking Tray 250 sheets All supported sizes All supported 
weights 

NA 

Integrated Office 
Finisher 

Stacking: 500 
sheets A4, 8.5 x 11 
in. or 250 sheets A3, 
11 x 17 in. 

89 x 98 mm to A3 
7.2 x 8.3 in. to 11 x 
17 in. 

60–256 g/m² Single stapling: 50 
sheets A4, 8.5 x 11 in. 
or 30 sheets of 80 
g/m² Legal, B4, A3, 11 
x 17 in. 

Office Finisher LX Stacking: 2000 
sheets unstapled, 
1000 sheets single-
stapled, or 250 
sheets dual-stapled 

182 x 210 mm 
to A3 
3.5 x 3.9 in. to 11 x 
17 in. 

60–256 g/m² Multiple-position 
stapling: 50 sheets 
Hole Punch: Optional 
2–3 or 2–4 Hole Punch 

Office Finisher LX 
with Booklet Maker 

Stacking: 2000 
sheets unstapled, 
1000 sheets single-
stapled, or 250 
sheets dual-stapled 

182 x 210 mm 
to A3 
3.5 x 3.9 in. to 11 x 
17 in. 

60–256 g/m² Multiple-position 
stapling: 50 sheets 
Hole Punch: Optional 
2–3 or 2–4 Hole Punch 

Booklet Tray: 40 
booklets, 2–15 
sheets per booklet 

A4 SEF (Short-Edge 
Feed), Letter SEF, 
B4 SEF, Legal SEF, 
A3 SEF, 11 x 17 in. 
SEF 

Saddle-stapling: 2–15 
sheets of 60–90 g/m² 
Score/Crease: 1–15 
sheets unstapled 
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Output Device Capacity Sizes Weights Finishing Options 

Business Ready 
Finisher 

Top Tray: 500 
sheets 

Stacking: A6–A3 
4.25 x 5.85 in. to 11 
x 17 in. 
Stapling: B5–A3 
7.25 x 10.5 in. to 11 
x 17 in. 

60–300 g/m² Single-position and 
multiple-position 
stapling: 50 sheets 
Hole Punch: Optional 
2–3, 2–4, or Swedish 
4-Hole Punch 

Stacking: 3000 
sheets unstapled, 
200 sets single-
position stapled or 
100 sets multiple-
position stapled 
sheets, dual-stapled 

Business Ready 
Finisher with 
Booklet Maker 

Offset Catch Tray: 
500 sheets 

Stacking: A6–A3 
4.25 x 5.85 in. to 11 
x 17 in. 
Stapling: B5–A3 
7.25 x 10.5 in. to 11 
x 17 in. 

60–300 g/m² Single-position and 
multiple-position 
stapling: 50 sheets 
Hole Punch: Optional 
2–3, 2–4, or Swedish 
4-Hole Punch 

Stacking: 1500 
sheets unstapled, 
200 sets single-
position, dual, or 4-
position stapled or 
100 stapled sets A3 
or 11 x 17 in. 

CZ Fold Unit 40 sheets C-Fold, Z-Fold: A4, 
Letter SEF 
Z-Half Fold: A3, 11 x 
17 in 

64–90 g/m² C-Fold, Z-Fold, and 
Z-Half Fold 

Convenience 
Stapler 

NA Any supported size Any supported 
weight 

50 sheets 

Note: Sheet quantities for tray capacities and finishing options are based on 80 g/m². Quantities are 
reduced for heavier media and must be within the specified weight range. 
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Physical Specifications 

Base Configuration 
• Width: 640 mm (25.2 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 151.9 Kg (334.8 lb.)

Configuration with Integrated Office Finisher 
• Width: 705 mm (27.8 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 158 Kg (348.3 lb.)

Configuration with Office Finisher LX and Booklet Maker 
• Width: 1242 mm (48.8 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 183 Kg (403.4 lb.)

Configuration with Business Ready Finisher 
• Width: 1302 mm (51.3 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 195.6 Kg (430.4 lb.)

Configuration with Business Ready Finisher and Booklet Maker 
• Width: 1431.4 mm (56.4 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 212.3 Kg (467.1 lb.)
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Configuration with Business Ready Finisher, Booklet Maker, and CZ Folder 
• Width: 1664.2 mm (65.5 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 264.4 Kg (581.7 lb.)

Configuration with Business Ready Finisher, Booklet Maker, CZ Folder, and 
High-Capacity Feeder 
• Width: 1978.2 mm (77.9 in.)
• Depth: 732 mm (28.8 in.)
• Height: 1149 mm (45.2 in.)
• Weight: 297.5 Kg (654.5 lb.)

Clearance Requirements 

Clearance Requirements for Base Configuration 

10.0 cm
(3.9 in.)

206.7 cm
(81.4 in.)

74.2 cm
(29.2 in.)

198.1 cm
(78.0 in)

161.4 cm
(63.5 in.)

30.7 cm
(12.1 in.)
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Clearance Requirements for Configuration with Office Finisher LX and Booklet 
Maker 

Clearance Requirements for Configuration with Business Ready Finisher and Booklet 
Maker 

10.0 cm
(3.9 in.)

206.7 cm
(81.4 in.)

74.2 cm
(29.2 in.) 104.5 cm

(41.2 in.)

198.1 cm
(78.0 in)

235.2 cm
(92.6 in.)
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Clearance Requirements for Configuration with Business Ready Finisher, Booklet 
Maker, and CZ Folder 

10.0 cm
(3.9 in.)

206.7 cm
(81.4 in.)

74.2 cm
(29.2 in.)

104.5 cm
(41.2 in.)

198.1 cm
(78.0 in)

258.5 cm
(101.8 in.)

23.3 cm
(9.1 in.)
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Clearance Requirements for Configuration with Business Ready Finisher, Booklet 
Maker, CZ Folder, and High-Capacity Feeder 

10.0 cm
(3.9 in.)

206.7 cm
(81.4 in.)

74.2 cm
(29.2 in.) 104.5 cm

(41.2 in.)

198.1 cm
(78.0 in)

258.5 cm
(101.8 in.)
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Environmental Specifications 

Temperature 

Operating: 10–28°C (50–83°F) 

Relative Humidity 

Operating: 15% to 85% (non-condensing) 

Elevation 

For optimum performance, use the printer at elevations below 2500 m (8200 ft.). 
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Electrical Specifications 

Speed Power Supply Voltage Frequency Current Required 

30-55 prints per minute 110–127 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

15 A 

220–240 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

10 A 

70 prints per minute 110–127 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

20 A 

220–240 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

10 A 
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Performance Specifications 

Printing Resolution 

Maximum Resolution: 1200 x 2400 dpi 

Print Speed 

Xerox reports speeds for continuous printing using long-edge feed on A4 (210 x 297 mm, 8.27 x  
11.69 in.) or Letter (216 x 279 mm, 8.5 x 11 in.) Bond 60–105 g/m² (18–28 lb.) paper from any tray 
except for tray 5. 

Several factors affect print speed: 
• Paper orientation: For faster print speeds, you can load paper long-edge feed.
• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed.
• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels.
• Paper type: Plain prints faster than Glossy.

You can achieve maximum print speed when you print on Plain, Letter/A4 paper, using long-edge feed. 

The slowest print speed is approximately 13 ppm when you print from tray 5 using large size, 
Heavyweight Glossy Cardstock. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 
Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmenteu&Language=English
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance with 
these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
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Certifications in Europe 

 

The CE mark applied to this product symbolizes a declaration of conformity by 
Xerox with the following applicable Directives of the European Union: 
• Low Voltage Directive 2014/35/EU 
• Electromagnetic Compatibility Directive 2014/30/EU 
• Radio Equipment Directive 2014/53/EU 

 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

 WARNINGS:  

• Changes or modifications to this equipment not specifically approved by the 
Xerox Corporation may void the user's authority to operate this equipment. 

• External radiation from Industrial, Scientific, and Medical (ISM) equipment 
can interfere with the operation of this Xerox device. If external radiation 
from ISM equipment interferes with this device, contact your Xerox 
representative for assistance. 

• This is a class A product. In a domestic environment, this product can cause 
radio frequency interference, in which case the user can be required to take 
adequate measures. 

• To ensure compliance with European Union regulations 2014/30/EU, use 
shielded interface cables. 

 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
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Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the 
development and purchase of energy efficient models, which help to reduce 
environmental impact. Details on the ENERGY STAR program and models 
qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGrou
p&pgw_code=IEQ  

The ENERGY STAR and ENERGY STAR mark are registered United States 
trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between 
United States, European Union, and Japanese governments and the office 
equipment industry to promote energy-efficient copiers, printers, fax, 
multifunction printers, personal computers, and monitors. Reducing product 
energy consumption helps combat smog, acid rain, and long-term changes to 
the climate by decreasing the emissions that result from generating 
electricity. 

Power Consumption and Activation Time 

The amount of electricity that a device consumes depends on the way the device is used. This device is 
designed and configured to enable you to reduce your electricity usage. 

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the 
device transitions to Ready mode. In this mode, the device can print again immediately. If the device is 
not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In these 
modes, to enable reduced-power consumption, only essential functions remain active. The device takes 
longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready 
mode. This delay is the result of the system waking up and is typical of most imaging devices on the 
market. 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
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To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, 
you can configure the mode as follows: 
• Always Allowed: The device powers off automatically after the specified time, and the cumulative

Low Power mode and Sleep mode timeouts have elapsed.
• Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts

have elapsed. The device also powers off if Fax, USB Drive, and Wired and Non-Wired Network have
not been activated.

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/ALC80XXdocs.  
For further assistance, contact your System Administrator or refer to the System Administrator Guide. 

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System 
Administrator Guide at www.xerox.com/office/ALC80XXdocs. 

To learn more about Xerox participation in sustainability initiatives, go to: www.xerox.com/about-
xerox/environment/enus.html. 

Note: Changing the default Power Saver activation times can result in an overall higher energy 
consumption of the device. Before you turn off Power Saver modes or set a long activation time, 
consider the increase in device power consumption. 

Default Power Saver Settings 

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging 
Equipment. The transition time from Ready mode to Low Power mode can be set up to 30 minutes.  
The default value is 2 minutes. The transition time from Low Power mode to Sleep mode can be set up to 
30 minutes. The default value is 0 minutes. The total transition time from Ready mode to Sleep mode 
can take up to 60 minutes. 

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/ALC80XXdocs.  
For further assistance, contact your System Administrator, or refer to the System Administrator Guide. 

Environmental Choice Certified to Office Machines CCD-035 

This product is certified to Environmental Choice standard for office machines, 
meeting all requirements for reduced environmental impact. As part of 
achieving certification, Xerox Corporation has proven this product meets the 
Environmental Choice criteria for energy efficiency. Certified copier, printer, 
multifunctional device, and fax products must also meet criteria such as 
reduced chemical emissions and demonstrate compatibility with recycled 
supplies. Environmental Choice was established in 1988 to help consumers 
find products and services with reduced environmental impacts. Environmental 
Choice is a voluntary, multi-attribute, and lifecycle-based environmental 
certification. This certification indicates that a product has undergone rigorous 
scientific testing, exhaustive auditing, or both, to prove its compliance with 
stringent, third-party, environmental performance standards. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
http://www.xerox.com/about-xerox/environment/enus.html
http://www.xerox.com/about-xerox/environment/enus.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=AltaLink+ALC80XX&PgName=Man&Language=English
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Germany 

Germany - Blue Angel 

RAL, the German Institute for Quality Assurance and Labeling, has awarded 
this device the Blue Angel Environmental Label. This label distinguishes it as a 
device that satisfies Blue Angel criteria for environmental acceptability in 
terms of device design, manufacture, and operation. For more information, go 
to: www.blauer-engel.de. 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 

Lärmemission 

Maschinenlärminformations-Verordnung - 3. GPSGV, der höchste Schalldruckpegel beträgt 72dB(A) 
gemäss EN ISO 7779 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 

Eurasian Economic Community Certification 

Russia, Belarus, and Kazakhstan are working to establish a common customs 
union, the Eurasian Economic Community, or EurAsEC. The Eurasian Economic 
Community members anticipate sharing a common regulatory scheme and 
common EurAsEC certification mark, the EAC Mark. 

http://www.blauer-engel.de/
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Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmenteu&Language=English
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as:

− Certificates of Indebtedness.
− National Bank Currency.
− Coupons from Bonds.
− Federal Reserve Bank Notes.
− Silver Certificates.
− Gold Certificates.
− United States Bonds.
− Treasury Notes.
− Federal Reserve Notes.
− Fractional Notes.
− Certificates of Deposit.
− Paper Money.
− Bonds and Obligations of certain agencies of the government, such as FHA and so on.
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or 

may be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law.
Further information of these provisions may be obtained from the Copyright Office, Library of
Congress, Washington, D.C. 20559. Ask for Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be
photographed.

5. Passports. Foreign Passports may be photographed.
6. Immigration papers.
7. Draft Registration Cards.
8. Selective Service Induction papers that bear any of the following Registrant’s information:

− Earnings or Income.
− Court Record.
− Physical or mental condition.
− Dependency Status.
− Previous military service.
− Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the
head of such department or bureau).

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses.
• Drivers’ Licenses.
• Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 

Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money
• Obligations or securities of a government or bank
• Exchequer bill paper or revenue paper
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of

a court of law
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer
for a province)

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a
province, the government of a state other than Canada or a department, board, Commission, or
agency established by the Government of Canada or of a province or of a government of a state
other than Canada
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of
a province or by the government of a state other than Canada

• Documents, registers, or records kept by public officials charged with the duty of making or issuing
certified copies thereof, where the copy falsely purports to be a certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or
trademark owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes
• Bank notes and checks
• Bank and government bonds and securities
• Passports and identification cards
• Copyright material or trademarks without the consent of the owner
• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges.  

For instructions on programming the Fax Send Header information, refer to the section of the System 
Administrator Guide on Setting Transmission Defaults. 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be 
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing 
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). 
To be certain of the number of devices that can be connected to a line, as determined by the RENs, 
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the 
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN 
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately 
shown on the label. 

To order the correct service from the local Telephone Company, you could also have to quote the codes 
in the following list: 
• Facility Interface Code (FIC) = 02LS2
• Service Order Code (SOC) = 9.0Y
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CAUTION: Ask your local Telephone Company for the modular jack type installed on your 
line. Connecting this machine to an unauthorized jack can damage telephone company 
equipment. You, not Xerox, assume all responsibility and/or liability for any damage caused 
by the connection of this machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the 
Telephone Company interrupts your service, they can advise you of your right to file a complaint with 
the FCC if you believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Device app on the printer and in 
the back of the Troubleshooting section of the User Guide. If the equipment is causing harm to the 
telephone network, the Telephone Company may request you to disconnect the equipment until the 
problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If 
unauthorized repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state 
tariffs. Contact the state public utility commission, public service commission, or corporation commission 
for information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
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Canada 

This product meets the applicable Innovation, Science and Economic Development Canada technical 
specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 

WARNING: Do not attempt to make such connections yourself. Contact the appropriate 
electric inspection authority, or electrician, to make the ground connection. 

The Ringer Equivalence Number (REN) indicates the maximum number of devices allowed to be 
connected to a telephone interface. The termination of an interface may consist of any combination of 
devices subject only to the requirement that the sum of the RENs of all the devices not exceed five. For 
the Canadian REN value, please refer to the label on the equipment. 

Canada CS-03 Issue 9 

This product has been tested to and is compliant with CS–03 issue 9. 
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European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

This device has been designed to work with the national public switched telephone networks and 
compatible PBX devices of the following countries: 

Pan-European Analog PSTN and 
Compatible PBX Certifications  

Austria Greece Netherlands 

Belgium Hungary Norway 

Bulgaria Iceland Poland 

Cyprus Ireland Portugal 

Czech Republic Italy Romania 

Denmark Latvia Slovakia 

Estonia Liechtenstein Slovenia 

Finland Lithuania Spain 

France Luxembourg Sweden 

Germany Malta United Kingdom 

If you have problems with your product, contact your local Xerox representative. This product can be configured to 
be compatible with other country networks. Before reconnecting the device to a network in another country, 
contact your Xerox representative for assistance. 

Notes: 

• Although this product can use either loop disconnect (pulse) or DTMF tone signaling,
Xerox recommends that you use DTMF signaling. DTMF signaling provides reliable and
faster call setup.

• Modification of this product, or connection to external control software or control
apparatus not authorized by Xerox, invalidates its certification.
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New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has

accepted that the item complies with minimum conditions for connection to its network. It indicates
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it
provides no assurance that any item will work correctly in all respects with another item of
Telepermitted equipment of a different make or model.
The equipment may not be capable of correct operation at the higher data speeds designated.
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such
circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its
disposal or repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom
customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is
no guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems,
do not contact the Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is
readily available on almost all New Zealand telephone exchanges.

WARNING: No '111' or other calls can be made from this device during a mains power 
failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected to
the same line.
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8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on
the equipment (computer) associated with this device. The associated equipment shall be set to
operate within the following limits for compliance with Telecom Specifications:
For repeat calls to the same number:
− There shall be no more than 10 call attempts to the same number within any 30 minute period

for any single manual call initiation, and 
− The equipment shall go on-hook for a period of not less than 30 seconds between the end of 

one attempt and the beginning of the next attempt. 
For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of 
another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should
not exceed five.

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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Safety Certification 

This device is certified by the following Agencies using the following safety standards. 

Agency Standard 

TUV-Rheinland (US and Canada) UL 60950-1:2007:R10.14 
CAN/CSA C22.2 No. 60950-1-07 +A1:2011 +A2:2014 

TUV-Rheinland (Europe) IEC 60950-1:2005 +A1 +A2 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds
• European Union: www.xerox.com/environment_europe

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply. For more information, go to 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment , or for recycling and disposal 
information, contact your local authorities. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=AltaLink+ALC80XX&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 

Domestic/Household Environment 

Application of this symbol on your equipment is confirmation that you should 
not dispose of the equipment in the normal household waste stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 

Professional/Business Environment 

Application of this symbol on your equipment is confirmation that you must 
dispose of this equipment in compliance with agreed national procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

These symbols on the products and/or accompanying documents mean that 
used electrical and electronic products and batteries should not be mixed with 
general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in accordance with 
your national legislation and the Directive 2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to save 
valuable resources and prevent any potential negative effects on human health 
and the environment which could otherwise arise from inappropriate waste 
handling. 

For more information about collection and recycling of old products and 
batteries, please contact your local municipality, your waste disposal service or 
the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in accordance 
with national legislation. 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 

Battery Symbol Note 

This wheeled bin symbol may be used in combination with a chemical symbol. 
This establishes compliance with the requirements set out by the Directive. 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 

Hg
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Output Color Use Output Color 
to control the 
color rendering of 
the output image 
or print. 

￭ ￭ ￭ ￭ ￭ 

2-Sided 
Copying, 
2-Sided 
Scanning 

You can use the 
2-Sided options 
to set the device 
to scan one or 
both sides of an 
original 
document. For 
Copy jobs, you 
can specify  
1-Sided or 2-
Sided output. 

￭ ￭ ￭ ￭ ￭ ￭ 

Paper Supply Use Paper Supply 
to specify the 
size, type and 
color of the paper 
required, or the 
Paper Tray to 
use. If Auto is 
selected, the 
printer chooses 
the paper tray 
based on the 
original 
document size 
and the selected 
settings. 

￭ ￭ 

D Apps Features 
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Collation You can collate 
multiple-page 
copy jobs 
automatically. 
For example, 
when making 
three 1-Sided 
copies of a 
six-page 
document, the 
copies are 
printed in this 
order: 
1, 2, 3, 4, 5, 6; 1, 
2, 3, 4, 5, 6; 1, 2, 
3, 4, 5, 6. 

￭ 

Finishing If finishing 
options are 
available, use this 
option to choose 
the finishing 
options required 
for your printed 
output. 

￭ 

Reduce / 
Enlarge 

You can reduce 
the image to as 
little as 25% of 
its original size or 
enlarge it as 
much as 400%. 
Use Proportional 
% to maintain 
original 
proportions when 
resizing, or use 
Independent % 
to adjust the 
width and length 
of the image by 
different 
percentages. 

￭ ￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Original Type The printer 
optimizes the 
image quality of 
the copies based 
on the type of 
images in the 
original 
document and 
how the original 
was created. 

￭ ￭ ￭ ￭ ￭ ￭ ￭ 

Contrast You can use the 
Contrast feature 
to adjust the 
variation 
between light 
and dark areas of 
the image. 

￭ ￭ ￭ ￭ ￭ ￭ 

Lighten / 
Darken 

Use the 
Lighten/Darken 
slider to make 
the output image 
or print lighter or 
darker. 

￭ ￭ ￭ ￭ ￭ ￭ ￭ 

Sharpness Use this option to 
sharpen the 
output image or 
print. For best 
results, sharpen 
text images and 
soften photos. 

￭ ￭ ￭ ￭ ￭ 

Saturation Saturation allows 
you to adjust the 
color strength 
and the amount 
of gray in the 
color. 

Note: This 
feature is not 
available when 
Output Color is 
set to Black and 
White or 
Grayscale. 

￭ ￭ ￭ ￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Color Presets You can adjust 
the color of the 
copy using preset 
color effects. For 
example, you can 
adjust colors to 
be brighter or 
cooler. 

￭ 

Color Balance If you have a 
color original 
image, you can 
adjust the 
balance of the 
printing colors 
between cyan, 
magenta, yellow, 
and black before 
printing your 
copy. 

￭ 

Original 
Orientation 

You can use the 
Original 
Orientation 
option to specify 
the layout of the 
original images. 
The printer uses 
the information 
to determine if 
images require 
rotation to 
produce the 
required output. 

￭ ￭ ￭ ￭ ￭ 

Image Shift Image Shift 
allows you to 
modify the 
location of the 
image on the 
page. You can 
shift the printed 
image along the 
X and Y axes of 
each sheet of 
paper. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Automatic 
Background 
Suppression 

Use the Auto 
Background 
Suppression 
setting to reduce 
the sensitivity of 
the printer to 
variations in light 
background 
colors. 

￭ ￭ ￭ ￭ ￭ ￭ ￭ 

Edge Erase You can erase 
content from the 
edges of your 
images using the 
Edge Erase 
feature. You can 
specify the 
amount to erase 
on the right, left, 
top, and bottom 
edges. 

￭ ￭ ￭ 

Original Size To ensure that 
you are scanning 
the correct area 
of the 
documents, 
specify the 
original size. 

￭ ￭ ￭ ￭ ￭ ￭ 

Book Copying You can use the 
Book Copying 
feature to copy 
books, 
magazines, or 
other bound 
documents. 

￭ 

Mirror Image Use Mirror Image 
to reverse the 
image and text 
on the page. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Negative 
Image 

Negative Image 
reverses the light 
and dark areas in 
your document, 
and print it as 
though it were a 
photo negative. 
Printing a 
negative image is 
useful for 
documents that 
have a 
substantial 
amount of dark 
background or 
light text and 
images. 

￭ 

Special Pages Special Pages is 
used to add 
covers and inserts 
to your job. You 
can specify 
exception pages 
to print on 
different paper 
than the main 
body of the job. 
You can also 
program Chapter 
start pages. 

￭ 

Annotations You can add 
Annotations such 
as page numbers 
and the date, to 
your copies. 

￭ 

Booklet 
Creation 

The Booklet 
Creation feature 
prints two pages 
on each side of 
the paper. The 
pages are 
reordered so that 
they are in 
numerical order 
when folded. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Page Layout You can print the 
selected number 
of pages on one 
side of a sheet of 
paper. Selecting 
multiple pages 
per sheet saves 
paper and 
provides a way to 
review the layout 
of a document. 

￭ 

Sample Job Sample Job 
allows you to 
print a test copy 
of a job to 
inspect before 
printing multiple 
copies. This 
feature is useful 
for complex or 
high-volume jobs. 
After you print 
and inspect the 
test copy, you 
can choose to 
print or cancel 
the remaining 
copies. 

￭ 

Transparency 
Separators 

Use 
Transparency 
Separators to 
add blank sheets 
of paper between 
each printed 
transparency. 
The size and 
orientation of the 
separators must 
be the same  
as the 
transparencies. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Build Job Use Build Job for 
jobs that include 
a variety of 
originals 
requiring 
different settings, 
or for scanning 
multiple-page 
jobs from the 
document glass. 
The job is 
scanned in 
segments. After 
all the segments 
are scanned, the 
job is processed 
and completed. 

￭ ￭ ￭ ￭ ￭ ￭ 

Save Current 
Settings 

To use a 
particular 
combination of 
copy settings for 
future copy jobs, 
you can save the 
settings with a 
name and 
retrieve them for 
later use. 

￭ 

Retrieve 
Current 
Settings 

You can retrieve 
and use any 
previously saved 
copy settings for 
current jobs. 

￭ 

Quantity Use this option to 
enter the number 
of required ID 
card copies. 

￭ 

Resolution Resolution 
determines how 
fine or grainy 
graphic images 
appear. Image 
resolution is 
measured in dots 
per inch (dpi). 

￭ ￭ ￭ ￭ ￭ 

Remove Blank 
Pages 

Remove Blank 
Pages configures 
the printer to 
ignore blank 
pages. 

￭ ￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

From Use the From 
option to specify 
the originator of 
the email. 

Note: The system 
administrator 
can preset this 
option to 
populate 
automatically 
with your user 
account details. 

￭ ￭ 

Reply To Use the Reply To 
option to include 
an email address 
that you want 
the recipient to 
reply to. This 
option is useful if 
you want the 
recipient to reply 
to your email 
address rather 
than to the 
device. 

Note: The system 
administrator 
can preset this 
option. 

￭ ￭ 

Message Use Message to 
enter information 
to accompany 
the email. 

￭ ￭ 

Quality/File 
Size 

The Quality/File 
Size option lets 
you choose from 
three settings 
that balance the 
quality of the 
image and the 
size of the file. 
Higher quality 
images result in 
larger file sizes, 
which are not 
ideal for sharing 
and transmitting 
over the network. 

￭ ￭ ￭



Apps Features 

368 Xerox® AltaLink® C80XX Series Multifunction Printer 
User Guide 

Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

File Format Use the File 
Format option to 
specify the 
format of the 
saved image or 
to define a 
searchable 
image. You can 
add a password 
to protect the 
image or choose 
to combine 
multiple images 
into a single file. 

￭ ￭ ￭ 

If File Already 
Exists 

Use the If File 
Already Exists 
option to define 
what action the 
device takes 
when the file 
name is used 
already. 

￭ 

File and 
Attachment 

Use the File and 
Attachment 
option to specify 
a name for the 
file containing 
the scanned 
images. 

￭ ￭ ￭ 

Acknowledge- 
ment Report 

You can request 
to print a report 
to confirm each 
recipient has 
received the 
scanned file.  
The report 
contains delivery 
status 
information. 

Note: The report 
depends on 
recipient 
response time. 

￭ 

Update 
Workflows 

Use Update 
Workflows to 
refresh the list of 
workflows 
displayed at the 
control panel. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Add File 
Destinations 

Use this option to 
choose more 
destinations for 
filing the 
scanned images. 

￭ 

Book Faxing You can use the 
Book Faxing 
feature to scan 
images from 
books, 
magazines, or 
other bound 
documents for 
faxing. 

￭ 

Reduce/Split Use the 
Reduce/Split 
option to specify 
how your faxed 
document is 
printed on the 
receiving fax 
machine. If the 
image is too 
large to fit on the 
paper size, you 
can reduce the 
image to fit or 
split across 
multiple pages. 

￭ 

Confirmation 
Report 

You can request 
a report to 
confirm if your 
fax has been 
received. To 
receive a 
Confirmation 
Report only if an 
error occurred 
during 
transmission, 
choose Print on 
Error Only. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Starting Rate Select the 
highest starting 
rate for 
transmitting the 
fax, unless the 
destination for 
the fax you are 
sending has 
special 
requirements. 
Forced (4800 
bps) is the 
recommended 
setting for lines 
that may have 
transmission 
interference. 

￭ 

Cover Sheet You can use the 
Cover Sheet 
option to add an 
introduction 
page to the 
beginning of your 
fax. You can add 
a short comment 
to the cover 
sheet, as well as 
To and From 
details. 

￭ 

Send Header 
Text 

It is unlawful to 
send a message 
from a fax 
machine without 
the proper Send 
Header Text. 
Ensure that the 
name and 
telephone 
number of the 
sender, and the 
date and time of 
the transmission 
is included on all 
faxes. 

￭
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Feature Description Copy Email Fax 
Server 
Fax 

Internet 
Fax 

Workflow 
Scanning/ 
Scan To 

ID 
Card 
Copy 

Delay Send You can set a 
time in the future 
for the printer to 
send your fax job. 
You can delay 
the send of your 
fax job for up to 
24 hours. 

￭ ￭ 

Polling Fax Polling allows 
you to store a fax 
document on the 
printer and make 
it available for 
other fax 
machines to poll. 
You can retrieve 
faxes stored on 
other fax 
machines. To use 
this feature, both 
the polling 
printer and the 
remote printer 
must have the 
Polling feature. 

￭ 

Mailboxes Use the Fax 
Mailboxes option 
to store faxes 
that have been 
retrieved from a 
remote fax 
machine, or to 
store faxes for 
retrieval by a 
remote fax 
machine. The 
mailbox number 
is required to 
access a mailbox. 
You can set a 
passcode to 
secure 
confidential 
documents. 

￭
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